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2 Abstract
Samgods 1.2 incorporates a few new features in terms of reporting and functionalities and
improvements related to performances, simplification of the processes and clearness of the
interface.
The main changes introduced in the GUI are:






General structure
o

New commodity structure; number of commodities groups has been changed
from 35 to 16

o

All reporting and inputs connected to STAN group classification has been
removed and it has been applied commodity group classificaion.

Functionalities
o

Distribution betweeen first and second best logistics solution in STD and RCM

o

Inclusion of specific attributes for transfer costs

o

Attribute in Nodes table CONAGGR: aggregation of flows will occur for flows
which have same CONAGGR values.

o

Locksolution enhancment

Inout data structure
o

o

o



Vehicle parameters table: Higher flexibility: Before it was by STAN group, now it
is by commodity group. Vehicle parameters table is now specified by commodity
group. Former classification had three groups, Dry bulk, Liquid bulk and general
cargo. This is not the case anymore. The vehicle parameter tables are devided
in two parts:


1) first part (called Part A) holds general parameters: KM_COST,
HOURS_COST, DFLTFREQ, F_DUES_VH, F_DUES_TON,
CAPACITY, VESSELTYPE, ONFER_H_C, ONFER_KM_C, POSICOST,
SPEED, VDF_SPEC, MODE_1, MODE_2, FUNC_FILE, EMPTY_V,
COORFACT



2) second part (called Part B) holds parameters by commodity group:
NC_LCO, NC_LTI, NC_LCOT, NC_LTIT, CONT_LCO, CONT_LTI,
CONT_LCO_T, CONT_LTI_T.

Calibration parameters present in ScalingF_Veh table can be applied:


by vehicle type and commodity group



by vehicle type and all commodity groups (setting ID_COM=0 the same
setting will be applied across all commodities, so it is not required
anymore to repet the same entry for each commodity group);



vehicle types which do not require any adjustment can be skipped in the
table

Table with consolidation lower and upper values has a new logic to make the
definition of the parameters flexible. There are 17 sets of lower and upper
values, 1 for defaul values and 16 sets, one for each commodity group.
Previoulsy only default values and three STAN groups were present. Also the
coding within the table has changed. When default value must be applied, in
each commodity specific attribute would be sufficient to code -1.

Reporting

Preface
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o

Cost Benefict Analysis – ASEK values has two new reports which hold the
required information for emmission calculations (Vehicles, loaded and empty,
within Swedish territory) and data for the benefit part (Logistic Cost Changes
used for CBA).

o

Enhanced VhclRepXX.rep with inclusion of all cost components

o

Cleaned up reports 1 and 4 of attributes which were generating
missunderstanding.

Model optimization
o

Reduced number of exe programs moving functionalities from
BuildChain4RCM.exe and ChainChoi4RCM.exe to BuildChain.exe and
ChainChoi.exe

o

Optimized Extract program (this does not require parallelization anymore)

o

Exclusion of not used or unueccessary parts (LP-Adjust and extract process in
LP0 and LP1)

3 Preface
The national model for freight transportation in Sweden is called Samgods. The model is aimed
to provide a tool for forecasting and planning of the transport system in Sweden. Samgods can
be used for forecasting of possible future scenarios, such as the evaluation of the effects of
transport policies. Samgods consists of several parts, where the logistics module is the core of
the model system. In the logistic module, different types of commodities are assigned to different
types of transport chains based on minimization of the total logistics cost.
To make Samgods more user-friendly, a graphical user interface (GUI), incorporated in Cube,
has been developed.
This document is the manual for how to use the model system where Samgods has been
implemented. For more information about the Samgods model, please refer to1:


Method report of the logistics model in the Swedish national freight model system



Program documentation for the logistics model for Sweden



Railway capacity management for Samgods using linear programming with a stochastic
approach



Samgods PWC-matriser 2016 och 2040



Technical documentation



Kalibrering



MPS documentation



SelectDirect documentation

AECOM has incorporated Samgods in Cube and has produced this manual.
For questions regarding the system, please contact Petter Hill at Trafikverket or visit the
webpage www.trafikverket.se/samgods.

1

See 14 References for a full reference list.
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4 Introduction
This document is the manual for how to use of the graphical user interface of the Samgods
model in Cube. It describes how to setup input files to run the Logistics Module and Rail Capacity
Management procedure of the Samgods model, how to visualize the output (modal split, traffic
work, etc.), and how to compare the output from different scenarios. Moreover, the manual aims
to show how to use different tools developed to facilitate the handling of the large amounts of
data produced by the model.
The system consists of a set of main software components:


The Logistic module, which is the core of the system.



The Rail Capacity module, which is a feature to manage rail link flow volume constraints.



Cube Base, where the graphical user interface of Samgods is incorporated.



Cube Voyager, which is a transport modelling software used to implement supply and
assignment models.



Cube GIS, which is the geographical information system where the network of the model
is implemented.

This is the outline of the manual:
Chapter 5: Glossary, explaining important glossaries used in this manual.
Chapter 6: Practical instructions for how to install the Samgods GUI in Cube, together with
system requirements.
Chapter 7: General description of the structure of the GUI, the different windows and how to
work with the applications. It also contains a table with all data that can be accessed via the Data
Section window in the GUI.
Chapter 8: Detailed description of all applications, in terms of input data, possible actions and
choices for how to use the different applications in the system and how to set up the results. This
chapter should be used more as a look-up guide per application, rather than to be read from start
to end.
Chapter 9: General instructions for how to use the graphical user interface, listed after the kind
of action the user wants to do. A new user to the system is advised to start reading here, after
having read Chapter 7.
Chapter 10: Instructions for how to make different kinds of scenario setups.
Chapter 11: Advanced user options
Chapter 12: Log reports from the Samgods GUI and Check-list when errors occur.
Chapter 13: Examples of maps on outputs
Chapter 14: References.
Chapter 15: Appendices.
For all the users, it is strongly recommended to follow instructions on file naming conventions
and coding listed in subsection 12.4.
For the reader who is interested in getting started quickly and who already has some knowledge
of the Cube system, it is recommended to make sure that the system is properly installed as
described in Chapter 6 and then jump to Chapter 9 and 10 for the specific analysis that he/she
wants to carry out.
For the reader without previous knowledge of the Samgods GUI or Cube, it is recommended to
start with Chapter 7 and then read Chapter 9 and 10 from the beginning and refer to Chapter 8
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for more information on the specific applications. The appendix (Chapter 15) also contains
explanations on some parts of the model.
The use of Cube Base and Cube Voyager is described in the reference guides
RG_CubeBase.pdf and RG_CubeVoyager.pdf, which can be found where Cube is installed
(under Citilabs\Cube folder).
For users interested in the usage of the new vehicle types introduced in this version, read for
example section 10.13.
Finally, a technical description of Samgods is available, please see References 4.
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5 Glossary
Below some important glossaries used in this manual are collected. Observe that for some
glossaries the explanation is specific for this context.
Application – a group of programs
Assignment model – a model where the transport demand is assigned to the network. In this
context, Voyager is used as an assignment model. The automobile and lorry assignments are
based on generalized time for route choices and all-or-nothing solution.
Base scenario (or base) – the scenario that is used as reference scenario. See Scenario.
Commodity or Product group - commodity type in the model.
Catalog – the folder where the Samgods model and its set of scenarios are stored. Several
catalogs, with their corresponding base scenarios, can be included in a project.
Demand model – a model of the transport demand in terms of OD matrices. In this context, the
Logistics Module in the Samgods model is a demand model. The Logistics Module has the
purpose to produce the OD matrices (demand for vehicle movements on legs) from the fixed
transport demand provided in the PWC matrices (PWC = Production Warehouse Consumption).
Domestic – transport volumes between domestic zones.
EOQ - Economic Order Quantity
Feature class - used in ArcGIS. This is a collection of geographic features with the same
geometric type (such as point, line or polygon), the same attributes and the same spatial
reference. Feature classes can be stored in geodatabases, shape files, coverages or other data
formats. Feature classes allow homogeneous features to be grouped into a single unit for data
storage purposes.
Geodatabase (or short: gdb) – a database designed to store and handle geographic
information and spatial data.
Keys – a varying input into an application (i.e., parameter settings). Catalog keys are used to
specify settings for the applications etc.
MAT - extension for matrix file produced in Cube (binary format)
Layer – used in GIS. This is the visual representation of a geographic dataset in any digital map
environment.
LOS (Level Of Service) matrix (or skim matrix) – a matrix where a particular measure, such as
time, distance, cost, are summarized link-by-link along the minimum cost path for each OD pair
(OD = Origin Destination). The distance, domestic distance, fee/toll, and extra cost LOS matrices
(defined per vehicle type) are mandatory input to the Samgods model.
Program – a single task or an instance.
regional diff DT – Reference to regional differentiation by domestic and total domestic.
regional diff DTI – Reference to regional differentiation by domestic, total domestic and
international.
RCM - Rail Capacity Management module.
S/A user - Standard User / Advance User.
Scenario – refers to a set of input files or values. A scenario can be a base scenario, or it can be
an alternative scenario that is studied in relation to the base scenario, e.g., a child to the base
scenario. An existing scenario means that the scenario-specific tables are included in the main
geodatabase.
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Scenario folder – the folder containing all the data for a specific scenario, located in the
Scenario_Tree folder.
Skim matrix – see LOS matrix
Standard outputs/reports – the outputs/reports that the Samgods GUI always produces.
STD - STanDard logistics module.
Supply model - In this context, a supply model (or network model) is the model of the network
where the transport infrastructure, such as nodes and links (i.e., ports, railways, roads, etc.), are
implemented. In this context, Voyager is used as supply model.
TOC – Table Of Content, see Section 9.15.
Total domestic (or Tdomestic) – same as domestic + domestic part of international transports
V/C – flow volume over capacity ratio for rail flows.
#LEA-vehicles – Reference to loaded, empty and all vehicles respectively.
NORIG – the Emme node number and its specification comes from a set of rules when edits are
made in GIS interface
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6 Installation Instructions
This chapter describes the installation requirements, required programs for the Samgods GUI
and their download locations and the installation procedures for each required program. It also
describes how to setup the Samgods model in Cube.

Minimum system requirements
Cube Base will run on any Intel Pentium 4-compatible personal computer (including Pentium 4,
Centrino, Xeon, AMD, and Cyrix chips) running the Windows XP/7/8/10 or Windows Server
2003/2008 operating system. The requirements for processor speed, amount of RAM and hard
disk space are directly related to the operating system, the network, and other file sizes. At a
minimum, Citilabs recommends:


Intel Pentium 4, AMD Athlon



At least 4 GB of RAM to run the full Samgods model but 1 GB to run Cube.



10 GB for the application and supporting applications and data (like GIS); ATAPI IDE,
5,400 rpm



100+ GB for output files



24 bit capable graphics accelerator OpenGL version 2.0 runtime and Shader Model 3.0
or higher is recommended; ATI or Nvidia GPU is strongly recommended for any 3D GIS
work or Cube Dynasim micro simulation



17-inch monitor, 1024 x 768 higher at Normal size (96dpi); 24 bit color depth



Mouse or other pointing device



Colour printer or plotter

A system with additional resources may be more appropriate for certain applications of this
software.
Running the Samgods model at an acceptable performance puts a demand on the hardware as
well as on the operating system. The hardware should preferably have several processors
available for parallel executions and several GB of RAM to support the allocation of memory to
each execution and must be based on 64-bit technology. The operating system needs to be able
to allocate a certain amount of memory to the different processors, see the list below.
In tests, the Samgods group has lowered the total execution time from over 24 hours to just
above 4 hours by using a laptop with 8 processors and 16 GB of RAM on a 64-bit Windows 10
Operating System, instead of a laptop with a single processor.
The graphical interface of the Samgods model allows the user to set the number of commodity
groups to run simultaneously, in order to have an optimal performance of the system (note that
this option is available only if Java runtime environment is installed see Section 6.4 below). The
monitoring of the parallel executions is done by a Java program underneath the GUI, but the
actual work of allocating memory and tasks to each processor is done by the operating system
itself.
There is an upper limit on how many processors that may be used simultaniously:


It is strongly recommended never to use more parallel executions than the number of
available processors



Each processor should in average have at least 2 GB of RAM available, or the program
may encounter out-of-memory problems



It is mandatory to run the model on a 64-bit system for the RCM procedure to function.
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The model has 16 commodity groups and this number constitutes the upper limit for the
number of parallel processes for the main part of the logistics model (should the
hardware allow it). One task involves construction of OD-matrices for 40 vehicle type,
and this can in principle be parallelized into 40 parallel processes.

Cube Software
For the Samgods GUI to function, certain Cube software is required. They are:


Cube Base: 6.1.1



Cube Voyager: 6.1.1



Cube GIS: ArcGIS 10.2.2

This software is available at http://citilabs-websiteresources.s3.amazonaws.com/release/cube611setup.exe .
For the above Cube software, Citilabs License 2014 is required (newer software and license
versions may be available later on). Please contact Citilabs for further information regarding this.
The installation also requires some custom-built programs developed specifically for Samgods
1.1. They are available by contacting Petter Hill at Trafikverket and will be distributed over ftp.

Cube Installation
To install and run the model full administration rights are required on the PC, or more specifically
on the model folder, the Citilabs program folder, the ArcGIS program folder and the user folder.
Do the following steps to install Cube (observe that these steps can be slightly different
depending on previous installations, newer software versions, etc.):
Attach the dongle to the back of the machine
1) Install Citilabs License 2014 (or later available license versions)
2) Install Cube Base (double-click on the cube611setup.exe file)
3) When requested, install ArcGIS Runtime 10.2.2 (it is mandatory to use this ArcGIS
version)
4) Restart the computer
After having installed standard Cube, you have to install additional new programs contained in
the Java_Voyager_programs.7z file, following instructions:




Files under Voyager_131013 must be copied in the following directories:
o

File Highway.rsc in C:\Program Files (x86)\Citilabs\CubeVoyager\resource

o

File hwyload.dll in C:\Program Files (x86)\Citilabs\CubeVoyager

o

File HWYLOAD.TDF in C:\Program Files (x86)\Citilabs\CubeVoyager

o

File tppdlibx.dll in C:\Program Files (x86)\Citilabs\CubeVoyager

File under AppMan must be copied in the following directory:
o

File AppManager.exe in C:\Program Files (x86)\Citilabs\Cube

Important Note: Update the above programs prior to open the model in Cube!

Other programs
The model uses the programming language Java, therefore it is required to have:
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Java runtime environment (jre). Platform: 1.6. Product: 1.6.0_17 (later program versions
are also possible to use)

Location for the above programs: http://www.java.com/sv/download/.
After having installed the program above, you have to install an additional new program
contained in the Java_Voyager_programs.7z file, following instruction below:


Double-click on jre-7-windows-x64.exe in order to install the program. (The jre is
necessary for the Railway Capacity Module RCM program and the parallel processing
program to work.)

For RCM the following CLP software is provided, CLP64.exe. So far, it is a superior alternative
for RCM-problems according to experience.

Samgods GUI installation
Unzip the zipped file Samgods_V1.2.7z, and select a destination folder. The default folder is
C:\Models\, however, any other folder works as well. It is recommended to select a folder name
without any blank value neither special characters (å, ä ö). Moreover, an advice is to put the
folder close to the root. The folder structure for the GUI is displayed in Table 1.
Table 1 Folder structure.
C:\Samgods\

Samgods.cat

Catalog file

01_Programs

Folder

02_Applications

Folder

03_GIS_Data

Folder

04_Media

Folder

05_Input_Data

Folder

06_Reports

Folder

07_Python

Folder

Scenario_Tree

Folder

The scenario folder for a specific scenario is in the Scenario Tree folder.
For the complete list of folders and files, see the technical documentation of the Samgods GUI.
To properly install all the programs connected to the model (GIS tools, user programs), do the
following:
1) Open the catalog file (Samgods.cat) in Cube Base (double click on the catalog file or
double click on the Cube icon on the desktop -> welcome screen -> open an existing
catalog -> browse to Samgods.cat)
2) To update the paths for the application, double click on each application (in total 11
applications) under “Applications” window, and click “Yes” to the following question (11
times):
“The base path of this Application has been moved from {Old folder} to {Selected folder}. Do you
wish to update the path for all Application (.APP, .PRJ) and Control (.CTL) files in the Application
structure? (Note the same subdirectory structure as in the original Applications will be assumed)”
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3) To set the properties of the catalog file, go to “Scenario” menu on the toolbar and select
“Properties”. On the Catalog Properties window, select the “Model User” tab, and set the
Model User as “Model Applier”. Under Model Applier section select "Developer" as
shown in Figure 1.

Figure 1 Correct settings for the catalog file.
4) Then, select the “Data Panel” tab, and set the values as in Figure 2.

Figure 2 Property setting for the catalog file.

5) Click “OK” to continue
6) Modify the catalog keys (i.e., parameter settings) below from the interface in the
following manner:
a) Select Scenario_Tree scenario
b) Select the Installation application
c) Double-click on the Scenario_Tree scenario

18

Installation Instructions
d) For the following catalog keys, change to its corresponding installed version if
needed2 (see Figure 3 for an example):
i)

“Hard Drive where the model resides” ( pre-defined: C:)

ii)

“Cube Software” (pre-defined: version 6.1.1 )*

iii) “ArcGIS Software” ( pre-defined: 10.2.2 )*
iv) “Python Software” (pre-defined: version 27)
v) “Logistics Model Software” (1.1.4)
For the catalog key “Location of Python program” change if needed the folder where Python 27 is
installed (pre-defined: C:\Python27\ArcGIS10.2)
vi) For the catalog key “Location of Java program” change if needed the
folder where Java is installed (pre-defined:
C:\ProgramData\Oracle\Java\javapath)
vii) For the catalog key “Path to cmd.exe:” change if needed the folder where
cmd.exe resides
viii) For the catalog key “Scenario name for the BASE scenario” point to the
scenario that should be used as base scenario (pre-defined: Base2017)

Figure 3 Example of catalog key values for the Installation application.

e) Run the Installation application by clicking “Run” in the scenario interface, or by
selecting Application -> Run Application -> OK on the main toolbar. (If “OK” is clicked
instead of “Run”, the application will not run – the changes in the settings will only be
saved.)

2

If you are using Swedish Windows 7/8, the system name of the standard Program folder is
Program Files. So in the keys in the Installation application, use “C:\Program Files\...”, not
“C:\Program\...”.
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f)

Save the model catalog clicking on

Now the GUI is installed.
* To properly set the values for the catalog keys indicated with *, see the information under the
Menu Bar; Help -> About (see Figure 4 and Figure 5 below for an example).
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Figure 4 How to access the “About …” information.

Figure 5 Example of the “About …” window.
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7 Cube Interface components
This chapter outlines the main components of the Cube Interface and explains their functions.
The Cube Interface has five different windows as shown in Figure 6. When opening the model,
three different user types can be selected – Model developer or Standard user or Advanced
user. The Model developer role is mainly used when setting up or installing the system, while the
Standard and Advanced user roles typically are used when running the model and for scenario
handling. The set of active windows depends on the user role, and this manual is relevant to all
user types.
The large area to the right is a workspace where manager windows and messages are shown,
i.e., when the user wants to manage a scenario, the Scenario manager window is shown here.
There are also Application manager windows and Data section manager windows. The manager
windows are opened from the corresponding window on the left hand side.
For more information on the Cube interface, please refer to the Cube Help, accessed from the
main toolbar: Help -> Cube Help.

Scenarios
window

Data Section
window

Applications
window

Keys
window

Figure 6 Example of Scenario manager window.
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Scenarios window
The purpose of the Scenarios window is to list the scenarios that exist in the model.
A scenario refers to a set of specific input files/values. An application is a group of programs. In
the Samgods GUI a set of applications are defined with different types of functionalities. Different
scenarios can be set up in the GUI by using the set of available applications. A scenario can be
opened and managed using different applications by double-clicking on the scenario name in the
Scenarios window (in Standard user/Advanced user mode). For example, the input data and
parameters to the scenario can be displayed or edited. When the scenario is open in the
Scenario manager window, it is possible to select the application you want to use by the scroll
down menu. Another way to open the application you want to use is to select the application in
the Applications window and then double-click on the scenario in the Scenarios window. The
application is then run by clicking “Run”.
The tree structure of the scenarios included in the Samgods GUI is visualized in the
Scenario_Tree in the Scenarios window. The Scenario_Tree is used for scenario management.
The default base scenario is included in the Scenario_Tree and is called Base2017. In the base
scenario all the input data is defined and it represents the parent for future sibling and child
scenarios.
An example of a Scenario manager window for the application Edit the data is given in Figure 7
below.

Data Section
window

Keys

Figure 7 Example of Scenario manager window.
The keys which are possible to set values for in the Scenario manager window are strictly
connected to the application selected in the Applications window. In Chapter 8, tables of keys
connected to the respective applications are presented.
Tip. Open an application (in model applier mode) to set the parameters for a scenario by
double-clicking on the scenario and select the application in the scroll down menu.
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7.1.1

Implication in scenario setup for new scenarios

In the following paragraphs will be explained the rules in Cube spftware and the ones specifically
designed for Samgods Model under scenario setup. To avoid wrong catalog definitions in
specific scenarios is sufficient to:
1) identify which is the model year we want to run
2) create a child scenario under Year_2017 or Year_2040
If a specific scenario holds catalog key values that we want to preserve in the next runs (without
the need to change again all the modified catalog keys), it would be sufficient to create child
scenarios from that scenario.
7.1.2

Catalog key values definitions in Cube

The catalog key value for any catalog key in a specific scenario is based on the following four
rules:


Rule 0: no default value is specified in the catalog key. The catalog key is empty



Rule 1: Default value of the catalog key: the default value is specified during the
creation of the catalog key



Rule 2: Specific value changed by an intentional action of the user



Rule 3: Value from father scenario: creating a child scenario, all the values for all
catalog keys will derived from father scenario

Which of the above rules is applied depends on the actions performed by the use and their order.

Rule 0: no default value
Looking at a simple example in which is present only one scenario (Base) and only one catalog
key (numerical) “Example”.

The value for the scenario is empty, since no default value has been applied. (Rule 0). For all
child scenarios created, “Example” will be always empty.

Rule 1: default value
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The catalog key can be created with a default value. Each new scenario will have the default
value in it without any action. For instance, in “Example”, defining a default value of 99, will result
in getting 99 in all scenarios (Base and children).

From the GUI, it is also possible to understand that the value is derived from the default value by
the form of the element under Keys window. If is grey, (as in our example above - see red
rectangle), the key has a default value and neither the current scenario nor its parent defines a
value for the key. In our example, it means we can understand that both CHILD1 and Base are
using a default value, otherwise a different form will be used.

Rule 2: User changes the value intentionally for a specific scenario
Suppose that for CHILD1 we want to apply a value of -100 rather than the default value. This
change will affect CHILD1 and all the future child scenarios created under CHILD1.
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The form of the element under Keys window (red rectangle) will be bold.
In other words, every time the form is bold, means the rules from father scenario or default value
are broken. What is specified in the current scenario has been intentionally changed from the
father scenario.

Rule 3: Value from father scenario
Rule 3 is the standard rule which does not require any action from the used. But which is the final
value depends if the father scenario has Rule 0, Rule 1 or Rule 2 in place.
In the examples above, CHILDOFCHILD1 has -100, since father scenario has Rule 2 in place

(modified value from default). Form under “Example” is in Italics.
CHILDOFCHILD2 has 99 since father scenario and base have Rule 1 in place. Form under
“Example” is still in grey.
Suming up what is the content of “Keys window”:


The first row of the key grid gives the name of the currently selected scenario



Subsequent rows list each key in the catalog

The value of the key for the current scenario is shown in the Value column. It may appear in one
of the following forms:


Blank if the key value is undefined for the selected scenario



Bold if the value is defined explicitly for the selected scenario



Italics if the value is inherited from the parent scenario



Grey if the key has a default value, and neither the current scenario nor its parent
defines a value for the key
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7.1.3

Catalog key values definitions in Samgods model

The scenario tree structure in Samgods model follows the rules explained in previous paraghap
and each catalog key can follow one of the rules.
Scenario_Tree scenario holds all the default values for all catalog keys. In the initial installation
only the catalog keys related to program folder location or version must be modified.

“Year_2017” and “Year_2040” Scenarios are functional in keeping in place the right values for
the following catalog keys:
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Maximum number of zones: Year_2017 has the default value (1377 grey),
Year_2040 has default value (1377 grey). (MainSc2040_Xore has the default value
1379.)



Year of PWC matrices: Year_2017 has the default value 2016 (grey), Year_2040
has value 2040 (bold)



Lock solution file: Year_2017 has value “Locked_2017” (bold), Year_2040 has value
“Locked_2040.dat” (bold). None of them is using default value (Locked_empty.dat).
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Applications window
In the Applications window all applications defined in the model catalog can be found. An
application group is the collection of programs and sub-groups belonging to the respective
application. When an application is selected (by clicking on it in the Applications window) the
application group is shown in the Application manager window. In the Application manager
window you can see Program boxes (e.g. MATRIX, HIGHWAY, NETWORK, and PILOT) and/or
other applications (called sub-groups) belonging to the application group (see Figure 8). In the
Applications window, you can see the main application at the highest level, and go through the
tree structure down to lower levels.

Application group

Figure 8 View of an application and its corresponding application groups.
In the Samgods GUI, the defined applications are (see the Applications window in model
developer mode):


Installation



Create the editable files



Edit the data



Samgods Model



Compare Scenarios
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Handling scenario



PWC_Matrices



Change matrix format



Select Link Analysis



Cost Benefit Analysis - ASEK Values



Elasticity Module

Data Section window
The Data Section window provides direct access to the main input and output files, which can be
utilized when working with the model (editing, controlling, etc.). It allows the user to display and
edit the input data, as well as to display the outputs and reports for specific scenarios and runs.
In conjunction with the Scenario manager window, it enables the user to easily access all data,
without needing to know where it is actually stored. The structure of the Data Section window is
described in Table 2, which also shows the location of the files, the names of the tables/maps, a
short description of its contents and which application that produces or uses the files.
There are three main folders in the Data Section window: Scenario Inputs, Scenario Outputs and
Scenario Reports. The General tables under Scenario Inputs are always accessible from the
Data Section window. The Editable data (also found under Scenario Inputs) is accessible only
during the edit phase or if the user has selected not to delete the temporary geodatabase (see
explanation for the Edit the data applications in Section 8.4).
The available output in the Scenario Outputs folder depends on the choices made when running
the Samgods Model application. The available outputs in the folder Scenario Outputs\Samgods
Report are always listed in the log report Scenario Outputs\Samgods Report\Existing Outputs.
There are two other log reports except Existing Outputs: Report for the import phase and Report
for the edit phase, which state any error messages or other messages from the applications
Handling scenario and Edit the data. For more information on the log reports see Chapter 12
Chapter.
Moreover, the Data Section window includes the 21 standard reports per Standard Logistic
Module, 22 standard reports for Rail Capacity Management and 15 standard reports for Cost
Benefit Analysis also called summary reports, which summarize the output from running the
Samgods GUI, in Word format. The summary reports are found in the Scenario Reports folder
and are listed in Table 2. To browse to different pages in the reports, use the arrows in the main
toolbar. It is possible to export the tables to Excel, by selecting the table in the Word format
report, right-clicking and selecting “Export” and type in a name with an Excel file format ending.
Some of the standard reports are also available as spreadsheet reports in the Scenario Outputs
folder, where they are marked with the same report number as in Scenario Reports (see, e.g.,
Scenario Outputs\Samgods Report\Logistic Module\OD Covered).
For some of the data files, the variable names that appear in the headings are explained in
tables in the appendix.
Before using and analyzing any output data regarding empty vehicles/vehicle kilometres or the
total number of vehicles (i.e. loaded + empty vehicles), please read the Section 15.2 about empty
vehicles in the appendices.
The GUI allows producing different aggregations in the results for Standard Logistic Module. The
model could produce the total number of loaded, empty and tonnes for all the commodity groups,
or just for a specific commodity group. The outputs will be saved with different name files ending
with a number of a suffix. Depending on the user choice, the possible values could be:
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0 (zero): all the commodities are aggregated, so the volumes and tonnes represent totals



A number among 1 and 16: a single commodity has been run

In order to access to the different aggregations, e.g. different files, it is requested to set the value
for catalog key “Select commodities for the Logistics module (…)” in the Samgods Model
application to the commodity or commodity group number you want to view and clicking “Save”
(please refer to Section 8.5 for more information).
For Rail Capacity Management Module (RCM) and Cost Benefict Analysis there are no options
and the only available choice is 0. That is related to the matter that the process requires all the
volumes to properly assess the congested level on the rail network, therefore a run for a specific
commodity would show inconsistent results to a full run with all commodity group.

Table 2 List of inputs and outputs accessible from the Data Section window.

Folder

Description

Used by
application

This folder contains all the inputs for
the scenarios

All

List of scenarios

Given a base scenario with standard
costs, the process applies variation of
costs expressed as variation in %

Elasticity
Module

Logit parameters
by commodity and
f2f type

Table with logit parameter for Chain
Choice by commodity group and flowto-flow type

Samgods
Model/Elastic
ity Module

Model Operating
Instructions

Rtf file with a short description on how
to run the Samgods GUI

All

Link Categories

Lookup table for the categories in the
network

All

NodeClass
description

Lookup table for the numbering system
(no longer required for the VY part)

Transfer Type at
terminals
List and codes for
modes (only visible
in developer
mode)

Lookup table for the transfer type
coded in the Nodes_Commodities data

All
Samgods
Model/Elastic
ity Module

Alphanumerical codes for modes

All

Zoning System

Lookup table for the ID_Region and
ID_Country codes

All

Modes

Lookup table for codes used for modes

All

V101 Speed Flow
Curves

Speed flow table with parameter
values for defining the delay functions
for vehicle class 101 (light lorry)

Samgods
Model/Elastic
ity Module
Samgods
Model/Elastic
ity Module

Name

Scenario Inputs

Scenario
Inputs\Model
Operating
instructions
Scenario
Inputs\General
tables

V102 Speed Flow
Curves
Ranges for node
classes (only

Same as previous but for vehicle
classes 102-105
For node classes from 12 to 19 the
range of allowed values for node
numbers

Edit the data
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Folder

Name
visible in developer
mode)
Default values for
the frequency
matrices (only
visible in developer
mode)
Port area
classification
Lower and upper
bounds for
consolidation
factors

Scenario
Inputs\General
tables\Logistics
module (only
visible in developer
mode and
advanced user)
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Description

Default frequencies for different vehicle
classes based on the terminal type
Port areas classification for Swedish
ports
Default upper and lower bounds for the
consolidation level ranking output per
submode

Used by
application

Edit the data
Edit the data
Samgods
Model/Elastic
ity Module

Empty vehicle
fractions per
vehicle type and
distance

See Section 13 point 4 for reference.
Function applied in extract procedure
per vehicle type. The empty vehicles
are calculated as fraction of loaded
ones based on function depending on
distance. See Section 13.6 for
reference.

County names

List of Sweden counties (in Swedish:
län) and related identification code

Other statistics
2016

Statistics on Kiel Canal, Öresund
bridge and Jylland in year 2016 used
in the calibration procedure

Chain_List_40

List of chains using 40 vehicle types

Trakbandel
definition

Trakbandel codes with their description
of section and corridor

Samgods
Model/Elastic
ity Module
Samgods
Model/Elastic
ity Module
Samgods
Model/Elastic
ity Module

The main vehicle type used in the
BuildChain process by submode id (i.e.
vehicle submode A-U) and commodity
(P1-P16).

Samgods
Model/Elastic
ity Module

List of vehicle types (VHCL_NR) by
submode id and commodity for
ChainChoi

Samgods
Model/Elastic
ity Module

Main vehicle class
for BuildChain
Vehicle types by
chain and
submode
(ChainChoi)

Direct Access

Whether direct access is active by
commodity (P1-P16) and type of firmto-firm flow (0-9, see table Type of
Flow MATRIX below)

Type of Flow
MATRIX

Lookup table with codes for type of
flow matrices

List of Chains

List of Chain types

Samgods
Model/Elastic
ity Module
Samgods
Model/Elastic
ity Module

Samgods
Model/Elastic
ity Module
Samgods
Model/Elastic
ity Module
Samgods
Model/Elastic
ity Module
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Folder

Scenario
Inputs\Editable
data

Name

Description

Vessel Type
(vessel ship)

Lookup table with codes for container
and non-container vessels

Used by
application
Samgods
Model/Elastic
ity Module

Consolidation
factors by chain (i.
e. General and by
product groups)

Individual consolidation bounds for all
sub modes [LB, UB] Default values
and values by commodity group (-1
value means keep default values)

Samgods
Model/Elastic
ity Module

Input_Data.mxd

General map to visualize all
georeferenced data

Edit the data

EMME Network
(211 format)

The Emme transport network with all
link and node attributes (see Section
10.1 for further details)

Edit the data

EMME Speed
table
General
parameters (only
visible in developer
mode)
Logistics model
parameters (only
visible in developer
mode)

Emme speed table (see Section 10.1
for further details)

Edit the data

Table with the scenario parameters
catalog key settings

Edit the data

Table with logistics module parameters

Edit the data

Cargo Table

General values per commodity
Costs and capacity values by vehicle
type. The attribute “EMPTY_V” (1 or
0) concerns whether the number of
empty vehicles will be calculated (1) or
not (0)

Edit the data

General Vehicles
Parameters (by
vhcl class only)
Specific Vehicles
Parameters (by
vhcl class and
commodity group)

Edit the data

Cost values by vehicle type and
commodity group

Edit the data

Scenario Network

Network (links and nodes) for all
modes (GIS map)

Edit the data

Nodes
Commodities

GIS map with all terminals and
specifications on allowed transfer
types and commodities per terminal

Edit the data

Nodes

Ports Sweden

Frequency network
Tax by country
Table

GIS map of zones and terminals with
values for the logistics module and port
area classification
GIS map of Swedish ports with the
pilot fees by vehicle type (sea mode
only)

Edit the data

Edit the data

GIS map with service frequencies
(transports per week) per
mode/combination of modes and
origin-destination connection. For more
information on the frequency network,
see the appendix

Edit the data

Tax by country and vehicle type

Edit the data
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Folder

Scenario
Inputs\Emme
tables

Scenario
Inputs\Others

Name
Tax by Linkclass
Table

Description

Used by
application

Tax by link type and vehicle type

Edit the data

Tax by link Table

Tax for specific links by vehicle type

Edit the data

Toll bridges Table

Bridge tolls per vehicle type

Edit the data

Daily bidirectional capacity for
domestic rail links

Edit the data

Rail capacity table
Default values for
the EMME macros
(only visible in
developer mode)
In-zone distances
– default values
(only visible in
developer mode)
Geodatabase file
for exported
matrices
Rail capacity table
with EMME node
numbers

Folder of Scenario
JA (CBA)
Scenario
Inputs\PWC_Matri
ces
Scenario
Inputs\Calibration
factors
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PWC matrix by
commodity
Port area
differences (RCM)
(only visible in
developer mode)
Parameters for
Port Area
Calculation (only
visible in developer
mode)
Parameters for Kiel
Canal Calculation
(only visible in
developer mode)
Port Area Scaling
factors (only visible
in developer
mode)
Kiel Canal Scaling
factor (only visible
in developer
mode)
Scaling factors for
Vehicle class
parameters (only
visible in developer
mode)

Table containing matrix names for LOS
matrices in Emme format
Default values for distances within
each zone (diagonal values in the
distance matrices). Applied when
origin and destination are in the same
zone

Location of the geodatabase file
As Rail capacity table with added
information of EMME nodes
Folder location of scenario JA used in
CBA (Example:
{CATALOG_DIR}\Scenario_Tree\Year
_2017\Base2017\)

Edit the data

Samgods
Model
Change
matrix format
Samgods
Model
Cost Benefit
Analysis ASEK Values

Displays the PWC matrix in Voyager
format for a specific commodity, see
Section 8.8 for instructions

PWC_Matric
es

Differences between modelled and
surveyed tonnes per port area and
commodity group

Samgods
Model/Elastic
ity Module

Step length, minimum value, cut off
value and default minimum value for
calibration of port area throughputs

Samgods
Model/Elastic
ity Module

Step length, minimum value, cut off
value and default minimum value for
calibration of Kiel Canal flows

Samgods
Model/Elastic
ity Module

Resulting scaling factors applied by
commodity group and port area to
TIME skims

Samgods
Model/Elastic
ity Module

Resulting scaling factor for the Kiel
canal applied to TOLL value

Samgods
Model/Elastic
ity Module

Scaling factors for vehicle costs by
commodity group

Samgods
Model/Elastic
ity Module
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Folder

Name

Description

Used by
application

Scenario Outputs

Existing Outputs
(Log report)

List of available outputs in the
Samgods Report

Samgods
Model

Report for the
import phase (Log
report)

Report with any warnings or messages
from the Scenario import function (in
the Handling scenario application) (see
Section 8.7)

Handling
scenario

Network with costs
for checking

Binary network with Toll, Taxes and
Fees integrated

Tax_Country
Scenario Table

Taxes by Country ID applied in current
scenario

Tax_Category
Scenario Table

Taxes by Category applied in current
scenario

Tax_by_Link
Scenario Table

Specific taxes on links applied in
current scenario

Scenario
Outputs\Scenario_
Import_function_R
eport
Scenario
Outputs\Scenario
Tables_costs taxes
tolls

Vehicle_parameter
s Scenario Table

Tolls present in current scenario
Vehicle costs applied by vehicle type
and commodity group in current
scenario

Samgods
Model/Elastic
ity Module
Samgods
Model/Elastic
ity Module
Samgods
Model/Elastic
ity Module
Samgods
Model/Elastic
ity Module
Samgods
Model/Elastic
ity Module
Samgods
Model/Elastic
ity Module

Report for the edit
phase (Log report)

Report with any warnings or error
messages from the Edit the data
application (see Section 8.4)

Edit the data

LOS Road Mode

LOS matrices between zones (both
terminals and actual zones) per vehicle
type for:

Samgods
Model

LOS Rail Mode

time – T [hours],

LOS Sea Mode

distance – D [km],

LOS Air Mode

extra costs – X [SEK],

Toll_by_link
Scenario Table

Scenario
Outputs\Edit the
data Report
Scenario
Outputs\Samgods
Report\LOS
matrices
generation

domestic distances – DD [km]
Scenario
Outputs\Samgods
Report\Logistics
Module\OD
Vehicles MAT

Road – Vehicle
Flows
Rail – Vehicle
Flows
Sea – Vehicle
Flows

OD matrices of loaded vehicle flows by
vehicle type. The sheet name indicates
the vehicle type and the scenario
name

Samgods
Model

OD matrices in tonnes by vehicle type.
The sheet name indicates the vehicle
type and the scenario name

Samgods
Model

Air – Vehicle Flows
Scenario
Outputs\Samgods
Report\Logistics
Module\OD
Tonnes MAT

Road – Goods
Flows
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Folder

Name
Rail – Goods
Flows
Sea – Goods
Flows

Description

Used by
application

OD matrices of empty vehicle flows by
vehicle type. The sheet name indicates
the vehicle type and the scenario
name.

Samgods
Model

Air – Goods Flows
Scenario
Outputs\Samgods
Report\Logistics
Module\OD Empty
Vehicles MAT

Road – Empty
vehicle Flows
Rail – Empty
vehicle Flows
Sea – Empty
vehicle Flows
Air – Empty vehicle
Flows

Scenario
Outputs\Samgods
Report\Logistics
Module\OD
Covered

Output by vehicle
class (spreadsheet
for summary report
no. 2: Logistics
module)

Output by chain
(spreadsheet for
summary report
no. 2: LM chains)
Loaded Demand
(spreadsheet for
summary report
no. 2: LM Demand)
(new)
Report #5
Logistics costs at
zone level
(spreadsheet for
summary report
no. 5)
Report #6 Goods
flow through
terminals
(spreadsheet for
summary report
no. 6)
Report #6b Goods
flow through
terminals
(excluding land
based transfers)
(spreadsheet for
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For important explanations of the
output in terms of empty vehicles, see
appendix section 16.2

Summary table with information by
vehicle type (number of shipments,
number of loaded vehicles, transport
distances, tonnes, tonne kms, average
loading factors, average distances),
split up on domestic, international and
total

Samgods
Model

Summary table with information by
chain type (total numbers of
shipments, transport distances,
tonnes, tonne kms, logistic costs,
average costs per tonne km), split up
on domestic, international and total

Samgods
Model

Summary table of the tonnes
transported and the tonnes in the
PWC-matrices together with allocation
success rates

Samgods
Model

Logistics costs per zone by commodity
group (P01-P16) and from/to flows to a
zone

Samgods
Model

Goods flow (tonnes) through terminals
per commodity (P01-P16) and divided
by direct access to (DAIMPORN), and
from (DAEXPORN) or regular
(REGULARN). Regular refers to flows
not having direct access

Samgods
Model

Total goods flow (tonnes) through
terminals per commodity (P01-P16)
excluding land based transfers

Samgods
Model
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Folder

Name
summary report
no. 6b) STD

Report #7
Domestic tonne
kms with container
per mode (road,
rail, sea, air)
(spreadsheet for
summary report
no. 7)
Report #8
Domestic vehicle
kms with container
per mode (road,
rail, sea, air)
(spreadsheet for
summary report
no. 8)
Report #10
Tonnes km per
mode, commodity,
domestic, total
domestic and
international
(spreadsheet for
summary report
no. 10)
Report #11
Tonnes per mode,
commodity,
domestic,
tdomestic and
international
(spreadsheet for
summary report
no. 11)
Report#12 node
and link costs per
vehicle and
product group
(spreadsheet for
summary report
no. 12)
Report #19
Loaded and
unloaded tons on
rail terminals
(spreadsheet for
summary report
no. 19)

Description

Used by
application

Transport work (tonne kms) in Sweden
for containers per commodity and
vehicle type

Samgods
Model

Traffic work (vehicle kms) in Sweden
for container transports per commodity
and vehicle type

Samgods
Model

Transport work (tonne kms) per
commodity, mode. Split into three
categories: domestic, total domestic
and international respectively

Samgods
Model

Transported tonnes per commodity.
Split into three categories: domestic,
total domestic and international
respectively

Samgods
Model

Link and node costs per vehicle type,
per commodity and split into total
domestic and international respectively

Samgods
Model

Loaded and unloaded tons on Rail
terminals per product group

Samgods
Model
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Folder

Scenario
Outputs\Samgods
Report\Assignment

Scenario
Outputs\Samgods
Report\Reports

Name

Road Assigned
Network
Rail Assigned
Network
Sea Assigned
Network
Air Assigned
Network

Assigned Network
Report #1
VHCLKM
(spreadsheet for
summary report
no. 1)
Report #3 Tonkm
per Mode with
statistics STD
(spreadsheet for
summary report
no. 3)
Report #4
TONNESKM
(spreadsheet for
summary report
no. 4)
Report #9 Vehicle
kms, tonne kms,
empty vehicle kms
and total vehicle
kms per
geographic region
per mode (road,
rail) (spreadsheet
for summary report
no. 9)
Report #13 Port
area statistics STD
(spreadsheet for
summary repost
no. 13)

38

Description
GIS network with the assignment of
the freight flows to the transport
network per vehicle type, in tonnes and
in number of vehicles (loaded and
empty). For important information on
the empty vehicles, see appendix
Section 16.2.

Used by
application

Samgods
Model

GIS network with the assignment of
the freight flows to the transport
network with all vehicle types in the
same network, in tonnes and in
number of vehicles (loaded and empty)
For important information on the empty
vehicles, see appendix Section 16.2.

Samgods
Model

Summary table of number of vehicle
kms per vehicle type and mode (split
up into 2 regional categories domestic
and total domestic and 3 aggregation
levels loaded/empty/all vehicles). See
appendix Section 16.2.

Samgods
Model

Tonne-kms in millions on domestic
movements per main mode (Road,
Rail, Sea) and international (Air) in
standard logistics module

Samgods
Model

Summary table of tonne kms
(domestic, international and total) per
vehicle type and mode road, rail, sea
and air.

Samgods
Model

Summary table of vehicle kms (split up
into loaded, empty and all vehicles)
and tonne kms per geographic region
and mode (road and rail). See
appendix Section 16.2.

Samgods
Model

Tonnes per port area and commodity
group and comparison with statistics
(results from standard logistics
module)

Samgods
Model
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Folder

Scenario
Outputs\RCM
Report

Scenario
Outputs\RCM
Report\Logistic
Module\OD
Vehicles MAT

Name
Report #14
Oresund Kiel canal
STD (spreadsheet
for summary report
no. 14)
Bidirectional
tonnes per mode
STD
Report #16
VHCLKM and
distribution per
road vehicle type
and county – totals
(spreadsheet for
summary report
no. 16)
Report #17
VHCLKM and
distribution per
road vehicle type
and county –
Category 11
(spreadsheet for
summary report
no. 17)
Report #18
VHCLKM and
distribution per
road vehicle type
and county – Other
roads
(spreadsheet for
summary report
no. 18)
Rail Capacity table
for current
scenario
Kiel Oresund
Jylland RMSE
calculation

Description
Results on Öresund bridge, Kiel canal
and Jylland and comparison with
statistics (results from standard
logistics module)
Network with bidirectional
tonnes/100.000 per mode road, rail
and sea (results from standard
logistics module)

Used by
application

Samgods
Model

Samgods
Model

Vehicle kms per county and vehicle
type and their distribution on all the
roads (results from standard logistics
module)

Samgods
Model

Vehicle kms per county and vehicle
type and their distribution on E10
(European roads = category 11)
(results from standard logistics
module)

Samgods
Model

Vehicle kms per county and vehicle
type and their distribution on all types
roads except E10 (results from
standard logistics module)

Samgods
Model
Samgods
Model

Number of links
over capacity

Definition of rail bidirectional capacities
per day for the current scenario
Comparison by mode of ml tonkm
modelled vs observed and related
RMSE
Number of links where flows over
capacity ratio is greater than one. In
the event the number is zero, RCM
process is skep since not required.

Road – Vehicle
Flows
Rail – Vehicle
Flows

OD matrices of loaded vehicle flows by
vehicle type (results from Rail Capacity
Management module). The sheet
name indicates the vehicle type and
the scenario name.

Samgods
Model

Samgods
Model

Samgods
Model

Air – Vehicle Flows
Sea – Vehicle
Flows
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Folder
Scenario
Outputs\RCM
Report\Logistic
Module\OD
Tonnes MAT

Name

Description

Road – Goods
Flows
Rail – Goods
Flows

OD matrices in tones by vehicle type
(results from Rail Capacity
Management module). The sheet
name indicates the vehicle type and
the scenario name

Air – Goods Flows
Sea – Goods
Flows
Scenario
Outputs\RCM
Report\Logistic
Module\OD
Empties MAT

Scenario
Outputs\RCM
Report\Logistic
Module\OD
Covered

Road – Empty
vehicle Flows
Rail – Empty
vehicle Flows
Air – Empty vehicle
Flows
Sea – Empty
vehicle Flows

Output by vehicle
class (RCM)

Output by chain
(RCM)

Loaded Demand
(RCM)
Report #5 Logistic
costs at zone level
(RCM)
(spreadsheet for
summary report
no. 5)
Report #6 Goods
flow through
terminals
(spreadsheet for
summary report
no. 6)
Report #6b Goods
flow through
terminals
(excluding land
based transfers)
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OD matrices of empty vehicle flows by
vehicle type.

Summary table with information by
vehicle type (number of shipments,
number of loaded vehicles, transport
distances, tonnes, tonne kms, average
loading factors, average distances)
and regional diff DTI.
Summary table with information by
chain type (total numbers of
shipments, transport distance, tonnes,
tonne kms, logistic cost, average cost
per tonne km) and regional diff DTI.
Summary table of the tonnes
transported and the tonnes in the
PWC-matrices together with allocation
success rates
Logistics costs per zone per
commodity (P01-P16) and from/to
flows to a zone

Used by
application

Samgods
Model

Samgods
Model

Samgods
Model

Samgods
Model

Samgods
Model

Samgods
Model
Goods flow (tonnes) through terminals
per commodity (P01-P16) and divided
by direct access to (DAIMPORN), and
from (DAEXPORN) or regular
(REGULARN). Regular refers to flows
not having direct access

Samgods
Model

Total goods flow (tonnes) through
terminals per commodity (P01-P16)
excluding land based transfers

Samgods
Model

Cube Interface components

Folder

Name
(spreadsheet for
summary report
no. 6b)
Report #7
Domestic tonne
kms with container
per mode (road,
rail, sea, air)
(RCM)
(spreadsheet for
summary report
no. 7)
Report #8
Domestic vehicle
kms container per
mode (road, rail,
sea, air) (RC)
(spreadsheet for
summary report
no. 8)
Report #10
Tonnes km per
mode, commodity,
domestic,
tdomestic and
international
(RCM)
(spreadsheet for
summary report
no. 10)

Description

Used by
application

Transport work (tonne kms) in Sweden
for container transports per commodity
and vehicle type

Samgods
Model

Traffic work (vehicle kms) in Sweden
for container transports per commodity
and vehicle type

Samgods
Model

Transport work (tonne kms) per
commodity, vehicle type and regional
diff DTI

Samgods
Model

domestic/total domestic/international
Report #11
Tonnes per mode,
commodity,
domestic,
tdomestic and
international
(spreadsheet for
summary report
no. 11)
Report #12 node
and link costs per
vehicle and
product group
(RCM)
(spreadsheet for
summary report
no. 12)
Report #19
Loaded and
unloaded tons on
rail terminals
(spreadsheet for
summary report
no. 19) (new)

Tonnes per commodity, vehicle type
and regional diff DTI

Samgods
Model

Link and node costs per vehicle type,
per commodity and regional diff DTI

Samgods
Model

Loaded and unloaded tons on Rail
terminals per product group

Samgods
Model
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Cube Interface components

Folder

Scenario
Outputs\RCM
Report\Assignment

Scenario
Outputs\RCM
Report\Reports
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Name

Road Assignment
Network (RCM)
Rail Assignment
Network (RCM)
Sea Assignment
Network (RCM)
Air Assignment
Network (RCM)

Assigned Network
Report #1
VHCLKM (RCM)
(spreadsheet for
summary report
no. 1)
Report #3 Tonkm
per mode with
statistics RCM
(spreadsheet for
summary report
no. 3)
Report #4
TONNESKM
(RCM)
(spreadsheet for
summary report
no. 4)
Report #9 Vehicle
kms, tonne kms,
empty vehicle kms
and total vehicle
kms per
geographic region
per mode (road,
rail) (RCM)
(spreadsheet for
summary report
no. 9)
Report #13 Port
area statistics
(RCM)
(spreadsheet for
summary report
no. 13)
Report #14
Oresund Kiel canal
(RCM)
(spreadsheet for

Description
GIS network with the assignment of
the freight flows to the transport
network per vehicle type, in tonnes and
in number of loaded and empty
vehicles respectively

GIS network with the assignment of
the freight flows to the transport
network with all vehicle types in the
same network, in tonnes and in
number of loaded and empty vehicles
respectively
Summary table of number of vehicle
kms per vehicle type and mode (split
up into regional diff DT and into
loaded/empty total number of
vehicles).

Used by
application

Samgods
Model

Samgods
Model

Samgods
Model

Tonne-km in millions on domestic
movements per main mode (Road,
Rail, Sea) and international (Air)

Samgods
Model

Summary table of tonne kms by
regional DTI per vehicle type and
mode

Samgods
Model

Summary table of vehicle kms (split up
into #LEA-vehicles) and tonne kms per
geographic region and mode (road and
rail)

Samgods
Model

Tons per port area and commodity
group and comparison with statistics

Samgods
Model

Results on Öresund bridge, Kiel canal
and Jylland and comparison with
statistics

Samgods
Model

Cube Interface components

Folder

Name
summary report
no. 14)
Report #15 Trains
per day (tot,
empty, loaded)
from RCM
procedure
(spreadsheet for
summary report
no. 15)
Report #15b Rail
Capacity Network
Bidirectional
tonnes per mode
RCM
Report #16
VHCLKM and
distribution per
road vehicles and
county – totals
(RCM)
(spreadsheet for
summary report
no. 16)
Report #17
VHCLKM and
distribution per
road vehicles and
county – Category
11 (RCM)
(spreadsheet for
summary report
no. 17)
Report #18
VHCLKM and
distribution per
road vehicles and
county – Other
roads (RCM)
(spreadsheet for
summary report
no. 18)
Comparison Ml
Tons RCM vs
Standard per
mode
Report Tons by
commodity groups
and total (Ktons)
(related map under
GIS maps\ GIS
map with Ktons by
commodity group)

Description

Used by
application

Number of loaded and empty trains per
day bidirectional and differences
between totals and capacities and
associated marginal costs

Samgods
Model

Network with capacities and #LEAtrains per day (same statistics as in
Report #15 but shown in the network)

Samgods
Model

Network with bidirectional
tonnes/100.000

Samgods
Model

Vehicle kms per county and vehicle
type and their distribution on all the
roads

Samgods
Model

Vehicle kms per county and vehicle
type and their distribution on E10
(European roads = category 11)

Samgods
Model

Vehicle kms per county and vehicle
type and their distribution on other
road types than E10

Samgods
Model

Absolute and percentage differences
per mode road, rail and sea (in millions
of tonnes) between RCM and STD

Samgods
Model

GIS network with total Ktons and
divided by commodity group, and rail
utilization as well (as percentage of
capacity)

Samgods
Model
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Folder

Scenario
Outputs\RCM
Report\GIS Maps

Scenario
Outputs\CBA
Report > Main
Reports

Scenario
Outputs\CBA
Report\OD
Covered

Name
Report #21
Domestic Total
and International
Tonkm and
VhclKm by
commodity group
RCM - RAIL
GIS map with
Ktons by
commodity group
GIS map with vhcl
by commodity
group

Used by
application

Table with tonkm, loaded and
unloaded vhclkm per total domestic
and international (tons are per year,
vehicles per day) on rail.

Samgods
Model

Standard GIS map with layers per
Mode and commodity group - Ktons
Standard GIS map with layers per
Mode and commodity group Loaded
Vhcl

Samgods
Model
Samgods
Model

Logistic Cost
Changes used for
CBA

Table with results produced using
methodology for CBA

Cost Benefit
Analysis ASEK Values

Vehicles, loaded
and empty, within
Swedish territory

Report of vhcl-km for loaded and
empties for emission model (ferries are
expressed as ferry vehicles)

Cost Benefit
Analysis ASEK Values

Output by vehicle
class (CBA)

Summary table with information by
vehicle type (number of shipments,
number of loaded vehicles, transport
distances, tonnes, tonne kms, average
loading factors, average distances)
and regional diff DTI.

Cost Benefit
Analysis ASEK Values

Output by chain
(CBA)

Loaded Demand
(CBA)
Report #5 Logistic
costs at zone level
(CBA)
(spreadsheet for
summary report
no. 5)
Report #6 Goods
flow through
terminals (CBA)
(spreadsheet for
summary report
no. 6)
Report #6b Goods
flow through
terminals
(excluding land
based transfers)
(CBA)
(spreadsheet for
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Description

Summary table with information by
chain type (total numbers of
shipments, transport distance, tonnes,
tonne kms, logistic cost, average cost
per tonne km) and regional diff DTI.
Summary table of the tonnes
transported and the tonnes in the
PWC-matrices together with allocation
success rates

Cost Benefit
Analysis ASEK Values
Cost Benefit
Analysis ASEK Values

Logistics costs per zone per
commodity (P01-P16) and from/to
flows to a zone. Cost based on ASEK
values.

Cost Benefit
Analysis ASEK Values

Goods flow (tonnes) through terminals
per commodity (P01-P16) and divided
by direct access to (DAIMPORN), and
from (DAEXPORN) or regular
(REGULARN). Regular refers to flows
not having direct access

Cost Benefit
Analysis ASEK Values

Total goods flow (tonnes) through
terminals per commodity (P01-P16)
excluding land based transfers

Cost Benefit
Analysis ASEK Values

Cube Interface components

Folder

Name
summary report
no. 6b)
Report #7
Domestic tonne
kms with container
per mode (road,
rail, sea, air) (CBA)
(spreadsheet for
summary report
no. 7)
Report #8
Domestic vehicle
kms container per
mode (road, rail,
sea, air) (CBA)
(spreadsheet for
summary report
no. 8)
Report #10
Tonnes km per
mode, commodity,
domestic,
tdomestic and
international (CBA)
(spreadsheet for
summary report
no. 10)

Description

Used by
application

Transport work (tonne kms) in Sweden
for container transports per commodity
and vehicle type

Cost Benefit
Analysis ASEK Values

Traffic work (vehicle kms) in Sweden
for container transports per commodity
and vehicle type

Cost Benefit
Analysis ASEK Values

Transport work (tonne kms) per
commodity, vehicle type and regional
diff DTI

Cost Benefit
Analysis ASEK Values

domestic/total domestic/international
Report #11
Tonnes per mode,
commodity,
domestic,
tdomestic and
international (CBA)
(spreadsheet for
summary report
no. 11)
Report #12 node
and link costs per
vehicle and
product group
(CBA)
(spreadsheet for
summary report
no. 12)
Report #19
Loaded and
unloaded tons on
rail terminals
(spreadsheet for
summary report
no. 19) (CBA)
Report #20 Order
and inventory

Tonnes per commodity, vehicle type
and regional diff DTI

Cost Benefit
Analysis ASEK Values

Link and node costs per vehicle type,
per commodity and regional diff DTI

Cost Benefit
Analysis ASEK Values

Loaded and unloaded tons on Rail
terminals per product group

Cost Benefit
Analysis ASEK Values

Order and inventory cost per product
group and total domestic/international
using ASEK values

Cost Benefit
Analysis ASEK Values
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Folder

Scenario
Outputs\Compare\
LOS matrices
generation

Name
costs for TDOM
and INT (CBA)

LOS Road Dif

Description

Used by
application

Absolute cost differences between the
current scenario and the scenario used
for comparison for the LOS matrices

Compare
Scenarios

Absolute differences in loaded vehicles
between the current scenario and the
scenario used for comparison for the
OD matrices

Compare
Scenarios

Absolute differences in tonnes
between the current scenario and the
scenario used for comparison for the
OD matrices

Compare
Scenarios

Absolute differences in empty vehicles
between the current scenario and the
scenario used for comparison for the
OD matrices.

Compare
Scenarios

Total generation (sum of each row)
and attraction (sum of each column)
for the vehicle OD matrices and
absolute differences to the scenario
used for comparison

Compare
Scenarios

GIS network with absolute differences
between the current scenario and the
scenario used for comparison of
loaded vehicles flows for all vehicle
types and modes

Compare
Scenarios

LOS Raíl Dif
LOS Sea Dif
LOS Air Dif
Scenario
Outputs\Compare\
Logistics
Module\OD
vehicles MAT

Road OD Dif
Rail OD Dif
Sea OD Dif
Air OD Dif

Scenario
Outputs\Compare\
Logistics
Module\OD
Tonnes MAT

Road TON Dif
Rail TON Dif
Sea TON Dif
Air TON Dif

Scenario
Outputs\Compare\
Logistics
Module\OD empty
MAT

Road EMP Dif
Rail EMP Dif
Sea EMP Dif
Air EMP Dif

Scenario
Outputs\Compare\
Logistics
Module\Tot Gen
Att

TRIPEND Road Dif
TRIPEND Rail Dif
TRIPEND Sea Dif
TRIPEND Air Dif

Scenario
Outputs\Compare\
Assignment

46

Compared Load
Net STD
Compared Load
Net RCM

Cube Interface components

Folder
Scenario
Outputs\Compare\
GIS maps
Scenario
Outputs\SelectLink
\STD
Scenario
Outputs\SelectLink
\STD \OD Vehicles
MAT

Name

Description

Used by
application

GIS map with
differences (Ktons)

GIS map with absolute differences
between the current scenario and the
scenario used for comparison of total
tonnes and by commodity group

Compare
Scenarios

Flows and Tonnes
Network STD

GIS network loaded vehicles flows and
tons for all vehicle types and modes
using the set of links, nodes and
commodities provided for the analysis

Select Link
Analysis

Road - vehicle
flows

Select link matrices by mode for
loaded vehicles

Select Link
Analysis

Select link matrices by mode for
tonnes

Select Link
Analysis

Road -Empty
vehicle flows
Rail – Empty
vehicle flows
Sea – Empty
vehicle flows
Air – Empty vehicle
flows

Select link matrices by mode for
unloaded vehicles

Select Link
Analysis

PATH STD 101

Path file for empty vehicles.

Select Link
Analysis

Path file for empty vehicles.

Select Link
Analysis

Rail – vehicle flows
Sea – vehicle
flows
Air – vehicle flows
Scenario
Outputs\SelectLink
\STD \OD Tonnes
MAT

Road - good flows
Rail – good flows
Sea – good flows
Air – good flows

Scenario
Outputs\SelectLink
\STD \OD Empty
Vehicles MAT

Scenario
Outputs\SelectLink
\STD
\Empties\Road

PATH STD 102
PATH STD 103
…
PATH STD 106
Scenario
Outputs\SelectLink
\STD \Empties\Rail

PATH STD 201
PATH STD 202
PATH STD 203
…
PATH STD 212
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Folder
Scenario
Outputs\SelectLink
\STD \Empties\Sea

Name

Description

Used by
application

PATH STD 301

Path file for empty vehicles.

Select Link
Analysis

Path file for empty vehicles.

Select Link
Analysis

PATH STD 302
PATH STD 303
…
PATH STD 322
Scenario
Outputs\SelectLink
\STD \Empties\Air
Scenario
Outputs\SelectLink
\STD \GIS Maps

Scenario
Outputs\SelectLink
\RCM
Scenario
Outputs\SelectLink
\RCM \OD
Vehicles MAT

PATH STD 401
GIS map with
Ktons by
commodity group
GIS map with vhcl
by commodity
group

Standard GIS map with layers per
Mode and commodity group Ktons
Standard GIS map with layers per
Mode and commodity group Loaded
Vhcl

Select Link
Analysis
Select Link
Analysis

Flows and Tonnes
Network RCM

GIS network loaded vehicles flows and
tons for all vehicle types and modes
using the set of links, nodes and
commodities provided for the analysis

Select Link
Analysis

Road - vehicle
flows

Select link matrices by mode for
loaded vehicles

Select Link
Analysis

Select link matrices by mode for
tonnes

Select Link
Analysis

Road -Empty
vehicle flows
Rail – Empty
vehicle flows
Sea – Empty
vehicle flows
Air – Empty vehicle
flows

Select link matrices by mode for
unloaded vehicles

Select Link
Analysis

PATH RCM 101

Path file for empty vehicles.

Select Link
Analysis

Rail – vehicle flows
Sea – vehicle
flows
Air – vehicle flows
Scenario
Outputs\SelectLink
\RCM \OD Tonnes
MAT

Road - good flows
Rail – good flows
Sea – good flows
Air – good flows

Scenario
Outputs\SelectLink
\RCM \OD Empty
Vehicles MAT

Scenario
Outputs\SelectLink
\RCM
\Empties\Road

PATH RCM 102
PATH RCM 103
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Folder

Description

Used by
application

Path RCM Rail

Unique path file for empty vehicles

Select Link
Analysis

PATH RCM 301

Path file for empty vehicles.

Select Link
Analysis

Path file for empty vehicles.

Select Link
Analysis

Name
…
PATH RCM 106

Scenario
Outputs\SelectLink
\RCM
\Empties\Rail
Scenario
Outputs\SelectLink
\RCM
\Empties\Sea

PATH RCM 302
PATH RCM 303
…
PATH RCM 322
Scenario
Outputs\SelectLink
\RCM \Empties\Air
Scenario
Outputs\SelectLink
\RCM\GIS Maps

Scenario
Outputs\SelectLink
\TraversalMat\STD
Scenario
Outputs\SelectLink
\TraversalMat\RC
M
Scenario
Reports\Logistic
Module (contains
the summary
reports for
standard logistic
module)

PATH RCM401
GIS map with
Ktons by
commodity group
GIS map with vhcl
by commodity
group
Folder location for
Road Traversal
Matrices (STD)

Standard GIS map with layers per
Mode and commodity group Ktons
Standard GIS map with layers per
Mode and commodity group Loaded
Vhcl

Select Link
Analysis

Traversal matrices in Emme format
(314) on road mode

Select Link
Analysis

Folder location for
Road Traversal
Matrices (RCM)

Traversal matrices in Emme format
(314) on road mode

Select Link
Analysis

Report_1_Tot
VHCKM by VHC
Type

Number of vehicle kms per vehicle
type (#LEA). And regional diff DT.

Samgods
Model

Report_2_Logistic
s Module

Summary table of no. of shipments,
no. of loaded vehicles, transport
distances, tonnes, tonne kms, average
load factors and average distance by
vehicle type by regional diff DTI

Samgods
Model

Report_2_LM_CH
AINS

Report_2_LM_DE
MAND

Summary table of no. of shipments,
costs, vehicle kms, tonnes, tonne kms
and average logistic costs per tonne
km, by transport chain type
Summary table of the tonnes
transported and the tonnes in the
PWC-matrices together with allocation
success rate

Select Link
Analysis

Samgods
Model

Samgods
Model
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Folder

Name

Description

Used by
application

Report_3_TonKm_
by_Mode_with_20
16StatisticsSTD

Tonne-kms in millions on domestic
movements per main mode (Road,
Rail, Sea) and international (Air)

Samgods
Model

Report_4_Total
tkms by VHC type

Summary table of tonne-kms (regional
diff DTI) per vehicle type

Samgods
Model

Report_5_Total
logistic cost at
zone-level

Total logistics costs per commodity
type (P01-P16) split by import and
export at geographical zone level

Samgods
Model

Report_6_Goods
flow through
terminals (number
of tonnes in and
out per year)
Report_6_b_Good
s flow through
terminals (total
number of tonnes
per year without
land based
transfers)
Report_7_Domesti
c tonne kms with
container per
mode (road, rail,
sea, air) and
vehicle cl

No. of tonnes through terminals
(described as zones) per commodity
(P01-P16), split into from/to flows for
direct access and flow for other
terminals (without direct access)

Samgods
Model

No. of tonnes through terminals
(described as zones) per commodity
(P01-P16), (without land based
transfers)

Samgods
Model

Domestic tonne kms with container
transports per mode and vehicle type,
split by commodity.

Samgods
Model

Total volume is also reported
Report_8_Domesti
c vehicle kms with
container per
mode (road, rail,
sea, air) and
vehicle cl
Report_9_Vehicle
kms and Tonnes
kms per
geographic region
Report_10_Transp
ort work (tonne
kms) per mode
and vehicle cl, total
and split per
commodity,
domestic,
tdomestic and
international
Report_11_
Transported goods
volume per mode
vehicle cl, total and
split per
commodity,
domestic,
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Domestic vehicle kms with container
transports per mode and vehicle type,
split by commodity Total volume is also
reported

Samgods
Model

Vehicle kms (for #LEA-vehicles) and
tonne kms per geographical region
(road and rail mode).

Samgods
Model

Transport work (tonne kms) per mode
and vehicle type and commodity.
Regional diff DTI

Samgods
Model

Transported goods (in tonnes) per
mode and vehicle type and commodity,
as well as regional diff DTI

Samgods
Model

Cube Interface components

Folder

Name
tdomestic and
international

Report_12_node
and link costs per
vehicle and
product group
Report_13_Tons_
per_PortArea_and
_commodity_Grou
p
Report_14_Oresun
d Bridge_Kiel
Canal and Jylland
Report_16_VHCL
KM and
distribution by
county - totals STD
Report_17_VHCL
KM and
distribution by
county - E10 roads
STD
Report_18_VHCL
KM and
distribution by
county Other roads
STD
Report_19_Loade
d_Unloaded_Tons
_Rail
Scenario
Reports\Rail
Capacity
Management
(contains the
summary reports
for rail capacity
management)

Report_1_Tot
VHCKM by VHC
Type (RCM)

Report_2_Logistic
s Module (RCM)

Report_2_LM_CH
AINS (RCM)

Report_2_LM_DE
MAND (RCM)

Description

Used by
application

Node and link costs per vehicle type
and product group, divided in total
domestic and international

Samgods
Model

Tonnes per port area and commodity
group and comparison with statistics

Samgods
Model

Results on Öresund bridge, Kiel canal
and Jylland and comparison with
statistics

Samgods
Model

Vehicle kms per county and vehicle
type and their distribution on all the
roads

Samgods
Model

Vehicle kms per county and vehicle
type and their distribution on E10
(category 11)

Samgods
Model

Vehicle kms per county and vehicle
type and their distribution on all the
roads except E10

Samgods
Model

Loaded and unloaded tons on rail
terminals per product group

Samgods
Model

Number of vehicle kms (#LEA)
Regional diff DT
Summary table of no. of shipments,
no. of loaded vehicles, transport
distances, tonnes, tonne kms, average
load factors and average distances by
vehicle type, split up into regional diff
DTI

Samgods
Model

Summary table of no. of shipments,
costs, vehicle kms, tonnes, tonne kms
and average logistic costs per tonne
km, by transport chain type
Summary table of the tonnes
transported and the tonnes in the
PWC-matrices together with allocation
success rate

Samgods
Model

Samgods
Model

Samgods
Model
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Cube Interface components

Folder

52

Name

Description

Used by
application

Report_3_TonKm_
per_Mode_with_20
16Statistics (RCM)
Report_4_Total
tkms by VHC type
(RCM)

Tonne-kms in millions on domestic
movements per main mode (Road,
Rail, Sea) and international (Air)

Samgods
Model

Summary table of tonnes and tonnekms (regional diff DTI) per vehicle type

Samgods
Model

Report_5_Total
logistic cost at
zone-level (RCM)
Report_6_Goods
flow through
terminals (number
of tonnes in and
out per year)
(RCM)
Report_6_b_Good
s flow through
terminals (total
number of tonnes
per year without
land based
transfers) (RCM)
Report_7_Domesti
c tonne kms with
container per
mode (road, rail,
sea, air) and
vehicle cl (RCM)
Report_8_Domesti
c vehicle kms with
container per
mode (road, rail,
sea, air) and
vehicle cl (RCM)
Report_9_Vehicle
kms and Tonnes
kms per
geographic region
(RCM)
Report_10_Transp
ort work (tonne
kms) per mode
and vehicle cl, total
and split per
commodity,
domestic,
tdomestic and
international
(RCM)
Report_11_
Transported goods
volume per mode
vehicle cl, total and
split per
commodity,
domestic,

Total logistics costs per commodity
(P01-P16) split by from/to flow at
geographical zone level

Samgods
Model

No. of tonnes through terminals per
P01-P16.

Samgods
Model

No. of tonnes through terminals
(described as zones) per commodity
(P01-P16), (without land based
transfers)

Samgods
Model

Domestic tonne kms with container
transports per mode and vehicle type,
split by commodity Total volume is also
reported

Samgods
Model

Domestic vehicle kms with container
transports per mode and vehicle type,
split by commodity Total volume is also
reported

Samgods
Model

Vehicle kms (#LEA) and tonne kms per
geographical region (road and rail
mode).

Samgods
Model

Transport work (tonne kms) per mode,
vehicle type and commodity, and
regional diff DTI

Samgods
Model

Transported goods (in tonnes) per
mode and vehicle type, commodity,
and regional diff DTI

Samgods
Model

Cube Interface components

Folder

Name
tdomestic and
international
(RCM)
Report_12_node
and link costs per
vehicle and
product group
(RCM)
Report_13_Tons_
per_PortArea_and
_Commodity_Grou
p (RCM)
Report_14_Oresun
d Bridge_Kiel
Canal_Jylland
(RCM)
Report_15_Trains
per day (tot,
empty, loaded)
(RCM)
Report_16_VHCL
KM and
distribution by
county - totals
(RCM)
Report_17_VHCL
KM and
distribution by
county - E10 roads
(RCM)
Report_18_VHCL
KM and
distribution by
country - Other
roads (RCM)
Report_19_Loade
d_Unloaded_Tons
_Rail (RCM)
Report_21_Domes
tic Total and
International
Tonkm and
VhclKm per
commodity group
RCM - Rail

Scenario
Reports\CBA

Report_2_Logistic
s Module

Description

Used by
application

Node and link costs per vehicle type
and product group, divided into
regional diff DTI

Samgods
Model

Tons per port area and commodity
group and comparison with statistics

Samgods
Model

Results on Öresund bridge, Kiel canal
and Jylland and comparison with
statistics

Samgods
Model

Number of loaded and empty trains per
day bidirectional and differences
between totals and capacities

Samgods
Model

Vehicle kms per county and vehicle
type and their distribution on all the
roads

Samgods
Model

Vehicle kms per county and vehicle
type and their distribution on E10
(category 11)

Samgods
Model

Vehicle kms per county and vehicle
type and their distribution on all the
roads except E10

Samgods
Model

Loaded and unloaded tons on rail
terminals per product group

Samgods
Model

Vehicle kms and tonne-kms for total
domestic and international by
commodity group

Samgods
Model

Summary table of no. of shipments,
no. of loaded vehicles, transport
distances, tonnes, tonne kms, average
load factors and average distance by
vehicle type by regional diff DTI

Cost Benefit
Analysis ASEK Values
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Folder

Name

Description

Used by
application

Report_2_LM_DE
MAND (CBA)

Summary table of no. of shipments,
costs, vehicle kms, tonnes, tonne kms
and average logistic costs per tonne
km, by transport chain type
Summary table of the tonnes
transported and the tonnes in the
PWC-matrices together with allocation
success rate

Report_5_Total
logistic cost at
zone-level

Total logistics costs per commodity
type (P01-P16) split by import and
export at geographical zone level

Cost Benefit
Analysis ASEK Values

Report_6_Goods
flow through
terminals (number
of tonnes in and
out per year)
Report_6_b_Good
s flow through
terminals (total
number of tonnes
per year without
land based
transfers)
Report_7_Domesti
c tonne kms with
container per
mode (road, rail,
sea, air) and
vehicle cl

No. of tonnes through terminals
(described as zones) per commodity
(P01-P16), split into from/to flows for
direct access and flow for other
terminals (without direct access)

Cost Benefit
Analysis ASEK Values

No. of tonnes through terminals
(described as zones) per commodity
(P01-P16), (without land based
transfers)

Cost Benefit
Analysis ASEK Values

Domestic tonne kms with container
transports per mode and vehicle type,
split by commodity.

Cost Benefit
Analysis ASEK Values

Report_2_LM_CH
AINS (CBA)

Cost Benefit
Analysis ASEK Values
Cost Benefit
Analysis ASEK Values

Total volume is also reported
Report_8_Domesti
c vehicle kms with
container per
mode (road, rail,
sea, air) and
vehicle cl
Report_10_Transp
ort work (tonne
kms) per mode
and vehicle cl, total
and split per
commodity,
domestic,
tdomestic and
international
Report_11_
Transported goods
volume per mode
vehicle cl, total and
split per
commodity,
domestic,
tdomestic and
international
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Domestic vehicle kms with container
transports per mode and vehicle type,
split by commodity Total volume is also
reported

Cost Benefit
Analysis ASEK Values

Transport work (tonne kms) per mode
and vehicle type and commodity.
Regional diff DTI

Cost Benefit
Analysis ASEK Values

Transported goods (in tonnes) per
mode and vehicle type and commodity,
as well as regional diff DTI

Cost Benefit
Analysis ASEK Values

Cube Interface components

Folder

Name
Report_12_node
and link costs per
vehicle and
product group
Report_19_Loade
d_Unloaded_Tons
_Rail
Report_20_Invento
ry and order cost
per commodity
group

Description

Used by
application

Loaded and unloaded tons on rail
terminals per product group

Cost Benefit
Analysis ASEK Values
Cost Benefit
Analysis ASEK Values

Order and inventory cost per product
group and total domestic/international
using ASEK values

Cost Benefit
Analysis ASEK Values

Node and link costs per vehicle type
and product group, divided in total
domestic and international
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Keys window
The model is based on Scenario Manager and Application Manager. Applications represent the
flow chart of the model containing calculation and specific programs, while the purpose of
Scenario Manager is to allow an application to be conveniently executed with a varying set of
inputs. This allows the user to compare the effects that different input values have on the results.
A set of input values is a scenario and the varying inputs to the applications are called “keys”.
Catalog keys define items that vary each time an application in a catalog is run. They may
represent a file, number, character string, or Boolean flag. For instance, using a key it is possible
to specify different values for parameters, different networks for LOS calculation and assignment,
different control parameters for the Logistics Module or more.
In general terms the keys may serve different purposes; in summary:


To manage input data



To give general settings for the model



To enable different ways to run the model

A key can for example be:


The name of an input data file



A directory



A check box with true or false value



A check list to choose a specific value



A constant



A radio button

Different kinds of keys appear in applications and other places where it is possible to select the
settings (for rules applied see section 7.1.1 and 7.1.3).
In Chapter 8, the available catalog keys for each specific application are listed. Catalog keys are
defined as keys for setting up parameters in the applications. The Keys window is available in
developer mode and it is also possible to display from Main toolbar -> Scenario -> View -> Show
Keys.
The following keys in the Cube interface are called system keys:


{CATALOG_DIR} is the directory where the .cat file is located



{SCENARIO_DIR} is the directory where the scenario folder is located



{SCENARIO_CODE}, {SCENARIO_SHORTNAME) are defined in the Scenario
Properties, see Figure 9



{SCENARIO_FULLNAME} =
{SCENARIO_SHORTNAME_PARENT}.{SCENARIO_SHORTNAME}, where
{SCENARIO_SHORTNAME_PARENT} is the base scenario to the current scenario

These keys are important components in each scenario. Please refer to the online Cube Voyager
help available from the menu bar for further information (see for instance Scenario Manager >
Working with applications and catalogs > Cube Voyager and TP+ scripts). “Scenario properties”
is accessed by right-clicking on the topical scenario in the Scenarios window and select
“Properties” (see ).
Each time a scenario is created all catalog keys should be given a value. Some of the keys have
a default value. If the default value is changed by the user, it will become specific for that
scenario. When a scenario is created as the child to another scenario, it will inherit all the catalog
key settings from the parent.
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In the Keys window information on the origin of the keys can be found. The keys for a specific
scenario and application can be viewed by selecting the scenario in the Scenarios window by
clicking on it, and selecting the application in the Applications window in the same way. The keys
marked in black in the Keys window are undefined. The keys are shown in bold font if they have
been explicitly defined by the user and in italics if they have been inherited from the parent
scenario. If the value is in grey font, it is a default value that has not been changed by the user,
neither for the current scenario, nor for its parent.
More information about the keys and the scenarios can be found in the Cube Help, accessed
from the main toolbar (Help -> Cube Help -> Cube Base -> Scenario Manager ->
Keys/Scenarios).

Figure 9 How to open the “Scenario Properties” window.

{SCENARIO_SHORTNAME}
{SCENARIO_CODE}

Figure 10 Set {SCENARIO_SHORTNAME} and {SCENARIO_CODE} in “Scenario Properties”.
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Application manager window
The Application manager window is accessed by double-clicking on an application in the
Applications window, and it provides a flow chart of a transportation modelling process, see
Figure 11. The view is in a hierarchical flow style that offers:


a view of the individual processes, the flow of data from one application to another, the
sequence in which the processes are run



a clear structure of what the input data and the output data are in each process



a convenient interface for running specific parts of the process or the whole model

STEP 1
STEP 2
STEP 3

Execution order

Figure 11 Application manager window.

Task Monitor program and the help function
The Task Monitor program starts automatically from the Application manager when the user runs
either a single program or an application. The main purpose of the Task Monitor is to report the
progress of the program/application execution, and to allow control of the run by pausing or
abandoning it. When a run finishes successfully, a message box will indicate that the run is
finished without any problem. If a failure occurred, a dialog box, showing the return code and
error information, will appear.
The return code from the process gives the information on how the run completed. The codes
are shown below.

Return codes:
Return code = 0 – the run completed successfully
Return code = 1 – along the process, a few warning messages were printed but the run was
completed successfully
Return code = 2 – the run ended with a fatal error
Return code = 3 – the process was aborted by the user
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There are facilities that allow showing:


The report for the whole run



The report for the step that failed, if the run ended with a fatal error

For more details on the Task Monitor, see reference guide RG_CubeBase.pdf under
Citilabs\Cube folder, Chapter 16.
When the user needs help about the Cube Interface, the help function can be consulted. It is
found on the Menu Bar; Help -> Cube Help.
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8 Description of the applications
This chapter introduces the different applications in the Samgods GUI, how they are used and
how the settings are made. The chapter is written as a catalog with detailed descriptions of the
applications and should be consulted for the specifications of the applications rather than for
instructions on how to use the entire Samgods model. For instructions on how to get started with
Samgods, how to create and use scenarios etc., we refer to Chapter 9. The chapter commences
with an explanation of the different Model User roles, followed by the description of the
applications in the Samgods model GUI.

Model User roles
In the Samgods model GUI, three Model User roles are available:


Standard user - should be used by the normal user when setting up scenarios and
running the model



Advanced user - should be used when it is requested to manage some general
parameters and values such as wait time for the prompt command or for running RCM
process



Developer - should in general be used when advanced system settings are made, for
instance when administrating the system by making installations and setting up the
system

As mentioned earlier, in order to set the Model User roles, to go Scenario menu on the toolbar
and select “Properties”. On the Catalog Properties window, select the “Model User” tab, where
the settings for the Model User roles are made, as described below:


Standard User – set the Model User to “Model Applier” and Current Applier group to
“Standard User”



Advanced User – set the Model User to “Model Applier” and Current Applier group to
“Advanced User”



Model Developer – set the Model User to “Model Applier” and Current Applier group to
“Model Developer”

More details for when the Model User roles are used are given in the catalog key tables. Most of
the catalog keys for the respective applications are described; however, not all keys are explicitly
explained.

General guidelines for which Model User role to use:
Standard user – should be used by the normal user when running different scenarios
Advanced user – should be used by an experienced user of the model that would control some
specific settings and parameters
Model developer – should be used when setting system keys, no restrictions are applied in this case

Installation application
The Installation application is only enabled in developer mode. A screenshot of the application is
displayed in Figure 12. The purpose of the Installation application is to set the general
information to properly run different programs involved in the model. In particular we have the
following programs:
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Logistics module (executable programs buildchain.exe and chainchoi.exe)



Rail Capacity Management module (executable programs LP2CC.exe, MPS.jar,
CLP64.exe)



Citilabs Cube Software



ArcGIS Esri Software



Python software



DOS command location

See the installation instructions in Section 6.5 for further details on how to access the keys and
set the right values.
The first group of catalog keys, called “Software versions”, is introduced to avoid inconsistency of
version problems over time. Different versions of the programs can be implemented (typically
when a software is updated to a newer version), and it is important to know which software
versions that were used for a particular scenario study to enable proper analysis and consistency
of the outcome. The keys are displayed in Table 3.
Table 3 “Software versions”.
Textfield name in template

Example of value

Cube Software

6.1.1

ArcGIS Software

10.2.2

Python software

27

Logistic Model software

1.1.4

The second group of catalog keys, “Installation parameters”, handles the possible problem of
having different installation folders on different PC’s by setting the path of the programs. Since
the path for the ArcGIS program is used by Python, the “\” signs must be replaced by “/” or “\\” in
this key, see Table 4 for an example. The first catalog key in the second group indicates the
harddisk in which the model is installed.
Table 4 “Installation parameters”.
Textfield name in template

Example of value

Hard Drive where the model resides

F:\

Location of Python Program

C:\Python27\ArcGIS10.2

Location of Java folder

C:\Windows\System32

Path to cmd.exe

C:\windows\sysnative\cmd.exe

The last key in the second group, see Table 5, defines the base scenario that is used in the
current model. The base scenario is used as a reference when storing the data for other
scenarios. Only the differences between the base scenario and other scenarios are stored in the
database. The value of this key is related to the Handling scenario application; please refer to
Section 8.7 for more information.
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Table 5 Base scenario definition.
Textfield name in template

Example of value

Scenario name for the BASE scenario

Base2017

Figure 12 The Installation application.

To open the overview of the application as illustrated in Figure 12, double-click on the
application. To access the catalog keys of a specific scenario, mark the application, and doubleclick on the specific scenario in the Scenario window. Please refer to Chapter 8.12 for further
instructions on how to use the Samgods GUI.

Create the editable files application
A view of the Create the editable files application can be seen in Figure 14. The purposes of this
application are to:


Create the essential files for visualizing or editing the input data from the graphical user
interfaces (Cube GIS window, DBI editor)



For a new scenario, allow to copy all the parent scenario data to the new scenario

The concept of this is that all the input data connected to a specific scenario is stored in the
database as the differences between the current scenario and the base scenario (i.e., the
reference scenario). The benefits of this are:
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A smaller amount of data is stored, that is, only the differences between the base
scenario and the alternative scenario(s)



It makes different alternative scenarios independent of each other, by letting the
alternative scenarios having only the base scenario as a reference. The only redundancy
of the system occurs when children are added to an alternative scenario since all
scenarios (including child and parent scenarios) are independent of each other and only
have the base scenario as a reference
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When changes are made to the base scenario, there is no need to change all the other
scenarios. This facilitates the handling of the overall scenarios. Furthermore the changes
and edits will be done only once, in the base scenario, avoiding risk of mistake when
updating the correlated scenarios

To create the editable files for a specific scenario and the scenario specific tables, two
applications work in conjunction:


the Create the editable files application, that merges the base scenario with the scenario
specific tables to view and edit a scenario, and



the Edit the data application, that stores the scenario-specific tables into the database
after any edits have been made

Figure 13 Database structure and scenario data of the Samgods GUI.

The main database is always present in the model, in the 05_Input_data folder (see Table 1 in
Section 6.5). The temporary database (Scenario_data.mdb) is created in the scenario folder in
each run of this application and is deleted on request by the user. The temporary database can
also be viewed in the GUI.
The catalog keys available in the Create the editable files application are shown in Table 6
below.

Table 6 Create the editable files catalog keys.

1

Textfield name in template

Example of value

Model User’s
rights

Which scenario do you want to copy as
new scenario?

Base2017

S/A user
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2

Location of Python program

C:\Python27\ArcGIS10.2

Developer

3

Scenario name for the BASE scenario

Base2017

Developer

4

Wait time for prompt messages during
execution (default 10 minutes = 600
seconds)

600

Developer
Advanced user

The first key is relevant during the creation of a new scenario. When the scenario already exists,
no action is needed. Keys number 2 and 3 are for installation purposes only. The last key
represents a model run setting, specifying the wait time for prompt message during execution.
For a normal user its value is set to 10 minutes, only for an expert user (advanced user right) it is
possible to change the definition to a small value (for instance 10 secs). A different setting is
required when several scenarios must be run since it is desiderable to minimize the interaction
with the user.
To create a new scenario, the application copies the scenario-specific tables from the scenario
(as indicated in the first catalog key in Table 6) and stores them in the temporary database. The
Edit the data application will then store them back to the main database.

Figure 14 The Create the editable files application.
When the application has been executed, the output (i.e., the editable files) can be found in the
folder Scenario Inputs\Editable data in the Data Section window. If the Create the editable files
application has been executed before and the user after that has not selected to delete the
temporary geodatabase, all the data will be available without the need to run the application
again. If the temporary database has been deleted, it may always be reconstructed by running
the Create the editable files application.
Please note: This application must be run at least once for each scenario, including
the base scenario. Otherwise, the necessary files for using the scenario will not be
created.
The Create the editable files application is the only application that is necessary to run for each
scenario - including the base scenario. For all other scenarios except the base scenario it is also
necessary to run the Edit the data application.

64

Description of the applications - Create the editable files application

Tip: The date and time of the last modification of the temporary and the main geodatabase are
checked by the application to avoid inconsistencies between the two datasets. If any
differences are found, the user is asked to choose whether the execution should be completed
(the temporary geodatabase will then be overwritten) or cancelled, so that the temporary
geodatabase could be saved to the main geodatabase by the user.

Please also note:


The location of the main database is under 05_Input_data folder (Table 1 in Section
6.5).



The location of the temporary database, Scenario_data.mdb, is under scenario
folder, which can be found in the Scenario_Tree folder (see Table 1 in Section 6.5). It
is available after each run. It can also be viewed from the GUI.

Edit the data application
The Edit the data application is used to store the scenario-specific tables into the database after
any edits have been made.
A view of the application is shown in Figure 15 The purposes of the application are to:


Enable editing of the scenario data by using the Scenario manager window or the Data
Section window. All georeferenced data is visualized using the GIS Cube window and
the other data is displayed in a database window. See the reference guide for Cube
Base (RG_CubeBase.pdf under Citilabs\Cube folder) for further information on these
tools



Store the modified data (the scenario-specific tables) to the main database after editing

The catalog keys are ordered in two groups. The first group is shown under Table 7 below.
Table 7 Scenario parameters and handling keys.

1

Textfield name in
template

Example of value and
explanation of values

Description

Model
User’s
rights

Do you want to
lock the scenario
from further
editing?

Yes

This key is introduced
due to data security
reasons, where the user
can choose to lock the
scenario from further
editing.

S/A user

Further explanation is
given below
2

Select from which
source you want to
import your edits

GIS Window (Use input files
constructed by the Cube GUI)

This key indicates if the
edits are saved in a

S/A user
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Voyager Network or in an
EMME Network.
If option “GIS window” is
selected, the next two
catalog keys (no. 3 and 4
below) do not need to be
specified
3

Emme network file

C:\Temp\EMME_NET_Emme2017.
211

The network data can be
edited by importing
Emme data (format:
.211). The file should be
specified here. It is
necessary that the
network file exists in the
specified folder,
otherwise the system will
prompt the user with a
message during the
execution

S/A user

4

Emme speed table

C:\EMME\NetworkBase2011\V101
_1_02_SPEEDS.DAT

See key no. 3, except for
the format, that is .DAT
for speed table file

S/A user

5

General
parameters [Table]

C:\Samgods\Scenario_Tree\Base2
017\Scenario_Data.mdb\General_B
ase2017

This is the scenario data
for the scenario,
generated by the system

Developer

6

Attribute name for
extra cost on
specific link (SEK)

EC_V

Please refer to Section
10.2 for further
explanation

S/A user

7

Attribute name for
extra cost on
specific link
(SEK/km)

EC_KM_V

Please refer to Section
10.2 for further
explanation

S/A user

8

Number of
operating days per
year for all modes
(except for Rail
Mode) (days/year)

250

This key represents a
value used to convert the
annual flows into daily
flows and is expected to
be changed rarely

Developer

9

Number of
operating days per
year for Rail Mode
(days/year)

250

This key represents a
value used to convert the
annual flows into daily
flows and is expected to
be changed rarely

Developer

10

Number of
zones/terminals in
network (see value
in scenario
network)

1377 (1379 in MainSc2040_Xore.)

Maximum number of
zones plus terminals in
the network

S/A user
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11

General
parameters for
Logistic Module
[Table]

C:\SamGods\Scenario_Tree\Base2
017\Scenario_Data.mdb\LogMod_
Base2017

This is the Logistic
Module data for the
scenario, generated by
the system

Developer

12

Interest rate used
in cost calculation
(%/year)

0.1

Interest rate used in cost
calculations (%/year)

S/A user

13

Stuffing cost (SEK
/tonne)

60

Stuffing cost (SEK/
tonne)

S/A user

14

Number of
transport chain
solutions for the
Logistics module

1: the optimal solution

See document under
reference 3. The output is
found in the Data Section
window, in Scenario
Inputs/Editable data/
General parameters
table, in the field DATA.
In the current
implementation the
optimal solution and up to
the fifth solution are
considered.

S/A user

2: the second best solution
…
5: the fifth best solution

For the current RCM
implementation, it is
strongly recommended to
leave the number of
alternatives set to 5.
15

Output variables
for the optimal
transport solution
[e.g.1,2,3, max is
8]

1: direct access
2: (un)loading costs
3: wait time costs
4: main utilization rate
5: number of vehicles
6: detailed information (total cost,
total distance, total times,
commodity, etc.) per f2f-solution
7: detailed information (transport
cost share, total distance, total
times, mode, etc.) per OD-leg. This
table is linked to table 6

See document under
reference 3. The output
files are found in the
scenario folder (see
Table 1), in
LogMod\ChainChoi\
OUTPUT and could be
consulted by the
advanced user. To
reduce the amount of
output files and produce
meaning full reports it has
been suggested to use
reports 6 and 7.

S/A user

This key concerns which
consolidation factor (for
all modes) that should be
used in BuildChain. See

S/A user

8: Statistics of the avail function
Max is 8
16

Initial consolidation
factor in
BuildChain (First
iteration - from 0 to
1)

0.75
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Section 13.3 for
reference.
17

Allow
consolidation for
all lorry types

Yes

This key will enable the
consolidation of all lorries
if the value is Yes. With
No unconsolidated lorry
transports will be enabled

S/A user

18

Evaluate transport
chains one leg at a
time

Yes

If Yes then each chain is
evaluated one leg at a
time, and the lowest cost
vehicle is chosen. This
can be done since the
OD-legs are independent.
The exception is OD-legs
for vehicles rolling on and
off a RoRo vessel, where
a recursive optimization
method is used for the
three OD-legs (roll on
vehicle – RoRo – rolloff
vehicle).

S/A user

19

Lower bound for
frequency
optimization
(Tonnes)

100

If (Annual Demand / Nr
Relations) <
MINIMUM_ANNUAL_TO
NNE_DEMAND_4_FREQ
_OPTIMIZE ChainChoi
will exit 20 step frequency
optimization loop after the
first iteration, where
frequency corresponds to
EOQ.

S/A user

20

Lower bound for
consolidation
factor (applied to
all commodities from 0 to 1)

0.05

Lower bound for the
consolidation factors
ranking output

S/A user

21

Upper bound for
consolidation
factor (applied to
all commodities
from 0 to 1)

0.95

Upper bound for the
consolidation factors
ranking output

S/A user

22

Calculation for
demand affecting
shipment size

DYNAMIC_AVERAGE

Parameter to control how
the demand shall be used
in the calculation of the
shipment sizes in
BuildChain. The following
values are allowed:

S/A user

DYNAMIC
DYNAMIC_MAX
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DYNAMIC_AVERAGE
DYNAMIC_GEOMEAN
23

Do you want to log
parameters from
control files?

Yes

If true the parameters
from control file are
logged in a log file (under
LOG folder).

S/A user

24

Do you want to log
reading of input
data?

Yes

If true the input data
phase is logged in a log
file (under LOG folder).

S/A user

25

Do you want to log
cost values from
vehicles files?

Yes

If true the cost values
read from LOS files are
logged in a log file (under
LOG folder).

S/A user

26

For which logistic
solutions do you
want to produce
output
data?(0=none,
1=Best solution,
2=Best + Second)

Number:

This key limits the output
files controlled by Key
#16 for a subset of
solutions (best one or
suboptimal)

S/A user

Do you want to
delete the
temporary
geodatabase?
(Tick=yes)

Tick =yes

This key gives the user
the possibility to save
hard disk space by
deleting the temporary
geodatabase
(Scenario_Data.mdb).
However, by keeping the
temporary files, there is
no need to run the Create
the editable files
application again (for the
current scenario)

S/A user

27

0 no output
1 only for best solution

The first key (lock the scenario or not) is introduced due to data security reasons. The user can
choose to lock the scenario from further editing. A new scenario is always editable, because it is
expected that the user will make some changes to the scenario tables. To lock a scenario means
that after the run, all the scenario data can be visualized in the interface, but if any edits are
made, these edits will not be saved in the main geodatabase. The base scenario is locked by
default and it should always be locked to enable comparison of the scenarios. In the database,
only the relative differences between the base scenario and the scenarios alternatives are
stored, this is why it is important not to change the base scenario when new scenario alternatives
have been introduced. A prompt window gives information on whether the scenario has been
locked or not during the execution of the following applications: Create the editable files, Edit the
data, Samgods Model.
The 10th key (Number of zones/terminals in network (see value in scenario network) must be
updated accordingly the number of zones in the EMME or Voyager network. The Emme network,
in conjunction with the speed table, could be provided as input network and converted by the
application. In this case the number of zones has specified as the record number in the Emme
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node table for nodes starting with *. In Voyager the number could be identified and modified in
the GIS window selecting the network in TOC and right clinking on that. For more details on the
EMME network please refer to paragraph 10.1.
The key (no.26) controls the number of report files specified by key 15, those reports can be
produced for the best solution, second or third etc. Its number specifies which set of results that
will be produced (only the best solution or the others as well, see the Logistic Module technical
documentation for further details).
The last key no. 27 gives the user the possibility to delete temporary files. By deleting the
temporary geodatabase, hard disk space could be saved. On the other hand, by keeping the
files, run time can be saved since the Create the editable files application does not have to be
run again for the specific scenario. The Create the editable files application needs about 5-10
minutes to merge all scenario specific tables with the base scenario.
To avoid inconsistencies between the temporary and the main geodatabase, it is recommended
to always control whether the two data sets have the same date and time of last modification,
before running the Samgods Model. If they differ, there could be edits in the temporary
geodatabase that have not been saved to the main geodatabase and those edits will not be
included in the execution of the model. In order to save edits in the main geodatabase, it is
necessary to run the Edit the data application. For the Create the editable files application, this
check is done by the application, in order not to overwrite any not saved edits in the temporary
geodatabase by mistake (see Section 8.3).
When “Next” is clicked in the Edit the data application in the Standard user Advanced user mode,
a second set of catalog keys is displayed, see Table 8. These keys give access from the
interface to all the input data for the specific scenario. The model Standard user / Advanced user
does not need to do anything to define the key values. The tables and geodata can be edited by
clicking on the “Edit…” button in Standard user Advanced user mode. All these files are also
accessible from the Data Section window, under Scenario Inputs\Editable data. In Section 7.3 a
brief explanation of all files in the Data Section window is given.
Table 8 Editable data.
Textfield
name in
template

Example of value

Model
User’s
rights

Name of file in
Data Section
window

ArcMap GIS
Project File

C:\Samgods\Scenario_Tree\Base2017\Input_
Data.mxd

S/A user

Input_Data.mxd

Commodity
data [Table]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb\Cargo_Base2017

S/A user

Cargo Table

General
parameters of
Vehicle
Classes
[Table]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb\Vehicles_Parameters_Base2
017_PartA

S/A user

General Vehicles
Parameters (by
vhcl class only)

Specific
parameters of
Vehicle
Classes by
commodity
group [Table]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb\Vehicles_Parameters_Base2
017_PartB

S/A user

Specific Vehicles
Parameters (by
vhcl class and
commodity group)
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Table with tax
by country
(SEK/km)
[Table]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb\Tax_Country_Base2017

S/A user

Tax by country
Table

Tax by
Category
(SEK) [Table]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb\Tax_Category_Base2017

S/A user

Tax by Link class

Tax by Link
(SEK) [Table]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb\Tax_Link_Base2017

S/A user

Tax by link

Toll for
bridges (SEK)
[Table]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb\Toll_Link_Base2017

S/A user

Toll bridges

Network
specific of
scenario
[Geodata]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb\Network

S/A user

Scenario Network

Port terminals
(pilot fees
values)
[Geodata]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb\Ports_Swe

S/A user

Ports Sweden

Zones and
terminals
attributes
[Geodata]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb\Nodes

S/A user

Nodes

Nodes
commodities
(interchanges
allow)
[Geodata]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb\Nodes_commodities

S/A user

Nodes
commodities

Frequency
data (#
transport
/week)
[Geodata]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb\Frequency_network

S/A user

Frequency
network

Table with
Rail Capacity
[Table]

C:\Samgods\Scenario_Tree\Base2017\Scen
ario_Data.mdb \Rail_Capacity_Base2017

S/A user

RailCapacity
Table

The last three catalog keys are only accessible in model developer mode with the exception for
Wait time (that could be also specified by the Advanced user). They define the base scenario,
the folder for the Python program and the wait time for prompt message during execution, see
Table 9.
Table 9 Developer and advanced user keys.
Textfield name in template

Example of value

Model User’s
rights
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Location of Python Program

C:\Python27\ArcGIS10.2

Developer

Scenario name for the BASE scenario

Base2017

Developer

Wait time for prompt messages during execution
(default 10 minutes = 600 seconds):

600

Developer
Advanced user

Figure 15 The Edit the data application
The output of the Edit the data application, a log report containing information on the execution of
the application, can be found in the folder Scenario Outputs\Edit the data Report in the Data
Section window. This file contains a list of numbered messages giving information on, e.g.,
whether any data is missing in the input data (e.g. a missing port in the ports_swe table). For a
list of messages, see Chapter 12.

Samgods Model application
A schematic picture of the Samgods Model application is outlined in Figure 16. The Samgods
Model application is the core of the system, since it has the purpose to:


run the Samgods model



make sure that all required input data exists (in the main geodatabase or created along
the process)



save all the outputs in the right places (depending on the request of the user)

The Samgods Model application provides three different processes integrated in a unique
application:
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The logistics module (in the document it could be referred to as Standard Logistics
Module or STD - steps 4,5,6,and 7): the transport solutions are produced considering all
the available chains and the results are summarized in vehicle, tonne and empty vehicle
matrices assigned to the transport network. The solution considered for each firm-to-firm
relationship is one and only one in the deterministic method. Applying the variable VARI
the stochastic approach will be invoked, in this case the probability of usage between
Stochastic approachbest choice and second/third/fourth and fifth choice will be

Description of the applications – Samgods Model application
estimated. The lambda parameter (VARI) can specified by commodity group and F2F
segment using a table in access database.


The Rail Capacity Management module (steps 8, 9 and 10): in an iterative process the
transport chains solutions using rail infrastructure are modified with the goal to
redistribute the flows and reduce the congestion on the rail network. In each iteration a
new alternative per each firm-to-firm using rail links may be added. It may be added if it
represents a new alternative since possibly existing alternatives are already in the list of
alternatives, to the capacity problem manager (called LP since it involves the definition of
a linear programming problem). The variables in the LP model are the usage split of the
available solutions per f2f-relation. The initial step is denoted LP0 and considers the best
solution from the logistic module and the second best choice. In principle new
alternatives are successively added in step LP1, LP2 etc. until the total LP model cost is
minimized, i. e. when the solution has converged according to defined stopping criteria,
or no new columns have been found. In the current setup the stopping criteria applied is
when the maximum number of iterations is met (catalog key Maximum number of loops
for Linear Programming process (LP) has this purpose). Should any rail links still be
overloaded after stopping, the best option to adress the issue is to run yet one LPiteration. In cases with severe overload / tight capacity it may be necessary to run RCM
with a higher cost for acquisition of extra capacity (parameters CAPCOST and
EXTRA_CAPCOST in the contol file MPS_LP.ctl to force usable alternatives to appear).



The calibration module (steps 1,2,11 and 12): details will be provided in the documents
listed in Section 14.4. It has been used to calibrate the current version. The standard and
advanced user are not allowed to access to the catalog keys that control this process.

The steps related to the Logistics Module are:


LOS calculation (step 4) – the step where the Level Of Service matrices are calculated.
There is one LOS matrix for each vehicle type providing transport time, transport
distance, infrastructure fees/charges and the domestic distance for zone-to-zone
relations. The LOS matrices are mandatory input to the Samgods model (We refer to the
Method Report, see Section 14 References)



Logistics module (step 5) – the step where the freight flows of the different commodities
are assigned to transport chains



Assignment (step 6) – the step where the freight flows are assigned to the infrastructure
network



Reports (step 7) – the step where all standard reports (also called summary reports)
from the Samgods Model application are produced

The steps related to the RCM module are:


Rail Capacity Management (step 8): using the results from standard logistics module
sets up the LP and provides a new revised set of vehicle and tonne OD matrices.



Assignment RCM (step 9) – the step where the freight flows are assigned to the
infrastructure network. The empty rail assignment considers the congestion on rail links
by applying a vehicle-delay function that depends on bidirectional link flows, the other
modes maintain the standard all-of-nothing assignment.



Reports RCM (step 10) – the step where all standard reports (also called summary
reports) from the Samgods Model application are produced with results for RCM

We refer to the reference material listed in Section 14, for further information of the Samgods
model.
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Figure 16 The Samgods Model application.
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8.5.1

Standard Logistic Module

The first four steps of the application represent the “standard” module where the capacity and
congestion on rail links are not considered. This “standard logistic” module has different choice
dimensions, depending on the results that the user wants to simulate (as showed in Figure 17).

Figure 17 Different ways to run the Samgods Model application for the standard part.
All the possible dimension are:


The model could be run as an uninterrupted process or step-by-step (illustrated in the
figure by the blue arrows to the right)



It is possible to run all the commodities at once or one commodity at the time (illustrated
by the yellow arrow at the top of the figure)



For the steps LOS Calculation and Assignment is it possible to run all the modes or only
a specific mode (illustrated by the green boxes to the left in the figure)



It is possible to select which specific outputs to save from running the Samgods model

Not all combinations of these choices are allowed. Details are given in the following paragraph.
During the run, the user will be informed with a prompt window whether the selections made are
coherent with each other.
The option to run the model for one mode at a time is allowed only for the steps highlighted in
green, i.e. LOS Calculation and Assignment. This is due to the fact that the Logistics module
needs LOS matrices for all modes. A reason for running only a specific mode could be that the
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differences in the input data are related only to one mode. For instance, if no other changes have
been made in the input data, there is no need to rerun the whole scenario in the LOS Calculation
step. Regarding the Assignment step, the user may be interested in examining the assignment of
the freight to the network for only one mode.
The fourth step, Reports, produces summary reports from running the Samgods model
application. Since this step summarizes the three previous steps, a full run of all four modes
needs to be done to obtain complete reports.
It is allowed to run all steps related the standard logistic module in the Samgods model
application for only one specific commodity group (as illustrated by the blue arrows). With the
new setting of empty add-on factors for empty rail flows, these will be correct at any level of
disaggregation. For other vehicle types the empty flow distributions are not separable, i. e. the
sum of individual commodity based empty flow generations will not sum to the empty flow
generation from the combined set of commodities.
If changes in the input data are detected after the LOS matrices have been created, the program
will prompt the user with a message in the report file in the folder Scenario Outputs\Samgods
report\Existing Outputs in the Data section window. During the execution, the user is provided
with the option to cancel the run (by ticking the answer “Do you want to check data and skip the
process?”). See Chapter 12 for further information on the log reports.
The last step of the application represent the “Rail Capacity Management” module where
capacity and congestion on rail links are taken into account. This module has several sub-steps:


Rail Capacity Management – the step where the freight flows of the different
commodities are assigned to transport chains considering link congestion on rail



RCM Assignment – the step where the freight flows are assigned to the infrastructure
network considering link congestion on rail



Results RCM – the step where all reports for the Rail Capacity Management module are
produced

For the “rail capacity management” it is not possible to select which commodity and mode to run,
but it is mandatory run all the commodities and all the modes. In fact, the rail capacity
management module considers the congestion on the rail links, and to do this properly you have
to consider all the commodities and modes simultaneously. Like Standard Logmod, you can
select which step to run:


Rail Capacity Management (all below steps togethar)



RCM: only LP steps



Assignment RCM: assign final matrices



Reports RCM: produce RCM reports
For the Samgods Model application there are several groups of catalog keys.
The first group is “Scenario parameters” and it contains only one key that specifies the number of
zones\terminals in the network.
Table 10 “Scenario parameters” key.
Textfield name in
template
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Example of value

Description

Model
User’s
rights
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1

Number of
zones/terminals in
network (see value in
scenario network)

1377 (1379 in
MainSc2040_Xore)

Number of zones
plus terminals in the
network

S/A user

The next group of catalog keys is only available in developer mode and it contains installation
parameters.
Table 11 “Installation Parameters” keys
Textfield name in
template

Example of value

Description

Model
User’s
rights

1

Location of python
program

C:\Python27\ArcGIS10.2

It specifies the
installation directory for
Python program

Developer

2

Location of Java
folder

C:\Windows\System32

It specifies the
installation directory for
Java

Developer

3

Path to cmd.exe

C:\windows\sysnative\c
md.exe

Location of cmd.exe
program

Developer

4

Scenario name for
the BASE scenario

Base2017

It specifies the name of
the base scenario

Developer

5

Hard Drive where the
model resides

C:

Hard drive on which
the model resides

Developer

The next group of catalog keys, “Run Selections”, refers to the execution order specifying which
steps to run (see Table 12).
Table 12 “Run Selections” keys.
Textfield name in
template

Example of value

Description

Model
User’s
rights

1

Run only one step, or
run all steps

All steps

It specifies which step
that is to be run for
Standard Logistic
Module; it is possible
to specify only one
application or all the
steps

S/A user

2

Choose PWC
matrices

2016

It specifies the year for
the PWC demand
matrices

S/A user

3

Select the mode for
the LOS Calculation
and the Assignment
steps

All

It specifies which mode
that is to be run; it is
possible to specify only
one or all the modes

S/A user
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NOTE: if you run RCM,
you need to consider
all the modes
4

Select commodities
for the Logistics
Module (for all
commodities, select
0)

0

It specifies which type
of commodity that is to
be run; it is possible to
specify only one
commodity type (value
from 1 to 16 or all the
commodities (value 0)

S/A user

NOTE: if you run RCM,
you need to consider
all the commodities
Possible input values for the first key listed in Table 12 are:


STD LOS calculation: it indicates to run only “LOS calculation” step (#4)



STD Logistics module: it indicates to run only “Logistics Module” step (#5)



STD Assignment: it indicates to run only “Assignment” step (#6)



STD Reports: it indicates to run only “Results” step (#7)



STD All steps: it indicates to run all the “Standard LogMod” steps (LOS calculation +
Logistic module + Assignment + Reports) (#4+5+6+7)



RCM Rail Capacity Management Module: it indicates to run “Rail Capacity
Management” step (#8)



RCM Assignment: it indicates to run “RCM Assignment” step (#9)



RCM Results: it indicates to run “Results RCM” step (#10)



RCM All steps: it indicates to run all the “Rail Capacity Management” steps (RCM +
RCM Assignment + Results RCM) (#8+9+10)



All steps: it indicates to run all the steps


Note that, when running Standard Logistic Module, the input for Rail Capacity Management
procedure is created in the scenario folder. Therefore the Rail Capacity Management procedure
must be run after a full run of Standard Logistic Module.
Output is produced from all steps in the Samgods model application. Together with the Microsoft
Office tools (such as Access and Excel) this output can be analyzed in-depth in various ways.
The purpose of the standard reports produced in the Report step is to give the user a quick
overview of the results from running the Samgods model application.
Possible input values for the second key (Year of PWC matrices) in Table 12 are:


2016: PWC matrices for year 2016



2040: PWC matrices for year 2040



Any other value inserted by the user. Follow the general rule to create a folder under
01_Programs\LogMod\Input\PWC\, for instance “2040IRONORE”, and give the
same name to the catalog key

Possible input values for the third key listed in Table 12 are:
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All



Road
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Rail



Sea



Air

The last key has a more general function. It is used in all the applications where the output data
is filtered by commodity. It is the most important catalog key of these three keys. If the Samgods
model first is run for commodity type 1 (for instance), then for all the commodity types (key set to
zero), then both the results for commodity type 1 and for all the commodities will be saved. In the
scenario folder (under Scenario_Tree, see Table 1), the name of the specific output database is
OutputX_{SCENARIO_SHORTNAME}.mdb, where X is the commodity group. Switching from
one set of output to another in the interface is easily made by changing the value of this catalog
key and click “Save”. The possible values for this key are the numbers representing different
commodities or zero, representing all commodities. The possible commodities are the commodity
types (1-16). See the Appendix or for instance the Program Documentation (see References) for
more information.
The report “Existing Outputs” (in the folder Scenario Outputs\Samgods Report in the Data
Section window) is updated during each run and it gives information on the output and the
commodity class.
The next set of catalog keys, “Other options”, refers to the optional outputs which can be saved
in the scenario folder, see Table 13.
Table 13 “Other options” keys.
Textfield name in
template

Example of value

Description

Model
User’s
rights

Do you want to
produce
buildchainxx.log files?

None

It indicates if you want
to generate a log file
containing any warning
that can occur during
the execution of the
Buildchain program

S/A user

The user selects whether the Buildchain program will produce log files or not. The log files (*.log)
contain any warnings that can occur during the execution. Please refer to the Program
documentation for the logistics model (see References) for more information.
The next group of keys allows the user to set the advanced options for the logistics module
(heading “Logistics module settings – advanced”) and is made up by seven catalog keys, see
Table 14 below.
Table 14 “Logistics module settings – advanced” keys.

1

Textfield name in
template

Example of value

Description

Model
User’s
rights

Stochastic approach:
parameter for logit
distribution (0=no
stochastic approach
used or actual value

{CATALOG_DIR}\05_In
put_Data\Input_Data.md
b\CSTVARI

Table with lambda
parameters by
commodity group and
f2f cells.

Developer
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i.e. 0.1) by
commodity and f2f
type
2

Commodities with
zero demand:

0

In Samgods 1.2 a full
new set of PWC
matrices is provided.
No empty commodities
exist under current
dataset. The catalog
key, which lists the
empty commodities, is
retained to keep the
functionality in place.

S/A user

3

Total number of
commodities
(excluding empty
commodities):

16

Total number of
product groups in the
setup (16 in Samgods
1.2). N_Flows is
always 16 – number of
product groups listed in
catalog key 1

S/A User

4

Do you want to run
the Logistics module
on several
processors?

Yes

It indicates if you want
to run the model on
several processors

S/A user

5

How many
processors would you
like to run
simultaneously?

4

It specifies the number
of processes to run
simultaneously for all
programs except
LP2CC

S/A user

6

How many
processors would you
like to run
simultaneously for
LP2CC?

4

Specific limit for
LP2CC since
extremely RAM
demanding. Each
processor should, in
average, have at least
2 GB of RAM
available.

S/A user

7

Scaling factor for
outputs

Thousands

It specifies the scaling
factor for outputs –
fixed at Thousands

Developer

8

Do you want to
produce rescaled
LOS and MC
matrices per
commodity group?

No

Produces extra outputs
with LOS and Marginal
Cost matrices rescaled
with scaling
parameters used for
calibration

S/A user

If the computer has more than one CPU available, it is possible to split up the processes
between the CPUs to speed up the run time of the model, using the catalog keys above. The
seventh key enables the user to define the scale of the output that will be presented in the
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reports. If the value is thousands, the output value (for instance 2.000.000 vehicle kilometers) will
be presented as the value divided by thousand (i.e., 2.000 vehicle kkilometers in the example).

8.5.2

Rail Capacity Management

Next group of catalog keys, specifies several parameters for Rail Capacity Management (see
Table 15). For a complete comprehension, we refer to documentation listed in reference 1 and
reference 4.
Table 15 “RCM Parameters” keys.
Textfield name in
template

Example of value

Description

Model
User’s
rights

1

Cut off criteria for
RCM process (will
consider links with
Number of vehicles
over Capacity > XX%
where XX is the value
defined)

50

It specifies a
percentage value for
exclusion of link flows.
According to
experience, railway
links with flow to
capacity rates (V/C) at
this or lower levels will
not have any impact on
the solution

Advanced
user

2

Maximum number of
iterations in Rail
assignment

1

It specifies the
maximum number of
iteration in the empty
train rail assignment
(considering link
congestion)

Advanced
user

3

Delay function for
Empty assignment
(Derivate)

2*10000*(MAX (0,
VOLC[LI.ID_LINK]-C))

It specifies the delay
function used for the
assignment of empty
vehicles

Advanced
user

4

Options to save
output files from RMC
process

Yes, for all iterations

It indicates you want to
save output file from
Rail Capacity
Management process
for all the iterations (for
instance LP0, LP1,
LP2 etc.) or only in the
last iteration.

S/A user

5

Maximum number of
loops for Linear
Programming
process (LP)

1

It specifies the
maximum number of
loops for the linear
programming process
(LP). The 0 value
means that only LP0
will be perform. A
different number
between 1 and 9 will

S/A user
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iterate the process until
that number (or earlier
if convergence will be
reach).
6

File with list of locked
solutions for RCM:

LockedSTDLogMod_em
pty.txt

Free format file placed
under
C:\Samgods\01_Progr
ams\Logmod\RCM
with list of transport
chains that must be
excluded in setting up
the LP problem. The
solution evaluated in
Standard Logistics
Module will be applied.

Advanced
user

7

Shipment size cutoff
(tonnes)

5

Cutoff for shipment
size in kg. For
transports with
shipment sizes below
this level, alternative
transport solution is not
generated after
iteration 0

S/A user

8

Marginal cost limit in
MPS.jar (SEK)

998801

Limit of marginal cost
to include extra
capacity

S/A user

9

Acquisition of extra
capacity (SEK)

1000000000

Cost to buy extra
capacity. If set to 0,
consistent with 1.1
implementation

S/A user

10

Link number to use in
debug mode
CheckLinkN_itXX.dat
Max 10 links (Comma
s, ex. 1,25,182,164)

51,82,84,234,272,274

Providing the ID_Link
list an extra report will
be produced under
RCM folder.

Advanced
user

11

List of rail modes in
RCM:

GHhIiTUDdEFf

Switch between 35 to
40 vehicle types. List
of associated modes of
rail (see Logistic
module
documentation)

Developer

Current setup allows
only the full set of
vehicle types.
(The user may alter the
use of rail modes by
either forbidding
modes in the network
or by raise costs until
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modes are not
chosen.)
12

List of vehicle types
on Rail mode:

201,202,203,204,205,20
6,207,208,209,210,211,
212

List of vehicle types in
rail mode (12 or 9).
Current setup allows
only 12 vehicle types

Developer

(The user may alter the
use of vehicle types by
either forbidding
modes in the network
or by raise costs until
modes are not
chosen.)
13

List of chains for
different numbers of
vehicle classes:

Chain_List_40

List of available chains

Advanced
user

(The user may select a
different list of
accepted chains)

The first key in the table above will filter the transport chain solutions for rail links where the ratio
between total vehicle flows and capacity is greater or equals the value specified in the catalog
key. Since the linear programming problem could be huge (millions of records), this limit could
cut down the dimension of the problem. It is recommended to keep the default value.
The second key specifies the maximum number of iteration for the rail assignment with capacity
constraints.
The third key specify the delay function used for the assignment of empty vehicles; possible
choices are:


2*10000*(MAX(0,VOLC[LI.ID_LINK]-C))



4*10000*(MAX(0,VOLC[LI.ID_LINK]-C)^3)

The fourth key indicates if you want to save output files from RCM process and possible choices
are:


Yes, for all iteration



No, This option will save results only for the final iteration and the previous one

The options for key five are:
Run only LP0
o

Maximum number of loops for Linear Programming process (LP) = 0

Run only LP1
o

Maximum number of loops for Linear Programming process (LP) = 1

Run only LP2
o

Maximum number of loops for Linear Programming process (LP) = 2

The Samgods model could be run in several different ways. The current setup allows the
following choices (using "Run only one step, or run all steps" catalog key and catalog keys 1 and
4 in Table 12:


All: an interrupted run from LOS to reports for RCM. The number of LP and Adjust
LP will be specified by catalog keys 5 and 6



Logistics Module or Assignment or Reports: a single step for standard log mod
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Standard LogMod: all the steps related to Standard Logistic module (LOS +Logistic
Module +Assignment +Reports)



RCM or RCM Assignment or Reports RCM: a single step for Rail Capacity
Management



Rail Capacity Management: all RCM steps running the number of LP loops specified
via key 5

For instance, in a previous step LP1 has been run, and it is required to run LP2, it will be
sufficient set the model in the following manner:


Run only one step, or run all steps=Rail Capacity Management



Maximum number of loops for Linear Programming process (LP) =2

The last catalog keys allow different setup regarding the available vehicle classes, their minimun
shipment size, costs associated to buy extra capacity and chain types. Samgods 1.2 provides 40
vehicle classes, in which there are 5 new vehicle classes and a removed one:


Vehicle classes 106 (heavy trucks), 210, 211, 212 (longer trains), 322 (inland
waterway) are forbidden to be used in the network in the standard setup. To activate
them it is sufficient to open in the input network the set of links that should use the
specific vehicle class. Also make sure the vehicles are included in the chain list.



Vehicle class 209 is not used anymore in the model. All the input data and settings
for it could be used to describe a new vehicle type


8.5.3

Calibration

Next group of catalog keys specifies parameters and table for calibration and they are available
for developer users only (see Table 16). The calibration procedure should be not used at all by
standard user. The following keys should be not changed, except catalog key 7.
Table 16 “Parameters and tables for calibration” key.
Textfield name in
template

Example of value

Description

Model
User’s
rights

1

Initial values for port
calibration by Port
Area and commodity
group

C:\Samgods\05_Input_D
ata\Calibration\
PortAreaParams_16_Co
mm.txt

It specifies a text file
containing the initial
values of factors for
port areas; these
values are specific by
port area and
commodity group.
These scaling factors
are applied to time for
sea vessels 301 – 322.

Developer

2

Starting value for
scaling factor on Kiel
canal

1.8

It specifies the initial
values of factor for Kiel
canal. This scaling
factor is applied to the
canal toll

Developer
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3

Maximum number of
loops in calibration
process

1

It specifies the
maximum number of
loops to run in the
process

Developer

4

Parameters for port
calibration procedure
(step length,
minimum value,
threshold, default)

C:\Samgods\
05_Input_Data\Calibrati
on\Parameters_portcalib
ration.dbf

Step length, minimum
value, cat off value and
default minimum value
for calibration
procedure on port
areas

Developer

5

Parameters for Kiel
calibration procedure
(step length,
minimum value,
threshold, default)

C:\Samgods\
05_Input_Data\Calibrati
on\
Parameters_Kielcalibrati
on.dbf

Step length, minimum
value, cat off value and
default minimum value
for calibration
procedure on Kiel
canal

Developer

6

Restart process from
loop

1

The calibration
procedure could be run
for a fix number of
loops. If the run
crashes at a specific
loop or it is required to
run an extra loop, this
catalog key sets the
loop number to restart
with.

Developer

7

Consolidation factors
table

C:\Samgods\05_Input_D
ata\Input_Data.mdb\Buil
dChain_CONSOL

Individual consolidation
bounds for all sub
modes [LB, HB]
Default values and
specific values by
commodity group.

Developer
Advanced
user

The calibration procedure uses a set of initial values specified via catalog keys 1 and 2 and
progressively changes those values comparing the results with statistics. It applies a revision to
the values using a step length search specified in catalog keys 4 and 5. For further details on this
please refer to reference 4.
Catalog keys 3 and 6 are used to manage and control the calibration process. The first sets the
maximum number of loops for the process, the second allows to run extra loops after a
completed run.
The catalog key 7 allows specification of a different consolidation factors table and could be used
in setting up sensitivity tests for the lower and upper bounds for each submode.
The last catalog key is only accessible in model developer or advanced user mode and it defines
the wait time for prompt message during simulation running (see Table 17).
Table 17 Settings key.
Textfield name in template

Example of
value

Model User’s
rights
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Wait time for prompt messages during execution (default
10 minutes = 600 seconds)

600

Developer
Advanced user

For a standard user the model will prompt window messages along the run and wait for the
reaction from the user for 10 minutes. After that time it will apply the first choice available in each
message and the run will continue to the next prompt window. The advanced user could decide
to reduce the wait time to a small value, for instance 2 sec, just changing the value for this
catalog key. This choice, in other words, is suitable when several scenarios must be run in a
sequence, since it will not require any action from the operator.
8.5.4

Outputs

Based on the selections made by the user, different outputs are created – one set of outputs for
each specific setting of the catalog key “Select commodities for the Logistics Module (…)” for
Standard LogMod. The output files and their locations are listed in the file Scenario
Outputs\Samgods Report\Existing Outputs in the Data Section window.
Regarding empty vehicle calculations, the reader is referred to the appendix section 15.2 for
further details.
The available outputs from the respective steps in the Samgods model application that can be
accessed from the interface are:
LOS Calculation step


LOS matrices by mode showing distance, time, extra cost, domestic distance and
generalized cost summarized link-by-link along the minimum cost path (if the LOS
Calculation step or the whole run was selected)

Logistics module step


The loaded vehicle matrices (number of vehicles) by vehicle type (if the Logistics
module step or the whole run was selected)



Tonnes flow matrices – tonnes of freight by vehicle type (if the Logistics module step
or the whole run was selected)



The empty vehicle matrices (number of empty vehicles) by vehicle type (if the
Logistics module step or the whole run was selected and the attribute “EMPTY_V” in
the Vehicles Parameters table was set to 1 for the specific vehicle type, see Section
10.4).



OD covered – various output reports per vehicle type, chain type, zone, and
commodity – all the output used to create summary reports no. 5-8,6b, 10,11,12 and
19 (see Table 2)

Assignment step


All freight flows in tonnes, number of loaded vehicles and number of empty vehicles
assigned to the network by vehicle type (if the Assignment step or the whole run was
selected).

Report step
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The freight flows in tones, number of loaded and empty vehicles assigned to the network
with all modes in the same network (if the Report step or the whole run was selected).



Summary report no. 1. Summary table of number of vehicle kilometres per vehicle type
(domestic and in total) and per mode in the assigned network (if the Report step or the
whole run was selected).
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Summary report no. 3. Summary table of number of tonne kilometres per vehicle type
(domestic and in total) and per mode in the assigned network (if the Report step or the
whole run was selected).

Summary report no. 4. Summary table of tonne kms per vehicle type (domestic, international and
total) and per mode (if the Report step or the whole run was selected)


Summary report no. 9. Summary table of vehicle kms, tonne kms, empty vehicle kms,
and total vehicle kms per geographic region and mode (road and rail only) (if the Report
step or the whole run was selected).



Summary report no. 13. Summary table of tons per port area and commodity group and
comparison with statistics (if the Report step or the whole run was selected)



Summary report no. 14. Summary table of results on Oresund bridge, Kiel Canal and
Jylland and comparison with statistics (if the Report step or the whole run was selected)



Network with bidirectional tonnes per rail vehicle type



Summary report no. 16. Summary table of vehicle kms per county and vehicle type and
their distribution on all the roads (if the Report step or the whole run was selected)



Summary report no. 17. Summary table of vehicle kms per county and vehicle type and
their distribution on E10 (category 11) (if the Report step or the whole run was selected)



Summary report no. 18. Summary table of vehicle kms per county and vehicle type and
their distribution on all the roads except E10 (if the Report step or the whole run was
selected)

RCM Logistic Module step (if the Rail Capacity Management step, RCM step or the whole run
was selected)


The loaded vehicle matrices (number of vehicles) by mode and vehicle class



Tonnes flow matrices – tonnes of freight by mode and vehicle type



The empty vehicle matrices (number of empty vehicles) by mode and vehicle type



OD covered – various output reports per vehicle type, chain type, zone, and
commodity – all the output used to create summary reports no. 2, 5-8, 6b,10,11,12
and 19 (see Table 2)

RCM Assignment step (if the Rail Capacity Management step, Assignment RCM step or the
whole run was selected)


All freight flows in tones, number of loaded vehicles and number of empty vehicles
assigned to the network by mode

RCM Report step (if the Rail Capacity Management step, Report RCM step or the whole run was
selected)


The freight flows in tones, number of loaded and empty vehicles assigned to the network
with all modes in the same network



Summary report no. 1. Summary table of number of vehicle kilometres per vehicle class
(domestic and in total) and per mode in the assigned network. See appendix section
15.2 for details



Summary report no. 3. Summary table of number of tonne kilometres per vehicle type
(domestic and in total) and per mode in the assigned network (if the Report step or the
whole run was selected).

Summary report no. 4. Summary table of tonne kms per vehicle type (domestic, international and
total) and per mode
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Summary report no. 9. Summary table of vehicle kms, tonne kms, empty vehicle kms,
and total vehicle kms per geographic region and mode (road and rail only) See appendix
section 15.2 for details



Summary report no. 13. Summary table of tonnes per port area and commodity group
and comparison with statistics



Summary report no. 14. Summary table of results on Öresund bridge, Kiel canal and
Jylland and comparison with statistics



Summary report no. 15. Summary table of bidirectional number of trains and tonnes per
day



Summary report no. 15b. Summary table of bidirectional number of trains and tonnes per
day indicating capacity and train flows above the capacity level



Network with bidirectional tons per mode



Summary report no. 16. Summary table of vehicle kms per county and vehicle type and
their distribution on all the roads



Summary report no. 17. Summary table of vehicle kms per county and vehicle type and
their distribution on E10 (category 11)



Summary report no. 18. Summary table of vehicle kms per county and vehicle type and
their distribution on all the roads except E10



Comparison Ml Tons RCM vs Standard per mode: GIS network with differences between
RCM and standard results in million of tonnes per each mode



Report Tons per commodity groups and total (Ktons): GIS network with Ktons per
commodity group and totals. For its visualization under Report\GIS maps is present a
standard map



Report Tons per commodity groups and total (Ktons): GIS network with Ktons per
commodity group and totals. For its visualization under Report\GIS maps is present a
standard map (GIS map with Ktons by Commodity group)



Report Loaded and empty vehicles per commodity groups and total (Vhcl): GIS network
with Loaded Vhcl per commodity group and totals, plus emtpy totals. For its visualization
under Report\GIS maps is present a standard map (GIS map with vhcl by Commodity
group)

Compare scenarios application
A view of the application can be seen in Figure 18. The purpose of this application is to compare
model outputs between different scenarios. Each scenario can be compared with any other
scenario present under the Scenario_Tree structure. There are four catalog keys (five for a
model developer) to handle this application, see Table 18.
Table 18 Compare Scenarios application catalog keys.

1
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Textfield name in
template

Example of value

Description

Model
User’s
rights

Location of Python
program

C:\Python27\ArcGIS10.2

It specifies the
installation directory for
Python program

Developer

Description of the applications - Compare scenarios application
2

Select commodities
for the Logistics
Module (for all
commodities, select
0)

0

It specifies which
commodity type result
must be compared; it is
possible specify only
one commodity type
(value from 1 to 16), or
all the commodities
(value 0)

S/A user

3

What do you want to
compare?

LOS Matrices

It specifies which set of
result to compare; it is
possible to specify a
single step or all the
steps

S/A user

4

Scenario's name to
use in comparison
(ex. Test17)

Base2017

It specifies the name of
the scenario to
compare with the
current scenario

S/A user

5

Scenario folder for
comparison (ex.
C:\Samgods\Scenario
_tree\Year_2017\Test
17\)

C:\Samgods\Scenario_T
ree\Base2017\

It specifies the
directory of the
scenario to compare
with. It is required the
full path (C:\....), not
the relative path
(Scenario folder)

S/A user

The user needs:


to select the scenario name that he/she wants to compare with the current scenario
using the forth catalog key;



to identify the folder location for the scenario used for comparison (e.g. folder where the
outputs for scenario selected with previous catalog key are places., usually under
Scenario_Tree folder plus short scenario name) and to update accordingly the fifth
catalog key value;



to select which commodity type results to compare (select the commodity number or 0
for all in the second catalog key) between different scenarios. It is the user’s
responsibility to verify that the same outputs exist for both scenarios. This could be done
by looking in the Existing Outputs file for the respective scenario, found in the folder
Scenario Outputs\Samgods Report in the Data section window. If the requested files do
not exist for any of the scenarios, the process will be terminated with return code 2 from
the Task Monitor program, see Section 7.6.



With the third catalog key the user has the option to compare only a specific set of output
(among the ones listed below) or all of the results

Three sets of output will be produced by this application:


The LOS matrix comparison: the difference values with sign between the base scenario
and the selected scenario for each matrix by mode



Logistics Module output comparison: The OD matrices with number of vehicles (totals
and empties) and the tonnes are analyzed as well as the margins of the matrices for the
vehicle OD matrices (TRIPEND) (the margin is the sum of each row and column
respectively, i.e., the totals of attraction and generation): the absolute differences
between the base scenario and the selected scenario.
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Figure 18 Compare Scenarios application.


The Assignment comparison: the differences between the assigned network for the base
scenario and the selected scenario in absolute values



Under Compare\GIS Maps exists the standard GIS map with differences (Ktons) on
totals and by commodity group

Handling scenario application
Figure 19 shows an outline of the Handling Scenario application. As described earlier, the
scenario data is stored in the main geodatabase as a group of scenario specific table\s, so
managing this group of files requires dedicated tools to avoid creating any inconsistencies in the
input data between scenarios. This application allows the user to delete all no longer required
data, to easily import or export scenarios from or to other catalogs, to set up a new structure with
a new base scenario, etc.
This application has different subgroups with specific purposes, all of them related to handling
the scenario data. The structure can be seen in the applications tree in the Applications window.

Figure 19 Handling scenario application.
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Each subgroup corresponds to a specific operation:


Delete: delete the scenario-specific tables completely in the main geodatabase



Compact: compress the geodatabase files to save disk space (see Section 9.9 for
further information)



Scenario Export: This subgroup has two main purposes:
1. One is to enable the setup of a new catalog, using the current scenario (i.e., the
scenario that the application is executed for) as the base scenario in the new
catalog. One case where it may be appropriate to create a new catalog with a
new base scenario is if one of the scenarios in a catalog is being used as the
base scenario in a new project. Another reason could be that the database
becomes too large (with too many alternative scenarios, for instance), since it
has a physical limit for its size. Then it may be appropriate to create a new
catalog with a base scenario that is a copy of the original, where more
alternative scenarios (belonging to the same overall project) may be stored
2. Another one is to enable to export the scenario-specific tables for a specific
scenario into another, already existing catalog with a different base scenario.
The exported scenario can never become the base scenario in the destination
catalog – if the user wants this, then alternative 1. above must be used. This
function is useful e.g. when the user wants to set up a scenario in a new catalog
with a certain base scenario, and already has a similar scenario in another
catalog with another base scenario. Then the old scenario can be exported to
the new catalog and the user only has to change some of the input data, instead
of starting all over again



Scenario Import: When the scenario-specific tables have been exported to another
catalog using the previous subgroup (Scenario Export), the Scenario Import tool is used
to control whether the scenario parameters in the new catalog have the same values as
those in the imported scenario.

As showed in the Table 19, the first two groups of catalog keys specify scenario parameters and
parameters for the logistics module. These keys are used only by the Scenario Import subgroup;
no editing is required for these keys otherwise.
Table 19 Catalog keys for the Import subgroup.
Textfield name in template

Example of value

Model
User’s
rights

1

Attribute name for extra cost on specific link
(SEK)

EC_V

S/A user

2

Attribute name for extra cost on specific link
(SEK/km)

EC_KM_V

S/A user

3

Number of operating days per year for all
modes (except for Rail Mode) (days/year)

250

A user

4

Number of operating days per year for Rail
Mode (days/year)

250

A user
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5

General parameters for Logistics Module
[Table]

C:\SamGods\Scenario_Tree\B
ase2017\Scenario_Data.mdb\L
ogMod_Base2017

A user/
Developer

6

Interest rate used in cost calculations
(%/year)

0.1

S/A user

7

Stuffing cost (SEK/tonne)

18

S/A user

8

Number of transport chain solutions for the
Logistics Module

2

S/A user

9

Output variables for the optimal transport
solution [e.g.1,2,3, max is 8]

6,7

S/A user

10

Initial consolidation factor in BuildChain (1°
iteration)

0.75

S/A user

11

Allow consolidation for all lorry types

Yes

S/A user

12

Evaluate transport chains one leg at a time

Yes

S/A user

13

Lower bound for frequency optimazation
(Annual Tonnes/Shipment)

10

S/A user

14

Lower bound for consolidation factor

0.05

S/A user

15

Upper bound for consolidation factor

0.95

S/A user

16

Calculation for demand affecting shipment
size

DYNAMIC_AVERAGE

S/A user

17

Do you want to log parameters from control
files?

Yes

S/A user

18

Do you want to log reading of input data?

Yes

S/A user

19

Do you want to log cost values from vehicle
files?

Yes

S/A user

20

Do you want to produce DATA for option?
(0=no, 1=Best solution, 2=best + 2°)

1

S/A user

The second group of catalog keys is “Installation parameters“, and it is only available in
developer mode, see Table 20. It defines the location of the Python program and the name of the
base scenario.
Table 20 “Installation parameter” keys.
Textfield name in template

Example of value

Model
User’s
rights

1

Location of Python program

C:\Python27\ArcGIS10.2

Developer

2

Scenario name for the BASE Scenario

Base2017

Developer
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The next group, “Run Selections”, contains only one key that is for defining the commodity
type(s), see Table 21. It is only used when the user wants to compress the geodatabase files.
Table 21 “Run Selections” key

1

Textfield name in template

Example of value

Model
User’s
rights

Select commodities for the Logistics
Module (for all commodities, select 0)

1

S/A user

The fourth group of keys is related to which subgroup the user wants to use, and how to use it,
see Table 22.

Table 22 Catalog keys for selecting actions.
Textfield name in template

Example of value

Model
User’s
rights

1

Select how you want to use Handling
Scenario application

(2) COMPACT the
geodatabase files
(Input_data.mdb ,
Scenario_data.mdb and
Output.mdb)

S/A user

2

For choice 3 or 4 provide an absolute path
to the location of the destination model (ex.
C:\Samgods_New_version\)

C:\Samgods_V20191001\

S/A user

3

For choice 3 or 4 provide the name of the
base scenario in the destination model

Base2017

S/A user

The first catalog key in Table 22 enables the application:






to delete the scenario specific tables for the current scenario. During the execution, a
prompt window will ask the user to confirm the selections made to avoid mistakes.
to compact all the geodatabase files for the scenario, for both the input and output data. It
is recommended to do this regularly, especially after tables etc. have been deleted. Please
refer to Section 9.9 for more information.
to export the model or a specific scenario in antoher model. When using ” (3) EXPORT the
model in a new folder using the current scenario as Base” a folder location must be
provided in the second catalog key and a new name should be given to the new base
scenario in the third catalog key. If the user wants to export only the selected scenario to
another catalog ( ” (4) EXPORT the current scenario in another model” option for first
catalog key), the folder where the .cat file for this catalog is located should be indicated in
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the second key. The name of the base scenario in the destination catalog should be
specified in key no. 3.
If the user wants to delete or compact a scenario (i.e. has selected “ (1) DELETE the current
scenario tables under Input_data.mdb (mandatory if you want to delete the scenario)” or ”
(2) COMPACT the geodatabase files (Input_data.mdb , Scenario_data.mdb and
Output.mdb)” for key no. 1), it does not matter what is typed in for keys no. 2 and 3, but
since no keys can be left undefined, something must be put there because of the
construction of the software (just typing in a random character will work).
The last value ” (5) CHECK the imported scenario in terms of catalog key definitions” in
catalog key no.1 enables the application to control the scenario parameters for an imported
scenario. The scenario parameter values in the new catalog must be identical to the ones in
the imported scenario. The execution of this subgroup produces a report, Report for the
import phase, accessible from the Data Section window in the interface, in the folder
Scenario Outputs\Import function report. The report provides a list of the scenario
parameters that need to be changed. The parameters are changed by editing the catalogue
keys for the imported scenario according to the report, under “Scenario Parameters” in the
Handling Scenario application and then run the application again.

Finally, there is a key for the consolidation factors, see Table 23.
Table 23 “Parameters and tables for calibration” keys

1

Textfield name in template

Example of value

Model
User’s
rights

Consolidation factors table

{CATALOG_DIR}\05_Input_Da
ta\Input_Data.mdb\BuildChain
_CONSOL

A user/
Developer

Regarding output or reports from these functions:


No outputs are produced by the Delete and Compact choices, because they work on
the tables inside the geodatabase or on the geodatabase itself



The Scenario Export function creates a new catalog with a new base scenario, or a
new scenario in an existing catalog, depending on the selections made



The Import Scenario subgroup will create a report, Report for the import phase, as
described above

PWC_Matrices application
A screenshot of the PWC_Matrices application is shown in Figure 20. The purpose of the
application is to create the PWC matrices in Voyager format in order to enable visualization in
the interface.
In Standard user mode there are only two catalog keys to specify the number of zones in the
network and the year of the PWC matrices. In Advanced user and developer mode there is also
a key to identify the base scenario, and a key to set the total number of commodities.
Possible input values for the first key (Year of PWC matrices) in Table 24 are:
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2016: PWC matrices for year 2016



2040: PWC matrices for year 2040

Table 24 Catalog keys for the PWC_Matrices application.
Textfield name in template

Example of value

Model
User’s
rights

1

Number of zones/terminals in network (see
value in scenario network)

1377 (1379 in
MainSc2040_Xore)

S/A user

2

Scenario name for the BASE Scenario

Base2017

A User/
Developer

3

Year of PWC matrices

2016

S/A user

4

Total number of commodities (excluding
empty commodities):

16

A User/
Developer

It is only necessary to run the PWC_Matrices once in order to create the matrices, since they are
a fixed input for the model. PWC matrices for all commodities will be produced when running the
application – 1 matrices in Voyager format are created in the folder
01_Programs\LogMod\Input\PWC\{YEAR}\VY_F\, found in the Samgods folder (see Table 1 in
Section 6.5). In order to access the matrices from the Data Section window (in Scenario
Inputs\PWC_Matrices\PWC matrix for commodity), open the Samgods Model application in the
Scenario Manager window and select a commodity using the catalog key “Select commodities
for the Logistics Module (…)”. In this step, the application should not be run, just save the
settings by clicking “Save” and the matrices can be found in the Data Section window. The value
0 (for all commodities) is not allowed for this application. This is because the PWC_Matrices
application only allows showing one commodity at a time.

Figure 20 PWC matrices conversion format application.
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Change matrix format application
In Figure 21 below, the Change matrix format application is outlined. The purpose of the
application is the following. All the data in a catalog is accessible using Microsoft Office Access
(2003 or later) (all data except the geodatabases could also be accessed using Excel or
Notepad). The only exception is the data related to the matrix structure, which has a binary
Voyager format. The matrix files have a .mat extension. There are two ways to export these files
in order to use them in Access, Excel or a text editor. The first way is to use the functions in the
Cube Interface. For further details, see the reference guide RG_CubeBase.pdf in Chapter 10 –
Exporting matrix cell values. In short, this is done by choosing “Export…” from “File” on the menu
bar and selecting the appropriate file format.

Figure 21 Change matrix format application.
The second way is provided by this application, as follows. The catalog keys in Table 25 below
handle the export of Voyager format matrix files.
Table 25 Change matrix format application catalog keys.
Textfield name in template

Example of value

Model
User’s
rights

1

Select commodities for the
Logistic Module (for all
commodities, select 0)

3

S/A user

2

Do you want to export to CSV,
DBF or GDB format?

CSV

S/A user

96

Description of the applications - Select link analysis
3

Do you want to create a new
geodatabase or use an existing
one?

Existing

S/A user

4

Define the GDB where the
matrix should be exported.

C:\Samgods\Scenario_Tree\
Base2017\Matrices_Base2017.mdb

S/A user

5

What kind of matrix do you want
to export?

COST

S/A user

6

What vehicle class do you want
for the LOS matrices?

317

S/A user

7

What is the mode that you want
for the matrices?

ROAD

S/A user

8

Do you want the distance, time,
domestic distance or extra cost
LOS matrix?

Time

S/A user

9

What type of vehicle class (or
total) do you want for the
VEHICLES and TONNES
matrices?

202

S/A user

Regarding key no. 2, CSV format refers to Comma Separated Values, DBF refers to Database
Format and GDB refers to Geodatabase format (mdb). If the matrix is exported to a
geodatabase, it will be created as a table inside an existing geodatabase or a new geodatabase
containing this table will be created, depending on the choices made by the user.
To understand the usage of the keys 5-9, and how to export the correct values, an explanation of
the size and the structure of the matrices is required.
The following table (Table 26) presents how the LOS matrices are saved in the scenario folder,
how many matrices that are saved in each matrix file and what their names are. For the OD
matrices, see the next table (Table 27).
Table 26 Matrix table: LOS matrices.
Folde
r

Name of matrix file

Name of matrix

Descripti
on

Total
number
of
matrice
s

{Scenari
o_Dir}

COST_ROAD_{SCENARIO_SHORTN
AME}.MAT

D101_{SCENARIO_SHORTNAME},
D102_{SCENARIO_SHORTNAME},
D103_{SCENARIO_SHORTNAME},
D104_{SCENARIO_SHORTNAME},
D105_{SCENARIO_SHORTNAME},
D106_{SCENARIO_SHORTNAME}

Distance
(km) for
vehicle type
101-106

30

T101_{SCENARIO_SHORTNAME},
…, T106_{SCENARIO_SHORTNAME}

Time (hours)
for vehicle
type 101106
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Folde
r

Name of matrix file

Name of matrix

Descripti
on

X101_{SCENARIO_SHORTNAME},
…,
X106_{SCENARIO_SHORTNAME}

Extra costs
for vehicle
type 101106

CG101_{SCENARIO_SHORTNAME},
…,
CG106_{SCENARIO_SHORTNAME}

DD101_{SCENARIO_SHORTNAME},
…,
DD106_{SCENARIO_SHORTNAME}
{Scenari
o_Dir}

98

COST_RAIL_{SCENARIO_SHORTNA
ME}.MAT

Total
number
of
matrice
s

Generalized
cost for
vehicle type
101-106

Domestic
distance
(km) for
vehicle type
101-106

D201_{SCENARIO_SHORTNAME},
D202_{SCENARIO_SHORTNAME},
D204_{SCENARIO_SHORTNAME},
D205_{SCENARIO_SHORTNAME},
D206_{SCENARIO_SHORTNAME},
D207_{SCENARIO_SHORTNAME},
D208_{SCENARIO_SHORTNAME},
D212_{SCENARIO_SHORTNAME}

Distance
(km) for
vehicle type
201, 202,
204-212

T201_{SCENARIO_SHORTNAME},
T202_{SCENARIO_SHORTNAME},
T204_{SCENARIO_SHORTNAME},
…, T212_{SCENARIO_SHORTNAME}

Time (hours)
for vehicle
type 201,
202, 204212

X201_{SCENARIO_SHORTNAME},
X202_{SCENARIO_SHORTNAME},
X204_{SCENARIO_SHORTNAME},
…,
X212_{SCENARIO_SHORTNAME}

Extra costs
for vehicle
type 201,
202, 204212

CG201_{SCENARIO_SHORTNAME},
CG202_{SCENARIO_SHORTNAME},
CG204_{SCENARIO_SHORTNAME},
…,
CG212_{SCENARIO_SHORTNAME}

Generalized
cost for
vehicle type
201, 202,
204-212

DD201_{SCENARIO_SHORTNAME},
DD202_{SCENARIO_SHORTNAME},
DD204_{SCENARIO_SHORTNAME},
…,
DD212_{SCENARIO_SHORTNAME}

Domestic
distance
(km) for
vehicle type
201, 202,
204-212
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Folde
r

Name of matrix file

Name of matrix

{Scenari
o_Dir}
COST_SEA_{SCENARIO_SHORTNA
ME}.MAT

D301_{SCENARIO_SHORTNAME},
D302_{SCENARIO_SHORTNAME},
…,
D322_{SCENARIO_SHORTNAME}
T301_{SCENARIO_SHORTNAME},
T302_{SCENARIO_SHORTNAME},
…, T322_{SCENARIO_SHORTNAME}

X301_{SCENARIO_SHORTNAME},
X302_{SCENARIO_SHORTNAME},
…,
X322_{SCENARIO_SHORTNAME}

{Scenari
o_Dir}

COST_AIR_{SCENARIO_SHORTNA
ME}.MAT

Descripti
on

Total
number
of
matrice
s

Distance
(km) for
vehicle type
301-322
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Time (hours)
for vehicle
type 301322
Extra costs
for vehicle
type 301322

CG301_{SCENARIO_SHORTNAME},
CG302_{SCENARIO_SHORTNAME},
…,
CG322_{SCENARIO_SHORTNAME}

Generalized
cost for
vehicle type
301-322

DD301_{SCENARIO_SHORTNAME},
DD302_{SCENARIO_SHORTNAME},
…,
DD322_{SCENARIO_SHORTNAME}

Domestic
distance
(km) for
vehicle type
301-322

D401_{SCENARIO_SHORTNAME}

Distance
(km) for
vehicle type
401

T401_{SCENARIO_SHORTNAME}

Time (hours)
for vehicle
type 401

X401_{SCENARIO_SHORTNAME}

Extra costs
for vehicle
type 401

CG401_{SCENARIO_SHORTNAME}

Generalized
cost for
vehicle type
401

DD401_{SCENARIO_SHORTNAME}

Domestic
distance
(km) for

5
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Folde
r

Name of matrix file

Name of matrix

Descripti
on

Total
number
of
matrice
s

vehicle type
401

Table 27 presents how the Vehicle, Tonne, and Empty Vehicle OD-matrices are saved in the
scenario folder, how many matrices that are saved in each matrix file and their names .The
matrices in Table 27 have an index (0 in the table) that represents the commodity class number
(e.g. ROAD_VHCLFLOW0_{SCENARIO_SHORTNAME}.MAT). The value 0 refers to all commodities, and a
specific number in the range 1 to 35, or STAN1 to STAN12, represents the respective commodity
selection.
Table 27 Matrix table with file structure for OD matrices for number of vehicles (loaded and empty)
and tonnes.
Folder

Name of matrix
file

Name of matrix

Descripti
on

Total
of
matric
es

{Scenario_
Dir}

ROAD_VHCLFLOW0
_{SCENARIO_SHOR
TNAME}.MAT

101_{SCENARIO_SHORTNAME}, …
106_{SCENARIO_SHORTNAME},
Road_{SCENARIO_SHORTNAME}

OD
vehicles by
vehicle
type 101106 and
total for
road mode

7

{Scenario_
Dir}

RAIL_VHCLFLOW0_{
SCENARIO_SHORTN
AME}.MAT

201_{SCENARIO_SHORTNAME},
202_{SCENARIO_SHORTNAME},
204_{SCENARIO_SHORTNAME},...
212_{SCENARIO_SHORTNAME},
Rail_{SCENARIO_SHORTNAME}

OD
vehicles by
vehicle
type 201,
202, 204212 and
total for rail
mode

12

{Scenario_
Dir}

SEA_VHCLFLOW0_{
SCENARIO_SHORTN
AME}.MAT

301_{SCENARIO_SHORTNAME}, …
322_{SCENARIO_SHORTNAME},
Sea_{SCENARIO_SHORTNAME}

OD
vehicles by
vehicle
type 3013212 and
total for
sea mode

23

{Scenario_
Dir}

AIR_VHCLFLOW0_{S
CENARIO_SHORTNA
ME}.MAT

AIR_{SCENARIO_SHORTNAME}

OD
vehicles by
vehicle
type 401
and total

1
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Folder

Name of matrix
file

Name of matrix

Descripti
on

Total
of
matric
es

for air
mode
{Scenario_
Dir}

ROAD_TON0_{SCEN
ARIO_SHORTNAME}.
MAT

101_{SCENARIO_SHORTNAME}, …
106_{SCENARIO_SHORTNAME},
Road_{SCENARIO_SHORTNAME}

OD tonnes
by vehicle
type 101106 and
total for
road mode

7

{Scenario_
Dir}

RAIL_TON0_{SCENA
RIO_SHORTNAME}.
MAT

201_{SCENARIO_SHORTNAME},
202_{SCENARIO_SHORTNAME},
204_{SCENARIO_SHORTNAME}, …
212_{SCENARIO_SHORTNAME},
Rail_{SCENARIO_SHORTNAME}

OD tonnes
by vehicle
type 201,
202, 204212 and
total for
mode rail

12

OD tonnes
by vehicle
type 301322 and
total for
sea mode

23

{Scenario_
Dir}
SEA_TON0_{SCENA
RIO_SHORTNAME}.
MAT

301_{SCENARIO_SHORTNAME}, …
322_{SCENARIO_SHORTNAME},
Sea_{SCENARIO_SHORTNAME}

{Scenario_
Dir}

AIR_TON0_{SCENAR
IO_SHORTNAME}.M
AT

AIR_{SCENARIO_SHORTNAME}

OD tonnes
by vehicle
type 401
and total
for air
mode

1

{Scenario_
Dir}

ROAD_EMP0_{SCEN
ARIO_SHORTNAME}.
MAT

101_{SCENARIO_SHORTNAME}, …
106_{SCENARIO_SHORTNAME},
Road_{SCENARIO_SHORTNAME}

OD
vehicles by
vehicle
type 101106 and
total for
road mode

7

{Scenario_
Dir}

RAIL_EMP0_{SCENA
RIO_SHORTNAME}.
MAT

201_{SCENARIO_SHORTNAME},
202_{SCENARIO_SHORTNAME},
204_{SCENARIO_SHORTNAME}, …
212_{SCENARIO_SHORTNAME},
Rail_{SCENARIO_SHORTNAME}

OD
vehicles by
vehicle
type 201,
202, 204212 and
total for
mode rail

12
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Folder

Name of matrix
file

Name of matrix

{Scenario_
Dir}

{Scenario_
Dir}

SEA_EMP0_{SCENA
RIO_SHORTNAME}.
MAT

301_{SCENARIO_SHORTNAME}, …
322_{SCENARIO_SHORTNAME},
Sea_{SCENARIO_SHORTNAME}

AIR_TON0_{SCENAR
IO_SHORTNAME}.M
AT

AIR_{SCENARIO_SHORTNAME}

Descripti
on

Total
of
matric
es

OD
vehicles by
vehicle
type 301322 and
total for
sea mode

23

OD
vehicles by
vehicle
type 401
and total
for air
mode

1

Potentially, as many as 2759 matrices with different level of aggregation could exist in the
scenario folder. See Table 28 below which values to set in the keys in order to print out a specific
matrix.
Table 28 Choice order.
Textfield name in template

Choices
available

Description

Refer to
matrix
table

Select commodities for the Logistics
Module (for all commodities, select 0)
0

All commodities

1-16

Single commodity

CSV

Comma Separated Values

DBF

Database Format

GBD

Geodatabase table

Do you want to export in CSV, DBF or
GDB format?

Do you want to create a new
geodatabase or use an existing one?
Create
Existing
Define the gdb where export matrix:
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An existing or new geodatabase,
depending on choice for previous
key

Table 25
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What kind of matrix do you want to
export?
COST

LOS matrix

Table 26

VHCLFLOW

OD Vehicles matrix

Table 27

TON

OD Tonnes matrix

Table 27

EMP

OD Empty Vehicles matrix

Table 27

Vehicle type for the LOS
matrices

Table 26

Which vehicle class do you want to
select for the LOS matrices?
101-106, 201, 202,
204-212, 301-322,
401
What is the mode that you want for the
matrices?

Vehicle types

Mode for the LOS matrices

Table 26

Specification for the LOS matrix

Table 26

ROAD, RAIL, SEA,
AIR
Do you want the distance, time,
domestic distance or extra cost LOS
matrix?
Distance

D101-D106, D201, …

Time

T101-T106, T201, …

Domestic Distance

DD101-DD106, DD201, …

Extra cost

X101-X106, X201, …

What type of vehicle class (or total) do
you want for the VEHICLES and
TONNES matrices?

Specification for the OD matrix

101-105, 201, 202,
204-209, 301-321

Select a specific vehicle type

Road, Rail, Sea, Air

Select a mode

Table 27

Based on the choices made in the catalog keys described above, the Change matrix format
application creates a CSV or DBF file, or a table inside an existing or a new geodatabase, with
the structure Origin zone, Destination zone and matrix value. The matrix file is found in the
scenario folder and will have a name that gives the specifications made in the catalog keys, e.g.:
{Scenario_DIR}\COST_RAIL_DD202_VOY.CSV
Where the first part (COST) defines the type of matrix (COST, VHCLFLOW, TONNES or
EMPTYVEHICLEFLOW), the second part (RAIL) the mode (RAIL, ROAD, SEA or AIR), the third
part (DD) the type of matrix for the LOS matrices (DD, D, T or X), the fourth part (202) the vehicle
type and the fifth part gives whether the user is an Emme or a Voyager user.
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Select link analysis
Figure 22 shows an outline of the Select link analysis application. Due to the huge amount of
output files produced by Standard Logmod and RCM and either the level of their disaggregation,
this application provides different tools to analyze and show the results with different aggregation
levels and for specific movements.

Figure 22 Select Link Analysis application.
The application produces the following outputs that depend on the choices made via the catalog
keys:


Network containing loaded vehicles and tons for specific product groups,by
commodity and total and the empty vehicles



Maps with loaded, empty vehicles and tons per commodity group when all the
commodities option is chosen



The loaded and empty vehicles and tons could be filtered based on a selection of:



o

Links in the network: the list provided will filter the chains in which the list of
links is part of the path.

o

Nodes in the network: with the same criteria all the chains having one or
more nodes in their path will be selected

The OD Loaded, empty vehicles and tons that are derived by filtering the chains by
the list of links or nodes

The catalog keys could be classify in six different groups:
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Output location



List of commodities to use in the analysis and rules in applying different selections



List of links for the selection



List of nodes for the selection



Traversal matrices



General parameters



Standard maps

Description of the applications - Select link analysis
The output location by default is:


{Scenario_Dir}\SelectLink\{FolderSL}: Since for the same scenario several select link
analysis could be occur, per each run the user should provide a name for the
selection (e.g. Oresun, SL1, anything but without special or black characters). Each
run will be saved in a subfolder in which the name is provided by \{FolderSL}

The catalog key designed for this purpose is:
Table 29 Select link run name.

1

Textfield name in template

Example of value

Model
User’s
rights

SelectLink analysis name (max 6
characters)

FirstSL

S/A user

The selection could be filtered by specific product groups or a list of them. The first catalog key in
Table 30 is designed for this purpose. The criterion can be also combined in different manner,
based on the rule applied throught the second catalog key:


only node selection (regardless what is under link selection)



only link selection (regardless what is under node selection)



node OR link selection (one or the other)



node AND link selection (both met)


Table 30 Selections
Textfield name in template

Example of value

Model
User’s
rights

1

List of commodities for Select Link Analysis
(0 for All)

1,5,9,12

S/A user

2

Select the method being applied for
conditions on nodes and links

only node selection
(regardless what is under link
selection)

S/A user

These catalog keys are specific for this application.
The link list for the selection is specified via the following catalog keys in Table 31.
Table 31 Link selection options
Textfield name in template

Example of value

Model
User’s
rights

1

Numbering system for link list

Voyager ; (Example 1-2049,22083,3-2039)

S/A user

2

List of links

1-2049

S/A user
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3

Selection criteria for links:

ANY ;any of the given links
must be used

S/A user

The interface provides different ways to specify the link list in terms of numbering systems:


Using Voyager nodes (specifing “Voyager” under catalog key 1)



Using Emme nodes (specifing “Emme” under catalog key 1)



Using the Link identified specified in file Links_List.txt under
{Scenario_Dir}\LogMod_{Loop}\RCM folder (Internal_Link_Nbr in the table)
(specifing “ID_Link” under catalog key 1)

For “Voyager” a link must be reprinted with A-B notation, in which A is the starting node number
and B is the ending node number for the link. For “Emme” ” a link must be reprinted with AORIGBORIG notation, in which AORIG is the starting emme node number and BORIG is the ending
emme node number for the link.
The last catalog keys controls how the list of links will be interpreted during the selection. Three
possible options are implemented:


ANY; any of the given links must be used



ALL; all of the given links must be used



ORDER; all nodes an links must be used, and nodes must be visited in order they
are listed under catalog key 2

The node list for the selection is specified via the following catalog keys in Table 32.
Table 32 Node selection options
Textfield name in template

Example of value

Model
User’s
rights

1

Numbering system for node list

Voyager (Example
1,2049,2083,2039)

S/A user

2

List of nodes

2049,2039

S/A user

3

Selection criteria for nodes

ANY ;any of the given links
must be used

S/A user

The interface provides different ways to specify the node list in terms of numbering systems:


Using Voyager nodes (catalog key 1 set to Voyager)



Using Emme nodes (catalog key 1 set to Emme)

The last catalog keys controls how the list of nodes will be interpreted during the selection. Three
possible options are implemented:
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ANY; any of the given links must be used



ALL; all of the given links must be used



ORDER; all nodes an links must be used, and nodes must be visited in order they
are listed in catalog key 2.

Description of the applications - Select link analysis
The Road traversal matrices can be produced using the following specific combination of catalog
keys with the exact values shown in Table 33 only. Reason is to produce traversal matrices (e.g.
trips crossing Swedish boarders) for transfer in the SAMPERS model. They are fixed and the list
of EMME nodes depends on the current Base2017/MainSc2040 coded networks.
Table 33 Traversal matrices settings
Textfield name in template

Example of value

Model
User’s
rights

1

List of nodes

207904,207823,206989,20584
0,206593,187836,200680,197
767,156054,181993,178637,1
88705,181993,190612,205895
,207871,206724,196653,1996
40,193196,158978,171090,15
5434,103288

S/A user

2

Numbering system for node list

Emme (Example
711400,171695,711401)

S/A user

3

Selection criteria for nodes:

ANY ;any of the given links
must be used

S/A user

4

Do you want to produce traversal matrices?
(Untick=no Tick=yes)

Tick (yes)

S/A user



The standard location for the output matrices (in Emme format *.314) is specified
under ScenarioOutput\DataPanel\Select Link\TraversalMatrices:



STD: {SCENARIO_DIR}\SelectLink\{FolderSL}\STD\*.314



RCM: {SCENARIO_DIR}\SelectLink\{FolderSL}\RCM\*.314

To produce standard maps with results classified by commodity group the following catalog key
in table 33 should be tick.
Table 34 GIS Maps option.

1

Textfield name in template

Example of value

Model
User’s
rights

Do you want to produce GIS Maps per
commodity group?

Yes

S/A user

The last group of catalog keys is related to general settings and parameters used in the creation
of empty path files, in Table 35.
The empty vehicles do not belong to any specific chain, therefore the select link analysis is
based on the used paths produced during the assignment. The first run will produce by default
the full set of path files (and therefore it will takes around 30 minutes). In the subsequent runs the
process will be skip since the required path files are already present. No selections are possible
for the user since they are produced by default.
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Table 35 “Installation parameter” keys.
Textfield name in template

Example of value

Model
User’s
rights

1

Number of zones/terminals in network (see
value in scenario network)

1377 (1379 in
MainSc2040_Xore)

Developer

2

Location of Python Program

C:\Python27\ArcGIS10.2

Developer

3

Location of Java folder

C:\Windows\System32

Developer

4

Path to cmd.exe

C:\Windows\SysWOW64\cmd.
exe

Developer

5

Scenario name for the BASE Scenario

Base2017

Developer

6

Choose PWC matrices

2016

S/A user

7

List of rail modes in RCM

GHhIiTUDdEFf

Developer

8

Maximum number of loops in calibration
process

1

Developer

Tip: For normal select link or node analysis, it is better to select:


all the commodities under “List of commodities for Select Link Analysis (0 for All):0” (or
just keeping the default value).



The production of GIS maps, ticking the catalog key “Do you want to produce GIS Maps
by commodity group? Yes” (or just keeping the default value)

The results will be already produced with commodity disaggregation for loaded vehicles and tons.
In the event of a deeper analysis for specific commodity groups (or just one), the default of the
above catalog keys should be revised with the appropriate commodity number. For instance,
selecting commodity 8 the two catalog keys will take the following values:


“List of commodities for Select Link Analysis (0 for All):8”



“Do you want to produce GIS Maps by commodity group? No”

In fact, the maps will be produced with several empty fields (all commodity groups that are not
included in the analysis) and with values for commodity group 8 only.
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Cost Benefit Analysis – ASEK Values
The existing standard transport and cost data derived from the model are based on calibrated
cost data and system performance parameters (such as loading times, transport times, link toll
values, country toll values etc). The split of data into domestic and international transports are
based on domestic distances as a fraction of total distances for the OD-legs. This is valid for
distance related items on links (travel costs and times), but not for times or costs related to
link/node usage (loading times and costs, holding costs, interest costs, transfer times, etc.)
The Cost Benefit Analysis – ASEK values application is specifically designed to calculate socioeconomic input from the Samgods model, primarily related to ASEK-valued data for transports
taking place on Swedish territory (including coastal waters along the coast).
The main differences between Samgods and Cost Benefit Analysis-ASEK values applications
are related to cost and time values in which:


All the calibration parameters such as port area commodity parameters,
transoceanic values, technological factors on time and cost per ports, rescaled
values of vehicle costs, Tax_category, Tax_country, Tax_link and Toll_link are
excluded to get the actual values



Total domestic and international costs and times are produced. The different
components of costs and time (loading and unloading, transfer, transfer) have the
same characterization. This implies that the application must provide LOS total
domestic matrices also for time and cost and not only for time as in the main model.

The application has the following simplified structure presented in Figure 23.

Figure 23 Cost Benefit Analysis – ASEK Values application.
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To use the application only the following catalog keys in Table 36 must be edited:
Table 36 Main catalog key.
Textfield name in template

Example of value

Model
User’s
rights

1

ASEK costs (Base2017ASEK if Year_2017,
MainSc2040ASEK if Year_2040)

Base2017ASEK

S/A user

2

Full scenario folder for comparison (JAreference scenario - before investment)
(Base2017 folder if Year_2017,
MainSc2040 folder if Year_2040)

C:\Models\Samgods_V12D_20
190531\Scenario_Tree\Year_2
017\Base2017\

S/A user

3

Scenario's name to use in comparison (JAreference scenario – before investment)
(Base2017 if Year_2017, MainSc2040 if
Year_2040)

Base2017

S/A user

The user needs:


to select current scenario in which CBA analysis must be run under scenario window;



to change first catalog key under table 35 in acordance of the scenario year:






to change third catalog key under table 35 with name of scenario he/she wants to use
as JA (reference scenario – before investment):







if current scenario is in Y_2017, catalog key “ Scenario's name to use in comparison
(JA- reference scenario – before investment) (Base2017 if Year_2017, MainSc2040
if Year_2040):” will have Base2017,
if current scenario is in Y_2040, catalog key “ Scenario's name to use in comparison
(JA- reference scenario – before investment) (Base2017 if Year_2017, MainSc2040
if Year_2040):” will have MainSc2040,

to identify the folder location for the scenario used for comparison (e.g. folder where the
outputs for scenario selected with previous catalog key are usually found in
Scenario_Tree folder plus short scenario name) in the third catalog key value and
update accordingly the second catalog key:
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if current scenario is in Y_2017, catalog key “ASEK costs (Base2017ASEK if
Year_2017, MainSc2040ASEK if Year_2040):” will have Base2017ASEK,
catalog key “ASEK costs (Base2017ASEK if Year_2017, MainSc2040ASEK if
Year_2040):” will have Base2017ASEK

if current scenario is in Year_2017, catalog key Full scenario folder for
comparison (JA- reference scenario – before investment) (Base2017 folder
if Year_2017, MainSc2040 folder if Year_2040):” will be
C:\Samgods\Year_2017\Base2017\,
if current scenario is in Y_2040, catalog key Full scenario folder for comparison
(JA- reference scenario – before investment) (Base2017 folder if
Year_2017, MainSc2040 folder if Year_2040):” will be
C:\Samgods\Year_2040\MainSc2040\,

Description of the applications – Elasticity module
All the other catalog keys are derived by Samgods and should be not modified for the specific
run.

Figure 24 Input data for Cost Benefit Analysis – ASEK values application.
In setting up the run for Cost Benefic Analysis the input data is derived from two different
scenarios:


The main scenario that contains the outputs from a regular Samgods run



The ASEK scenario that contains the input tables in Input_data.mdb

This has the following practical implications:


To run the Cost Benefit Analysis – ASEK values application it is mandatory to have
run a full Samgods scenario (e.g. to have in place Logmod folder with all the STD
and RCM results)



To have specified an ASEK scenario in terms of input. The model provides the set
for Base2017 and MainSC2040 by default. See section 10.12 for detailed
instructions on how to setup a new ASEK scenario



The application must be run on the main scenario (Base2017 for instance) and not
on the ASEK scenario.

All the outputs are then stored and saved under the main scenario, with suffix CBA on the folder
and file names.
The outputs are identical to those produced under Samgods Model application, all the costs and
times are recalculated without the scaling factors, and therefore they represent the actual values
that can be used in CBA.
The following reports are present in the data panel for CBA output:


Vehicles, loaded and empty, within Swedish territory: first table used for CBA
analysis in evaluating the externalities (emmissions, noise, accidents, infrastructural
damage, etc.). It containes VhclKm and tonkm by vehicle type within Sweden
territory divided by loaded and emtpies. For definition and name of each attribute
please refer to Techinal Manual (section 3.4.3.26).



Logistic Cost Changes used for CBA: the report contains step by step the
calculation defined under “Samhällsekonomisk kalkyl baserad på Samgods Bilaga
1”. An example is presented in Figure 25.
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Figure 25 General report on cost benefit analysis.

For a detailed description on how to setup and run a CBA with the Samgods model, please see
the memo “Samgods och CBA – en exempelanalys av lägre kostnader för bantrafik” on
Samgods web page www.trafikverket.se/samgods. Below a stepwise summary of the
description is given:
1)
2)
3)
4)
5)

Run the reference scenario JA e.g. Base2017 with the Samgods model application.
Make a check of the costs in the preinstalled ASEK-scenario i.e. Base2017ASEK.
Create and run the child scenario UA with the Samgods model application.
Analyze and compare the outputs from the two scenarios JA and UA.
Create the first dataset for the CBA analysis by running the application “Cost Benefit
Analysis - ASEK Values” from the reference scenario (JA). Please make sure that you set
the key to the ASEK costs i.e. Base2017ASEK and that you provide information about
the folder to the reference scenario JA i.e. Scenario_Tree\Year_2017\Base2017 and
the scenario’s name to use in comparison i.e. Base2017.
6) Create the second dataset for the CBA analysis by running the application “Cost
Benefit Analysis - ASEK Values” from the child scenario (UA). As in step 5 make sure
that you set the key to the ASEK costs i.e. Base2017ASEK and that you provide
information about the folder to the reference scenario JA i.e.
Scenario_Tree\Year_2017\Base2017 and the scenario’s name to use in comparison i.e.
Base2017.
7) Collect the output data. For transport costs, used for estimating the benefit, please see
report “Logistic Cost Changes used for CBA” under CBA Report > Main Reports in the
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data window of the child scenario UA3. For traffic and transport work, used for
estimating externalities and financial effects, use the file “Vehicles, loaded and empty,
within Swedish territory” under CBA Report > Main Reports in the reference and child
scenario respectively. You may find this data in the access database table
“Vehicles_loaded_and_empty_witin_swedish_territory_CBA” as well.

3

The reference scenario JA also produce this file. The purpose of this is to prepare data for the second
run of the CBA application. For the reference scenario the “cost differences” should sum to 0, since the
comparison is made with the same scenario.
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Elasticity module
Samgods model is used in setting up different scenarios (through changes in the input network,
vehicle costs and PWC matrices) and analysing the results at various levels of aggregation.
(assignment level, OD level, etc.).
To perform a sensitivity analysis, i.e. variation of fixed percentage of some input variables and
deriving the arc elasticity on the costs, the standard setup would require the setup and run of
several scenarios.
In this process, just a few results are deemed to conduct the analysis, in fact only the variation
of specific cost components and vehicle or ton performance indicators (vehiclekm, tonkm,
vehicles, tons, etc) are required. Most of the output would be irrelevant.
Besides the current scenario, setup would require a considerable time spent in creating
alternative scenarios with variation on a small fraction of the inputs, and as that the comparison
would require several manual steps.
The “Samgods Model Elasiticy” has been developed specifically to overcome all these
limitations.
The “Samgods Model Elasticity” has the following features:


to run several scenarios modifying specific attributes against the reference scenario
(initial scenario with neutral values) without user intervention



to skip the irrelevant modules to produce just the required outputs, cutting the
runtimes



to consolidate the results in a unique database for an easy access and create the
elasticity report that contains already the final values.

8.12.1 Cube implementation
The Samgods model has complemented by an application called “Elasticity module”, seen in
Application Panel in Figure 26 and the flow chart in Figure 27.

Figure 26 Application window.
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The “Elasticity module” differs in terms of structure from the standard one having excluded all
the assignment and reporting steps, except the following ones (where {Select_commodity}
represets catalog key “Select commodities for the Logistics Module (for all commodities, select
0)” which by default is 0, i.e. all commodities)4:


Output by vehicle class – Table
VHCL_OD_COV_{SCENARIO_SHORTNAME}_{Select_commodity}_1



Output by chain – Table
CHAIN_OD_COV_{SCENARIO_SHORTNAME}_{Select_commodity}_1



Loaded Demand – table
COM_L_D_{SCENARIO_SHORTNAME}_{Select_commodity}_1



Output by vehicle class – Table
VHCL_OD_COV_{SCENARIO_SHORTNAME}_RCM_1



Output by chain – Table CHAIN_OD_COV_{SCENARIO_SHORTNAME}_RCM_1



Loaded Demand – table COM_L_D_{SCENARIO_SHORTNAME}_RCM_1

That implies that only those tables are present under data panel.

Figure 27 Elasticity Module application flow chart structure.
8.12.2 Scenario preparation
The scenario name follows rules under “12.4 Check-list when errors occur”.
The scenario preparation follows the instructions under “9.4 Create a new scenario”.
The scenario run for the “Elasticity module” follows the instructions provided in this chapter.
4Both

{Scenario_ShortName} and {Select_commodity} are catalog keys, please see Technical documentation for
more information.
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8.12.3 Scenarios
As anticipated in the introduction, the elasticity module facilitates the setup of several runs using
a unique scenario modifying specific parameters. The list of scenarios is available in
Scenario_List table within Input_Data.mdb. It is also accessible from GUI interface through a
catalog key “Table with scenarios want to run for the elasticity calculation:”, see Figure 28, or
under the Data Panel, Scenario Inputs > List of scenarios, see Figure 29.

Figure 28 The Scenario list catalog key.

Figure 29 Data panel and list of scenarios location.
Now lets explain the variables in scenario list, a sample is seen in Table 37. The module
produces results modifying the base KM_COST and HOURS_COST (plus related attributes
NC_LTI_DRY, NC_LTI_LIQ, NC_LTI_GC, CONT_LTI, CONT_LTI_T) in each mode (or
subset of vehicle types in rail).
A second set of modified parameters refer to:


TOLL: for road tolls on bridges and rail fees on bridges;



TRACK_F: track fees in Sweden (working on base table COUNTRY_TAX and
ID_Country=1);



F_DUES_VH and F_DUES_TON: Fairway Dues per Vehicle and tonnes on sea
mode.

Each scenario is denoted with ID_SCENARIO and this code will identify the specific set of
outputs produced for the specific run and the values should be used under catalog keys (as
explained later in the document).
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Table 37 Scenarios definition.

ID_VEHICLES represents the list of vehicle types in which the parameters must be altered by
proportion specified through values under KM_COST, HOURS_COST and the others. For
instance, under ID_SCENARIO=97, ID_VEHICLES contains 102 and 205 and KM_COST=1.1.
Therefore, the test will be modified the basic values of KM_COST increasing them by 10 %
(1.1=110%) for vehicle type 102 and 205.
While ID_SCENARIO controls the outputs and which test must be run from the interface,
ID_VEHICLES gives the full list of vehicle types in which modification will occur. In providing the
list Voyager syntax is used:


“-“symbol is used for range of values. For instance, 101-106 represents
101,102,103,104,105 and 106. Basically, all road vehicle types.



“,” symbol is used to provide a list of values one by one: 102,205 represent vehicles
102 and 205



Symbols above can be combined to produce a full list. Some examples are:



207-209,212



101-105,201,211-212,311

The changes can be applied within the same mode (207-209,212) or across different modes
(102,205). There is no limitation in that sense.
The other attributes are:


ID: record identifier (row number). Not connected to any function or purpose in the
model. When records are deleted or added ID keeps always a unique number
(primary key) within the table



Mode: description purposes on type of vehicles included in the test. Not used in the
model but useful to remember the type of scenario ran



Scenario: general description of scenario type. It has a combination made by a first
part of the parameter Attribute, called LABEL, seen in Table 38.
Table 38 Scenario types and related label

LABEL Attribute
KM

KM_COST

HR

HOURS_COST (plus related attributes NC_LTI_DRY, NC_LTI_LIQ, NC_LTI_GC,
CONT_LTI)
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TO

TOLL;

TF

TRACK_F

FD

F_DUES_VH

FT

F_DUES_TON

And a second part which can contain anything (for instance KM_TO_ANALYSE_THIS) . The
first two characters of scenario are carried over the run and printed out in the final results (to
help user remembering scenario type) but they would NOT influence the results themselves
(which are controlled by ID_Vehicles list and values under KM_COST and other attributes).
The same ID_SCENARIO code is appended to the six output tables saved during the run of
each scenario ones (where {Select_commodity} represets catalog key “Select commodities for

the Logistics Module (for all commodities, select 0)” which by default is 0, i.e. all commodities)
:


Output by vehicle class STD – Table
VHCL_OD_COV_{SCENARIO_SHORTNAME}_{Select_commodity}
_{ID_SCENARIO}



Output by chain STD – Table
CHAIN_OD_COV_{SCENARIO_SHORTNAME}_{Select_commodity}_{ID_SCEN
ARIO}



Loaded Demand STD – table
COM_L_D_{SCENARIO_SHORTNAME}_{Select_commodity}_{ID_SCENARIO}



Output by vehicle class RCM – Table
VHCL_OD_COV_{SCENARIO_SHORTNAME}_0_RCM_{ID_SCENARIO}



Output by chain RCM – Table
CHAIN_OD_COV_{SCENARIO_SHORTNAME}_0_RCM_{ID_SCENARIO}



Loaded Demand RCM – table
COM_L_D_{SCENARIO_SHORTNAME}_0_RCM_{ID_SCENARIO}.

The tables produced are NOT accessible via Cube GUI but using Office Access.
8.12.4 Usage

Catalog keys
Three catalog keys control the process and provide information of:

Scenario list with rules to alter the base values present in the reference scenario (denoted as
ID_SCENARIO=1) with original setup in the costs and times. The initial table has a fixed number
of scenarios. The values can be revised and new scenarios can be added in line with new tests
with different definition. Textfield name in template is “Table with scenarios want to run for
the elasticity calculation”. Current implementation has a limit of 100 entries.
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“Lowest scenario in sensitivity run:” and “Highest scenario in sensitivity run:” work in pair and
represent the lower and upper scenario ID_SCENARIO the user wants to run in sequence.
Possible usages are:


Run a single scenario: both will be set to the same value (for instance 15 and 15)



Run a range of scenarios: lowest value will be the first scenario (15) and the second
one the highest scenario (20). All the scenarios from 15 to 20 will be run without
any manual action from the user.



It is not allowed to run a list of scenarios that is not sequential, for instance if the
user wishes to run 1, 8 and 15, they must be set up as single runs.

IMPORTANT NOTE: Scenario denoted as 1 is the reference scenario. All the other scenarios will
derive the definition of control files, batch files, etc. from the reference scenario.
In order to run any sensitivity test the reference scenario MUST be in place.
For the first run (when the model is delivered without any scenario), the first run must be set
with “Lowest scenario in sensitivity run” = 1. When the Logmod_1 folder is in place (e.g. a
successful run of reference scenario) all the other scenarios could be run with the preferred
order.
First run
To run “Samgods Elasticity” when the Logmod_1 folder is not in place:


Define the “Lowest scenario in sensitivity run” = 1 and “Highest scenario in
sensitivity run” to the value of last scenario the user wishes to run in one-go;



“Table with scenarios want to run for the elasticity calculation” should point to
05_Input_Data\Input_Data.mdb\Scenarios_List table present in the Input_data.mdb



Set all the other keys as for a usual Samgods run

Any other run
To run “Samgods Elasticity”:


Define the “Lowest scenario in sensitivity run” = the ID_SCENARIO for the first
scenario that needs to be run and



“Highest scenario in sensitivity run” to the ID_SCENARIO of last scenario the user
wishes to run in one-go

IMPORTANT NOTE: under some unforeseen circumstances writing from/to mdb files leads to
run failure since mdb gets lock. In order to avoid failure, it is recommended to run NO MORE
than 4 scenarios in a row. When completed, close down Cube catalog and Cube software and
start it again.
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8.12.5 Output
Output tables will be produced under same output mdb as Samgods Model standard run. In
detail under Output0_{SCENARIO_SHORTNAME}.mdb will be present the following tables
demarked by ID_SCENARIO. Here, in Figure 30 four elasticity scenarios has been evaluated (2,
10, 15 and 16).

Figure 30 Output examples within Output0_{Scenario_Name}.mdb.
Under scenario folder the rep files from STD and RCM procedures demarked by
ID_SCENARIO:

It’s the same for the DBF tables with vehicle parameters in each run. In the example
Vh_base_BS12.DBF is the initial table with original values, it is coincident to
VH_Par_Loop_A_1.DBF. Vh_Par_loop_PartA.DBF is a working table connected to the last run.
VH_Par_Loop_A_{ID_SCENARIO}.DBF the specific table for the scenario. Vh_Par_Loop_A_2.dbf
is the vehicle table used in ID_SCENARIO = 2.
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8.12.6 Specific elasticity output
Two new outputs have been developed:


Elasticities_{SCENARIO_SHORTNAME}_{ID_SCENARIO} table under
Output0_Base2017.mdb



Elasticities_{ID_SCENARIO}.CSV under scenario folder.

They have the following content as listed in Table 39. The attributes have the following
meaning:


PART: Which part of the model produced the output (Standard Logistic Module
(STD) or RCM)



LABEL: describes the unit for the values present in the line under V101-V401



RATIO TDOM VHCLKM: Ratio between vehicle km total domestic of current scenario
vs scenario 1



RATIO TDOM TONKM: Ratio between total domestic ton km of current scenario vs
scenario 1



RATIO TOT VHKM: Ratio between vehicle km total where total = total domestic
plus international, current scenario vs scenario 1



RATIO TOT TONKM: Ratio between ton km total (international plus total domestic)
current scenario vs scenario 1



TF RATIO: First part denoted in bold is defined by the user. It is suggested to keep
a clear coding such as in Table 38.

As per the scenario list:


TF ELAS VhclKm TDOM: elasticity values for vehicle km TDOM5



TF ELAS Tonkm TDOM: elasticity values for ton km TDOM



TF ELAS VhclKm TOT: elasticity values for vehicle km TOT



TF ELAS Tonkm TOT: elasticity values for ton km TOT



ID_SCENARIO: scenario id listed in scenario list table;



V101,V102,….V401 : values for a specific output, defined under LABEL attribute.

Table 39 Elasticities_{SCENARIO_SHORTNAME}_{ID_SCENARIO} table
PART

LABEL

ID_SCENARIO

V101

V102

…

V201

V202

V204

STD

RATIO VHCLKM TDOM

66

1

1.00053

0

0.99416

0.9911

1

5

The definition of TDOM is found in the MERGEREP/OUTPUT/-files, where TDOM is connected to Dtotal
and TOT is connected to DTonneKm + ITonneKm. This is also seen in the script.
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STD

RATIO TDOM TONKM

66

1

1.00069

0

0.99405

0.99088

1

STD

RATIO VHCLKM TOT

66

1

1.00023

0

0.99407

0.9911

1

STD

RATIO TOT TONKM

66

1

1.00031

0

0.99398

0.99088

1

STD

TF RATIO

66

1

1

1

1.1

1.1

1.1

STD

TF ELAS VhclKm TDOM

66

0

0.00053

-1

-0.09622

-0.099

-0.09091

STD

TF ELAS Tonkm TDOM

66

0

0.00069

-1

-0.09632

-0.0992

-0.09091

STD

TF ELAS VhclKm TOT

66

0

0.00023

-1

-0.0963

-0.099

-0.09091

STD

TF ELAS Tonkm TOT

66

0

0.00031

-1

-0.09638

-0.0992

-0.09091

RCM

RATIO VHCLKM TDOM

66

1

0.99901

0

0.98978

0.99749

0.98123

RCM

RATIO TDOM TONKM

66

1

0.9989

0

0.99161

0.99754

0.98406

RCM

RATIO VHCLKM TOT

66

1

0.99952

0

0.99387

0.99749

0.98125

RCM

RATIO TOT TONKM

66

1

0.99943

0

0.99534

0.99754

0.98408

RCM

TF RATIO

66

1

1

1

1.1

1.1

1.1

RCM

TF ELAS VhclKm TDOM

66

0

-0.00099

-1

-0.1002

-0.09319

-0.10797

RCM

TF ELAS Tonkm TDOM

66

0

-0.0011

-1

-0.09854

-0.09315

-0.1054

RCM

TF ELAS VhclKm TOT

66

0

-0.00048

-1

-0.09648

-0.09319

-0.10796

RCM

TF ELAS Tonkm TOT

66

0

-0.00057

-1

-0.09515

-0.09315

-0.10539

8.12.7 Elasticity formulation
The elasticity formulation refers to the approach outlined in UK WebTAG Unit 2 6 and has the
form of:

𝑒=

log(𝑇1) − log(𝑇0)
𝑙𝑜𝑔(𝐶1) − log(𝐶0)

Where:


T1 and T0 are respective values of tonkm, VhclKm, etc in each scenario



C1 and C0 the specific costs modified in the two scenarios

6

https://www.gov.uk/government/publications/webtag-tag-unit-m2-variable-demandmodelling-march-2017
Paragraph 6.4.5 pg. 47
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9 General instructions
This chapter gives instructions for how to start using the Samgods GUI. Please note that the
procedure is described for Standard user or Advanced user mode since the available parameter
settings are different if developer mode is used.

Open the model


Open Cube by clicking on the icon on the desktop



On the Welcome Screen select “Open catalog”



Browse to Samgods catalog (file name: Samgods.cat – default folder C:\Samgods)



Click on “Open”



Alternatively, double click on the Samgods catalog file.

Set the model to Standard user or Advanced user mode


Select “Properties” on the menu bar under section “scenario (see Figure 31)



In the Catalog Properties window, select the “Model User” tab (see Figure 32)



Select “Model user" to "Model Applier" mode



Select "Current Applier Group" among "Developer", "Standard User" or "Advanced User"

Figure 31 How to access “Catalog Properties”.
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Figure 32 How to set the model to Model Applier>Standard user mode.

Tip: Each time changes have been made to the catalog, such as creating a new scenario,
creating new output data by running the model or deleting data, the catalog must be saved. This
is done by clicking the “save catalog” icon (see Figure 33) or going to “File” menu and choosing
“Save” -> “Catalog” (see Figure 34). It is recommended to do this often when working with the
model.

Figure 33 How to save catalog file using icon.
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Figure 34 How to save the catalog file using the menu bar.

General guidelines for how to work with the model
After having opened the model and set it to Standard User mode, the user can start working with
the model. Instructions for each specific action can be found in Chapter 10. However, it is
necessary to also know which actions that should be taken and what to look for in the manual.
This section gives some guidelines for the order of doing different things.
Working with the model is done by using the different applications and via the Data Section
window. In order to use an application for a specific scenario:


Double-click on the scenario name in the Scenarios window and select the application in
the window that opens



When using the Data Section window, select the scenario you want to work within the
Scenarios window by clicking on it and then open the file you want to use from the Data
Section window

In order to work with the input data, i.e. to set up a scenario, the input data must be made
editable. This is done by:


Running the Create the editable files application, see Section 9.5 for instructions. This
must be done also if you just want to view the input data and it is mandatory to run the
application at least once for every scenario you want to use in the model



When the editable data has been created, it could be edited according to the instructions
in Chapter 10 (for example). This is done by using the Edit the data application. Via the
application, the editable data can be accessed (see Section 9.5 for instructions). An
alternative to use Edit the data application to access the editable data, is to use the Data
Section window



When all edits to the input data have been made, the edits must be saved before running
the actual Samgods model. This is done by running the Edit the data application (until
this point the application has only been used to access the editable data, but it has not
been run). For a locked scenario, such as the base scenario, no edits can be saved.
However, the application can still be used to view the data
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At this point the Samgods model can be executed, by running the Samgods Model application
(see Section 9.6). By doing that, the output data is produced and can be compared or exported
according to the instructions in the following chapters.
Different sets of output could be produced for different runs for the same scenario, for example if
the model is run for two different commodity groups for the Standard Logistics module. In order
to run the same scenario for different commodities, first run the Create the editable files
application and then Edit the data as described above (the Edit the data application doesn’t have
to be run for a locked scenario as e.g. the Base2017 scenario). Then select the commodity group
and run the Samgods Model application. After this another commodity can be selected and the
Samgods Model can be run again. The different sets of outputs will be saved separately.
In the scenario folder (under Scenario_Tree, see Table 1), the name of the specific output
database is OutputX_{SCENARIO_SHORTNAME}.mdb, where X is the commodity group. In the
interface, just one set of output for one scenario can be accessible at the time. In order to access
a specific set of output, double-click on the specific scenario, select the Samgods Model
application and select the specific commodity group in the catalog key “Select commodities for
the Logistics Module (…)”. Click “Save” (not “Run”). In this way the correct set of output is
activated and can be accessed from the Data Section window. The scenario selected under
scenario window always filter the data shown under data panel. This is a peculiar characteristic
of Cube and catalog file. All the logical relations are maintained in a coherent frame. The
selection of a particular scenario will specify the values of catalog keys, the folder where results
will be saved, and the data will be shown under data panel.
Whenever a scenario has been deleted or several runs have been made, the geodatabase files
should be compressed in order to save disk space – see Section 9.9 for instructions. When
working with the model and making changes to the catalog, such as adding a scenario or making
changes to the geodatabase, it is recommended to save the catalog often. This is done by
clicking the save button (the black floppy disk icon above the Scenarios window.
An exception is the output for Rail Capacity Management, since it can be run only with all the
commodities (X=0 always) and its results will be always produced in
Output0_{SCENARIO_SHORTNAME}.mdb.

Create a new scenario
To create a new scenario it is necessary to copy the scenario specific tables from another
scenario, then merge the scenario specific tables with the base tables and finally visualize them
in the graphical interface. To create a new scenario, do the following:
1) In the first step, create the scenario name in the catalog:
a) In the Scenarios window, right-click on “Year_2017” or “Year 2040” (depending
on model year for new scenario) and select “Add Child”
b) Type the scenario name (it is neither allowed to use blank entries or to start with
a number, nor to start with the following letters n f t) and press “Enter”
c) In the Scenario Properties window, which then is opened, set a scenario code
(or use the default one) and click “OK”. It is recommended to use a short code
that can be associated with the scenario name
d) The Scenario manager window is opened automatically
2) In the second step, run the Create the editable files application as described below:
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a) In the Scenario manager window, select the Create the editable files in the
Application scroll down menu
b) Define from which scenario to copy the scenario specific tables from (e.g.,
Base2017) by typing the scenario name in the catalog key ”Which scenario do
you want to use? (Default is Base2017)”
c) Click “Run”
d) At the end of the run, click “OK”
The temporary geodatabase is now available in the scenario folder (located in the Scenario_Tree
folder, see Table 1 in Section 6.5) with all the scenario data. To visualize the tables and the
layers of the scenario, change the application from Create the editable files to Edit the data in the
Scenario manager window. In Figure 35 and Figure 35 the default values of the catalog keys are
displayed. The first set of catalog keys (Figure 37) lists the scenario parameters and each
catalog key has an editing box (a box where a numerical value or label is expected), a scroll
down menu, or a check box.

Figure 35 Catalog keys in first window for Edit the data application.
The second set of catalog keys (Figure 36), accessed by clicking “”Next…” in the window in
Figure 35 consists of tables and layers of scenario data. By clicking the “Edit...” button on the
right, the data is opened in the correct format (i.e., a table in a database window or a layer in a
GIS window). Descriptions of the keys and of how to use them for editing and displaying the data
are given in Section 8.4.

127

General instructions - Visualize and/or edit an existing scenario

Figure 36 Catalog keys in second window for Edit the data application.

Figure 37 Catalog keys in third window for Edit the data application.

Tip: To visualize all the layers in a map, click the “Edit...” button, next to the ArcMap GIS Project
File catalog, key shown in Figure 37 pointing at the file Input_Data.mxd. All the geographical data
will be loaded with a few default legends. The same file is available via Scenario Inputs\Editable
Data\ Input_Data.mxd in the Data Section window.
3) Set the catalog keys according to the instructions in Section 8.4 and edit the data. For
instructions on how to edit the scenario data, see Chapter 10.
4) To save the edits that have been made in the temporary geodatabase, the Edit the data
application must be run. During this phase the scenario specific tables will be created
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and saved into the main geodatabase. Also, the report file “Report for the edit phase”
with information or errors from running the Edit the data application will be created in
Scenario Outputs\Edit the data Report in the Data Section window.
a) Click “Run”
b) During the execution, the program will prompt with the question: “Do you really
want to save the scenario {SCENARIO_SHORTNAME}?”. If “No” is selected, the
temporary geodatabase will be deleted. No changes will then be made to the
main geodatabase. If “Yes” is selected, the scenario specific tables will be saved
into the main geodatabase. Whether the temporary geodatabase is deleted or
not depends on the choice made for the catalog key “Do you want delete the
temporary geodatabase?”
c) At the end of the run, click “OK”
d) Close the Scenario Manager window. To the question “Do you want to create the
scenario {SCENARIO_SHORTNAME}?”, click “Yes”
Tip: Information on errors or results from running the Edit the data application is available in
Scenario Outputs\Edit the data Report\Report for the edit phase in the Data Section
window. For information on this and other log reports, please refer to Chapter 12. It is
recommended to consult the reports to make sure no errors have occurred in the input data.
When changes have been made to the catalog, such as adding a new scenario, the catalog file
should be saved. This is done by clicking the black floppy disk icon to the left above the catalog
in the interface.

Visualize and/or edit an existing scenario
In terms of the general structure and terminology of the Samgods GUI, an existing scenario
means that the scenario specific tables are already included in the main geodatabase. To
visualize the data, the scenario-specific tables must be merged with the base scenario tables,
and the appropriate layer (or feature class) for the data that is graphically represented in a map
needs to be created. A layer can be described as the visual representation of a geographic
dataset in any digital map environment. More information on the layers is given in Section 10.
We have already introduced how the applications Create the editable files and Edit the data work
together to guarantee consistence and coherence in the input data (see Sections 8.3 and 8.4).
Please note that it is not allowed to rename a scenario, due to the way input and output data
are handled in the model.
There are two possible statuses of a scenario (see Section 8.4 for further explanation):


The scenario is still editable (the key “Do you want to lock the scenario from further
editing?” in Edit the data was set to “No” when Edit the data was run and the scenario
was saved)



The scenario is locked, either because it is the base scenario or because the user has
locked it (the key “Do you want to lock the scenario from further editing?” was set to
“Yes” when the scenario was saved by the Edit the data application)

Editable Scenario
To visualize and edit an existing scenario, two steps must be performed.
First, the Create the editable files application should be run:
1) Double-click on the scenario name in the Scenarios window
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2) To the right, the Scenario manager window appears
3) In the Application scroll down menu, select Create the editable files (by default this
application is selected)
4) Click “Run”
5) Click “OK” at the end of the run
After the run, the temporary geodatabase is available in the scenario folder (located in the
Scenario_Tree folder, see Table 1 in Section 6.5) containing all scenario data. To visualize the
tables and the layers of the scenario, switch the application from Create the editable files to Edit
the data in the Application scroll down menu in the Scenario manager window.
The first set of catalog keys (Figure 35) lists the scenario parameters and each catalog key has
an editing box (a box where a numerical value or label is expected), a scroll down menu, or a
check box. The second set of catalog keys (Figure 36) accessed by clicking “Next…” in the
window in Figure 35) consists of tables and layers of scenario data. By clicking the “Edit...”
button on the right, the data is opened in the correct format (i.e., a table in a database window or
a layer in a GIS window). Another way to access the data is to use the Data Section window,
where the scenario data can be found in the folder Scenario Inputs\Editable data.
Tip: To visualize all the layers in a map, use the first catalog key (“ArcMap GIS Project File”)
shown in Figure 37, pointing at the Input_Data.mxd file. Click the “Edit…” button and all the
geographical data will be loaded with only a few default legends. The same file is also
available via the Data Section window, in Scenario Inputs\Editable Data\ Input_Data.mxd.

The second step to edit an existing scenario is to save the scenario data into the main
geodatabase. This is done by running the Edit the data application. During this phase, the
scenario specific tables are created and saved into the main geodatabase. Also, the report file
“Report for the edit phase” is created in the folder Scenario Outputs\Edit the data, which is found
in the Data Section window.
6) If the scenario still should be editable, select “No” in the first catalog key (first group of
catalog keys, Figure 34) (to lock the scenario, select “Yes)
7) Select whether the temporary geodatabase should be deleted or not in the scenario
folder
8) Make any edits in the scenario data (see Chapter 10 for instructions)
9) Click “Run”
During the execution, the program will prompt with the question: “Do you really want to save the
scenario {SCENARIO_SHORTNAME}?”. If “No” is selected, the temporary geodatabase will be
deleted. No edits will then be saved into the main geodatabase. If “Yes” is selected, the scenario
specific tables will be saved into the main geodatabase. Whether the temporary geodatabase is
deleted or not depends on the choice made for the catalog key “Do you want delete the
temporary geodatabase?”.
10) At the end of the run, click “OK” and close the Scenario Manager window.

Tip: In the log report in Scenario Outputs\Edit the data Report\Report for the edit phase in the
Data Section window, information is given on any errors or on the results of the process during
the execution of the Edit the data application. For information on this and other log reports,
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please refer to Chapter 0. It is recommended to consult these reports to make sure no input
data errors have occurred.

Locked Scenario
For a locked scenario, the first step (i.e., running the Create the editable files application and
visualizing the data using the Edit the data application) is the same as for an editable scenario. It
is sufficient to run the Create the editable files application once and leave the temporary
geodatabase in the scenario folder so that it is accessible each time the user wants to display the
input data. It is only necessary to run the Edit the data application if the temporary geodatabase
should be deleted.

Run the Samgods model
The different ways to run the Samgods model are described in Sections 8.5 and Section 10. The
following paragraph describes the procedure to run the Samgods model as a Standard user.
1) Open the scenario that you want to run by double clicking on it in the Scenarios window.
The Create the editable files application as well as the Edit the data application must be
run before running the Samgods model, otherwise the error message ReturnCode=2 will
be shown. Please refer to Section 9.5 for an explanation on how this should be done
2) Select the Samgods Model application in the Application scroll down menu. The catalog
key "Number of zones/terminals in network (see value in scenario network)" has shown,
its value should be consistent with the input network and its value should be modified in
Edit the data
3) Under “Run Selections”, make appropriate selections for the keys below:
a) “Run only one step, or run all steps”; choices: All (full run), LOS Calculation,
Logistics Module, Assignment, Reports, Standard LogMod, Rail Capacity
Management
b) "Year of PWC matrices", choices: 2016, 2040 or any user-defined set of
matrices
c) “Select the mode for the LOS Calculation and Assignment steps”; choices: All,
Road, Rail, Sea, Air (Choice available only for LOS Calculation, Assignment,
Reports)
d) “Select commodities for the Logistics Module”; choices: 0 for all the commodities
or the commodity number for a specific commodity (1-16) (Choice available only
for Logistics Module, Assignment, Reports)
4) Under “Other options”, make appropriate selections for the keys below:
a) For the key “Do you want to produce buildchainxx.log files?”, choose whether to
produce the log files from the Buildchain program, containing any warnings from
the execution
5) Under “Logistics Module settings – advanced”, make appropriate selections for the keys
below:
a) “Do you want to run the Logistics Module on several processors?”; tick “Yes” or
“No”
b) “How many processors would you like to run simultaneously?”; indicate 1-16
processors
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6) Under “Rail Capacity Management – settings”, make appropriate selections for the keys
below:
a) “Cut off criteria for RCM process (will consider links with V/C > XX% where XX is
the value defined)": provide a number between 50 and 80. In setting up the
linear programming problem all links with V/C equal to or above this number
(that is expressed as percentage, e.g. 50%) will be enter in the problem.
Recommendable numbers are in the lower range, default value is 50
b) “Options to save output files from RCM process:”, each LP produces a full set of
files (see document listed in reference 4) that could be saved in specific folders
under LogMod. This catalog key will control the option to save all the performed
loops or just the last one
c) "Maximum number of loops for Linear Programming process (LP)": number of
LP loops the user would like to perform. Provide an integer value between 0 and
9. 0 will perform only LP0. The LogMod process will produce the best solutions
and the suboptimal solutions (in terms of transport chains), the number of
suboptimal solutions is controlled by the catalog key " Number of transport chain
solutions for the Logistics Module". It is recommended to not change these
settings and leave the default value
7) Click “Run”
8) A message window appears that informs whether the scenario is locked or still editable –
click “OK”
9) A message window appears with working on Java installation if the path is wrong.
Process will terminated and user needs to revise “Location of Java folder:” catalog key
accordingly to settings on the computer. Example of pop-up message window is in
Figure 38.
10) At the end of the run, the message window ”Task Run Result” indicates that “VOYAGER
Run of Application Samgods Model, 01 is complete” (or a corresponding message for the
Emme user). Click “OK”.
Tip: The run time for the Samgods model varies depending on the selected options. If a full
run with all commodities and modes is selected together the RCM, it may be appropriate to
use multiple processors to reduce the run time.
In the current model version, the program used to solve the Linear Programming Problem
can use only a single processor. Therefore, this is the only part that will not have any
benefit.

Tip: Each time changes have been made to the catalog, such as creating a new scenario,
creating new output data by running the model or deleting data, the catalog should be
saved. This is done by clicking the save icon (the black floppy disk above the Scenarios
window). It is recommended to do this often when working with the model.
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Figure 38 Warning message on Java installation.

Compare scenarios
The comparison of outputs from scenarios is always made between the current selected
scenario and an alternative scenario. The comparison encompasses the following results:
1. differences in LOS matrices (dist, ddist, time and extracost) for all modes and vehicle
types
2. differences in OD tonnes, empty and loaded vehicles for all modes and vehicle types for
STD
3. differences in tonne flows per mode rail, road and sea for STD and RCM
4. differences in vehicle flows in terms per mode rail, road and sea for STD and RCM
5. differences in tonne flows per commodity group for RCM
The Samgods Model application must be run for the specific commodity for both the current
scenario and the scenario selected for comparison before it is possible to compare the outputs.
To run the Compare scenarios application, do the following:
1) Select the Compare Scenarios application in the Applications window
2) In the Scenarios window, open the current scenario that you want to use by double
clicking on it
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3) Select the commodity class that you want to compare. It is mandatory to select a
commodity class (0 for all commodities or the commodity number (1-16) for a specific
commodity)
4) Select what you want to compare. The alternatives are LOS matrices, Logistics Module,
Assignment or all of them
5) Update "Scenario's name to use in comparison:" catalog key with the name you want to
use in the comparison against the current scenario
6) Update "Scenario folder for comparison:" giving information of folder and geodatabase
name containing the scenario you want to compare
7) Click “Run”. At the end of the run, click “OK”.
The results from the comparison between scenarios are saved in their corresponding scenario
folders, with the commodity class number indicated in the file name. The .MAT files for the OD
matrices from the Logistics Module and LOS matrices will be saved directly in the scenario
folder, while the networks from the Assignment step will be saved inside the output
geodatabases. All output can be visualized from the Data section window, in Scenario
Outputs\Compare (Table 2).
An example of values for the different catalog keys is shown in Figure 39:

Figure 39 Catalog key values example.

Delete a scenario
Deleting a scenario requires two steps in different windows.
1) First step: Scenario manager window
a) Select the scenario that you want to delete in the Scenarios window
b) Double click on the scenario name. In the Scenario manager window, select the
Handling scenario application
c) Under the “Handling scenario” catalog key group, on catalog key “Select how
you want to use Handling Scenario application” select “(1) DELETE the current
scenario tables under Input_data.mdb (mandatory if you want to delete the
scenario)” option
Because of software settings, all catalog keys must be set. However, the key “For choice 3 or 4
provide an absolute path to the location of the destination model (ex.
C:\Samgods_New_version\)” will not be used in this case. A random character could be typed in
d) Click “Run”
e) During the execution, a warning window will prompt: ”Do you really want to
delete the scenario {SCENARIO_SHORTNAME}?”. Selecting “No” means that
the scenario will not be deleted. If “Yes” is selected, the scenario will be deleted
f)

At the end of the run, click “OK”

g) Close the Scenario manager window by clicking “Close”
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2) Second step: Scenarios window
a) Right-click on the scenario name in the Scenarios window and select ”Delete”
b) To the question “Ok to delete the data directories for this scenario and its
children?”, click “Yes”;
c) Run the Compact function, see Section 9.9 below.
3) Save the catalog by clicking on the saving icon (black floppy disk, above the Scenarios
window)
Please note: If the scenario is in read-only mode (i.e., the scenario is locked), this step will
have no effects on the scenario regarding the scenario specific tables. The scenario specific
tables will remain in the main geodatabase.

Compress the geodatabase files
The Compact function compresses the files and deletes all the temporary edits stored in the
geodatabase. Data that has been deleted previously are permanently deleted when the Compact
function is run. This reduces the size of the geodatabase and cleans among the files that are
stored in the geodatabase by only keeping the necessary data. Running the Compact function is
required every time that a scenario is deleted or when several runs have been made, and it will
influence:


The main geodatabase containing all the input data (i.e., Input_data.mdb)



The geodatabase containing all the outputs of a specific scenario in the scenario folder
(i.e. OutputX_{SCENARIO_SHORTNAME}.mdb, where X is the commodity group – 0, 116).

The choice to compact a specific output geodatabase is only related to the selected scenario.
However, when the Compact function is employed, the input data (main geodatabase,
Input_data.mdb) will also be compacted. Run the Compact function in the following way:
1) In the Scenarios window, double click on the scenario that you want to compact or any
scenario if you want to compact input data
2) In the Scenario manager window, select the Handling scenario application
3) Under the “Handling scenario” catalog key group, on catalog key “Select how you want
to use Handling Scenario application” select “(2) COMPACT the geodatabase files
(Input_data.mdb , Scenario_data.mdb and Output.mdb)” option

4) Because of software settings, all catalog keys must be set. However, the key “For choice
3 or 4 provide an absolute path to the location of the destination model (ex.
C:\Samgods_New_version\)” will not be used in this case. A random character could be
typed in
Click “Run”
5) At the end of the run, click “OK”
Tip: Run the Compact function every time a scenario is deleted or several runs have been made,
to reduce the amount of data stored in the geodatabase. Just choose any scenario under scenario
tree.
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Export and import a catalog
The Scenario Export function can be used to export a catalog into a new catalog, including a
scenario that will be the base scenario in the new catalog. It can also be used to export a single
scenario into an existing catalog – see the next chapter.
To export the entire catalog into a new catalog directory and create a new base scenario, the
following is required:
1) In the Scenarios window, double click on the scenario that you want to use as
the base scenario in the new catalog
2) In the Scenario manager window, select the Handling scenario application
3) Under the “Handling scenario” catalog key group, on catalog key “Select how
you want to use Handling Scenario application” select “(3) EXPORT the model in
a new folder using the current scenario as Base” option
To set the value for the catalog key “For choice 3 or 4 provide an absolute path to the location of
the destination model (ex. C:\Samgods_New_version\)”, type in the destination folder in the
editing box (for instance C:\Models\Samgods_New_Version\)
4) To set the value for the catalog key “For choice 3 or 4 provide the name of the
base scenario in the destination model”, type in the new name you want to use
for the current scenario, when it has been exported as the base scenario in the
new catalog, in the editing box (for instance Base2017Corr)
5) Click “Run”
6) At the end of the run, click “OK”
Please note: A new folder must be defined for the Scenario export function. If the destination
catalog already exists, the user will be informed by a prompt saying, “The model already
exists”; “This might be an error. The process will be terminated. Check the folder”. In the
Samgods GUI, it is never possible to overwrite an existing catalog.
To complete the export of a catalog properly by controlling that the scenario parameters in the
new catalog correspond to the imported ones, the Scenario Import function must be run. The
required actions are:
1) Close the old catalog by clicking on the x
2) Open the new catalog created during the export
3) Update the paths for the applications as described in Section 6.5 and run the Installation
application (type in the new base scenario name according to the name specified in the
Scenario Export function in the corresponding catalog key; please refer to Section 6.5 for
further instructions)
4) The Scenario_Tree in the Scenarios window in the new catalog only contains seven
scenarios, which have the orginal structure when model is istalled. If the new scenario
requires renaming, please right-clicking on the scenario name and rename it
accordingly. The code should also be updated, which is done by right-clicking and
selecting “Properties”. Define a short code that is similar to the scenario name
5) Under the “Handling scenario” catalog key group, on catalog key “Select how you want
to use Handling Scenario application” select “(5) CHECK the imported scenario in terms
of catalog key definitions” option
6) Because of software settings, all catalog keys must be set. However, the key “For choice
3 or 4 provide an absolute path to the location of the destination model (ex.
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C:\Samgods_New_version\)” will not be used in this case. A random character could be
typed in
Click “Run”
7) At the end of the run, click “OK”
8) Check the report in Scenario Outputs\Scenario_Import_function_Report\Report for
the Import Phase in the Data Section window
9) If any scenario parameters need to be changed according to the report, change those
catalog key values for the imported scenario, under “Scenario Parameters” in the
Handling scenario application and run the application again. Check the report again and
repeat if necessary.
Tip: Each time changes have been made to the catalog, such as creating a new scenario,
creating new output data by running the model or deleting data, the catalog should be saved.
This is done by clicking the save icon (the black floppy disk above the Scenarios window). It
is recommended to do this often when working with the model.

Export and import a scenario
To export a scenario into an existing catalog already containing a base scenario, the following
actions are required:
1) In the Scenarios window, double click on the scenario that you want to export. In the
Applications scroll down menu in the Scenario manager window, select the Handling
scenario application
2) Under the “Handling scenario” catalog key group, on catalog key “Select how you want
to use Handling Scenario application” select (4) EXPORT the current scenario in another
model” option
3) To set the value for the catalog key “For choice 3 or 4 provide an absolute path to the
location of the destination model (ex. C:\Samgods_New_version\)”, type in the
destination folder in the editing box (for instance C:\Models\Samgods_New_Version\)
4) To set the value for the catalog key “For choice 3 or 4 provide the name of the base
scenario in the destination model”, type in the new name you want to use for the current
scenario, when it has been exported as scenario in the new catalog, in the editing box
(for instance MainSc2040Corr)
Click “Run”
5) At the end of the run, click “OK”
Please note: The exported scenario will have the same scenario name in the new catalog as
in the catalog that it was exported from.

To complete the export of a scenario properly by controlling that the imported catalog key values
correspond to the ones in the new catalog, the Scenario Import function must be run. The
required actions are:
1) Close the catalog from where the scenario was exported (i.e., the one that is open) by
clicking on the x
2) Open the catalog to where the scenario has been exported
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3) Create a new scenario, with the same name as set in the export phase, in the catalog
(right-click on Scenario_Tree in the Scenarios window and select “Add child”, type in the
name and press Enter. Define the scenario code and click “OK”)
4) Under the “Handling scenario” catalog key group, on catalog key “Select how you want
to use Handling Scenario application” select “(5) CHECK the imported scenario in terms
of catalog key definitions” option
5) Because of software settings, all catalog keys must be set. However, the key “For choice
3 or 4 provide an absolute path to the location of the destination model (ex.
C:\Samgods_New_version\)” will not be used in this case. A random character could be
typed in
Click “Run”
6) At the end of the run, click “OK”
7) Control the report Scenario Outputs\Scenario_Import_function_Report\Report for
the Import Phase in the Data Section window to see if any edits are necessary
8) Change any catalog key values listed in the report for the imported scenario, under
“Scenario Parameters” in the Handling scenario application and run the application
again. Check the report again and repeat if necessary

Tip: Each time changes have been made to the catalog, such as creating a new scenario,
creating new output data by running the model or deleting data, the catalog should be saved.
This is done by clicking the save icon (the black floppy disk above the Scenarios window). It
is recommended to do this often when working with the model.

Produce PWC Matrices in Voyager format
To produce the PWC matrices in Voyager format, do the following:
1) Double click on a scenario (it does not matter which scenario) in the Scenarios window
and select the PWC_Matrices application in the Scenario manager window
2) Select the year you want to convert in Voyager format among 2016 or 2040 using " Year
of PWC matrices" catalog key
3) Click ”Run”
4) At the end of the run, click “OK”
The matrices are now available in the folder 01_Programs\LogMod\Input\PWC\{Year}\VY_F\,
found in the Samgods folder (see Table 1 in Section 6.5). In order to display the matrices for a
commodity via the Data Section window, do the following:
1) Double click on a scenario (it does not matter which scenario) in the Scenarios window
and select the Samgods Model application in the Scenario manager window;
2) Select a commodity using the catalog key “Select commodities for the Logistics Module
(…)”. Only the numbers 1-16 are allowed here (not 0 for all commodities);
3) Click “Save” to save the settings;
4) The matrices for the selected commodity are now available in the Data Section window,
in Scenario Inputs\PWC_Matrices\PWC matrix for commodity.

Change matrix format
To export a matrix in CSV or DBF format, or as a table in a geodatabase (GDB format):

138

General instructions - Export and import a scenario/Visualize the outputs
1) In the Scenarios window, double click on the scenario corresponding to the matrix you
want to export
2) In the Scenario manager window, select the Change matrix format application and make
appropriate selections for the desired matrix (see the details in Section 1.1)
3) Click “Run”
4) At the end of the run, click “OK”
The output is found in the scenario folder with a CSV or DBF extension or as a table inside a
geodatabase, depending on the selections made.

Visualize the outputs
In the Data Section window, the results that are produced in all steps are available. Please refer
to Section 7.3 for details.

General information on the GIS Window
The ArcMap GIS Project file (Input_data.mxd) is opened from the Data Section window by
opening the folder Scenario Inputs\Editable data and double-clicking on the .mxd file. The .mxd
file can also be visualized from the Edit the data application, by opening the scenario, clicking the
“Next…” button to reach the second set of catalog keys and finally clicking the “Edit…” button for
the ArcMap GIS Project File key. The map document (.mxd) contains the following information:
1) Details of all input data that can be visualized in a map (data with [Geodata] label) with
the following layers (where the default values are indicated in parenthesis):
a) Frequency_network (disabled) (i.e., frequencies of services between terminals,
for more information on this network, see the appendix section 15.3)
b) Nodes_commodities (disabled) (i.e., which commodities that can be handled at
the terminals)
c) Nodes (disabled)
d) Ports_swe (disabled)
e) Network – Link and Node layer (active)
f)

Samgods_zones (active).

A set of default legends () for the node and the link attributes for the layers:
a) Nodes_commodities: Type of terminal
b) Nodes: Type of terminal
c) Ports_swe: Swedish Ports
d) Network:
a. Network_Node: Terminal type (shown in Figure 40)
i. Node type – Road
ii. Node type – Rail
iii. Node type – Sea
iv. Node type – Ferry
v. Node type – Air
b. Network_Link: Modes
e) Samgods zones
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Click here to enable/disable legends

Figure 40 Enable the layer and select the set of legends as in the figure. Example of default legends, for
the Network_Node layer.
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Table of contents

Figure 41 Table of contents (TOC).

2) For the network node and link layers, a set of filter conditions to switch on/off specific
modes are also available. To enable/disable the filters, right-click on the node/link layer
in the TOC and select “Properties”. In the scroll down menu “Selection Group”, select the
desired group and then tick the “Active” check box to activate the option. The filters are
by default set as in the last session, which means that a filter can be active even if no
check boxes are ticked. To be sure to turn all filters off, tick and then un-tick an “Active”
check box. The available groups for the network node layer are:
a) Road Network
b) Rail Network
c) Sea Network
d) Ferry Network
e) Air Network
f)

Zones

The same groups are available for the link layer, except the last one. The advantages of enabling
a filter are the possibilities to:


visualize only the selected entities



select and edit only the visualized entities (and thereby avoid selecting the
wrong links)

The best way of using these filters is in conjunction with the default legends: First activate the
desired filter(s) for the layer(s) you want to work with and then enable and/or edit the
corresponding set(s) of default legends using the icons shown in Figure 40.
The layers ticked in the TOC in Figure 41 are the ones that are visualized in the GIS window. A
layer is selected by clicking on it in the TOC. By selecting “Datasets -> Set Selectable Layers” it
is possible to set which layers that allow selecting elements. E.g., if the Samgods_zones layer is
selected in the TOC but not set as selectable, the zones are shown in the GIS map but cannot
be selected with the Select features tool (see below). The default is that all layers are selectable.
When editing the GIS data, the layer containing the data that is edited must be selected in the
“Layers” drop down menu in the Editor toolbar (see below).
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Each layer has an attribute table, which is accessed by right-clicking on the specific layer in the
TOC. In the attribute table it is possible to view the attributes of each layer, but not to edit any
values. Any edits must be made in the Feature Explorer window (or using the Compute function)
and in Edit mode (see below for explanations).
More information on the GIS window can be found in the help section, accessed from the main
toolbar: Help -> Cube Help -> Cube Base -> GIS Window.

Tools in the GIS window
To select/edit/modify the layers, the following tools are available from the interface:


Select elements, (fixed) zoom in/out in the map, pan, full extent, refresh view, select
features, see Figure 42

Figure 42 Tool in GIS window.


Select/view elements via SQL queries based on the attributes in the layers: On the menu
bar, select Datasets -> Select by Attributes… and type an SQL syntax, for example all
railway nodes in the Stockholm region, in a node layer, see Figure 43.

Figure 43 Select/view elements via SQL.


The Editor toolbar, which is used when editing the network, see Figure 44.

Figure 44 Editor toolbar.
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Add/remove attributes in the layer’s table (node or link table) by selecting Node (or Link)
-> Attribute -> Add/Delete on the menu bar;



Visualize the attributes for a specific selected element – after an element has been
selected using the “Select Features” tool (see first bullet above), the attributes will be
displayed in the Feature Explorer window, see Figure 45. In the Edit mode, it is also
possible to edit and save the new values directly in the Feature Explorer window. To
change to Edit mode, click on Editor -> Start Editing on the Editor toolbar;
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Figure 45 Feature Explorer window


Modify values based on a condition. Under Link or Node (depends on the type of layer)
on the menu bar, the “Compute” option is available when the session is in Edit mode. By
selecting “Compute”, access is given to the Feature Class Attribute Calculation window,
shown in Figure 46. In this window, it is possible to edit the values and apply a condition
(in the example in Figure 46, the capacities for all ports in the Lysekil region are updated,
more details on this specific example can be found in Section 10.6).

Figure 46 The Feature Class Attribute Calculation window
Attributes available in the node and link layers
It is possible to select an element in a node layer using the following attributes:


ID_COUNTRY;
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ID_REGION (primary key if used in combination with ID_COUNTRY). A list of the
country and region codes can be found in the Data Section window, under Scenario
Inputs\General tables\Zoning System;



MODE_N (1 – Road terminal, 2 – Rail terminal, 3 – Port, 4 – Ferry terminal, 5 – Airport).

For example, to select all the nodes in a region, the user only needs to select the layer in the
TOC and then specify the ID_REGION attribute using Datasets -> Select by attribute… on the
main toolbar in figure Figure 47.

Figure 47 Select by attribute tool

To view all available attributes, right-click in the blank field in the Select Specification window.
For the network link layer the attribute corresponding to MODE_N is MODE_L. To select all the
links in a region, do the following:
1) Select the desired region in the map using the Select Features tool (as a suggestion, the
Samgods_zones layer should be ticked in the TOC so that the regions are visible)
2) Activate the layer where you want to select elements, in this case the “Network_Link”
layer, by clicking on it in the TOC
3) On the menu bar, select Datasets -> Select by Location…
4) In the Select by Location window, set the values indicated in Figure 48
5) Click “Apply”, and then “Cancel” when all specifications have been made
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Figure 48 The Select by Location tool.
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10 Scenario setup
As for Chapter 9, this chapter describes how to use the Samgods GUI in Voyager Standard user
mode. The parameter settings etc. that are described are visible in Standard user mode – e.g. in
developer mode all catalog keys are possible to set, in Advance Mode some extra catalog keys
but not all as per developer mode.
After edits have been made to the scenario according to the instructions below, the changes
must be saved to the main geodatabase before running the model. This should be done
according to the instructions in Section 9.5, i.e. by running the Edit the data application.
If you are not sure on how to use the GIS window, the layers, filters and legends, we refer to
Chapter 9 above for a short introduction.

Import EMME network
An option to make edits on the network in Emme environment is available in the GUI interface. In
this paragraph the actions that must be performed are outlined and general suggestions on how
to avoid inconsistencies in the model are provided.
In order to import an Emme network together with the speed definition for links, do the following:
1) Select "Edit the data" and double click on scenario under Scenario Window;
2) Set the values for the following catalog keys, see Figure 49
a) Change "Select from which interface you want to import your edits:" to "EMME
(importing Emme network and speed table)
b) Specify the location for Emme network using "Use Emme network file:" catalog key
The file must have *.211 extension to be recognized by the system
c) Specify the location for link speed file using "Use Emme speed table:" catalog key
The file must have *.DAT extension to be recognized by the system
d) From Emme network *.211 identify the number of zones present in the table (see
below for details on this) and set the catalog key "Number of zones in network (see
value in scenario network):" to that value
3) Click on "Run".

Figure 49 Catalog keys to import Emme network.
The main elements in this import are the number of zones and the file structure for the Emme
network and the speed link table.
The Emme network in *.211 has two distinct parts, t nodes init and t links init. The records
between those two strings represent the node table. An example has shown in Figure 50.
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Figure 50 Node table

The values present in each record has a similar meaning to the attributes present in a Voyager
network:


a: just a label used in Emme program, not relevant for the system



*: if present the record refers to a zone, if not present it is a regular node



711400: Emme number



1620.00: x coordinate



6601.00: y coordinate



1: ID_COUNTRY



114: ID_REGION



0: MODE_N



0000 : user field not relevant for the model.

During the import ID_COUNTRY, ID_REGION and MODE_N will be verified in terms of
consistency with the base scenario. If one or all of them is missed, in
{SCENARIO_DIR}\REPORT_ED_{SCENARIO_CODE}.TXT will be listed the errors (see Chapter
12 for list of messages and possible actions). The errors must be corrected in the *.211 and the
process must be rerun until no messages will be displayed in the report.
To identify the maximum number of zones in the Emme network browse along the node table
until a first record without "*" in the second position has identified. For instance se Figure 51.

Figure 51 Last zone in node table.
Since the text window in Cube gives the row number (number on the left hand side grayed), the
number of zones will be simply identified as difference of the current row number and 5 (first
record in the table containing a node record) plus 1. In the example 1381-5+1 =1377.
This is the value that must be provided to the catalog key "Number of zones in network (see
value in scenario network):". Note that the MainSc2040_Xore has the value 1379.
The system will not perform checks on the link table rather than consistency with the node table.
Therefore before using the network in Samgods the categories associated to the links must be
checked and corrected. The CATEGORY attribute (6th field in the Emme link table, denoted link
type) must be consistent to the list of allowed categories in A_LinkGategories.
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The UL3 attribute (user link data number 3) in the link table (11th field in the Emme link table)
has been used to specify a capacity constraint in sea mode. Therefore those sea links for which
the user wants to apply a constraint, a number must be coded.
It is worth noting that the nodes and links are not sorted in normal Emme output order from a
Cube/Voyager export.

10.1.1 Edit EMME network after importing in GIS Network window
When “Edit the data” has been run providing EMME files the tables under Scenario_Data.mdb
and Input_Data.mdb are updated accordingly. The network under Scenario_Data.mdb is not
used within the import process and keeps the original definition from the parent scenario.
To edit the revised EMME network the following extra steps are required:
1) Select "Create the editable files" and double click on scenario under Scenario Window;
2) Click on "Run";
3) When finished Input_data.mxd and network under Scenario_Data.mdb is updated to
Emme network
4) Proceed with edits in Cube GIS window;
5) When made the intended changes, select “Edit the data” application and double click on
scenario under Scenario Window;
6) Amend the catalog key in the following manner:
7) Set the values for the following catalog keys in Figure 48.
8) Change "Select from which interface you want to import your edits:" to "GIS Window
(Use input files constructed by the Cube GUI)

Figure 52 Catalog keys to edit after import of Emme network.
9) Click on "Run".

Introducing a link-based cost
There are different ways to add taxes, tolls and extra costs to one or several links. All of them are
added for each vehicle class separately. Six attributes with different purposes are defined:


Extra fixed cost per link or set of links (SEK)



Extra kilometres based cost per link or set of links (SEK/km)



Country tax: kilometres based tax per country (SEK/km)



Link class tax: fixed tax per link, per link category (SEK)



Link tax: fixed tax per link (SEK)



Toll for bridges, fixed tax per link (SEK)

How to edit each one of them is described in the following paragraphs. The three types of taxes
(country tax, link class tax and link tax) work together, so that only one of them can be applied to
a specific link at once. In short the priorities are the following:
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COUNTRY TAX <LINK CLASS TAX <LINK TAX
How the different taxes are prioritized in detail is described below, namely in the section about
the link tax. The toll for bridges is added to any tax on a link. It can also be applied to road and
rail links that are not bridges. All these four attributes (the three taxes together with the toll for
bridges) are edited via tables.
Then there are the two extra cost attributes. They could represent any fee, tax or other cost and
are added to any other taxes or tolls for the links where they are defined. They are edited via a
GIS layer.
10.2.1

Extra cost on a specific link or set of links

In order to add a specific cost to a specific link in the network for a specific vehicle class, do the
following:
1) Open the GIS file (Input_Data.mxd), in one of the two possible ways:
e) Open the Scenario manager window by double clicking on the scenario name in the
Scenarios window. In the Scenario manager window, select the Edit the data
application. Click the “Next…” button and then “Edit…” for the catalog key “ArcMap
GIS Project File”;
f)

Alternatively, select the scenario by clicking on it in the Scenarios window and open
the file from the Data Section window, under Scenario Inputs\Editable
data\Input_Data.mxd;

2) Select the Network_Link Layer in the TOC window;
3) On the menu bar, select Link -> Attribute -> Add;
4) In the first popup window, enter the name for the new attribute by considering the
following:
a) If you want to add an attribute as a fixed cost (independent of distance), the label
name EC_VXXX, where XXX represents the vehicle type, should be used (in the
network all the attributes depend on the vehicle type);
b) If you want to add an attribute as a parametric cost depending on the distance, the
label name EC_KM_VXXX should be used;
5) In the second popup window, fill in the variable type (numerical (N) or text (T));
6) Enter the specification for the next new attribute as in 5) and 6). When all attributes have
been added, continue to 8);
7) Leave the attribute name blank (without typing anything) and click “OK”.
Please note: The label names for the two attributes are managed by two catalog keys in the
Edit the data application:


“Attribute name for the extra cost to a specific link (SEK)” – default: EC_V;



“Attribute name for the extra cost to a specific link (SEK/km)” – default: EC_KM_V.

To change the defaults the user only needs to type the new label names in these catalog keys.
If the defaults are changed, the new label names must be used when setting the attributes as
described above, the vehicle type code must be placed at the end of the attribute name, e.g.


COST_KM101;
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FEES_201.

So, if the user e.g. wants to use the attribute name “COST_KM101” for vehicle type 101, the
catalogue key should be set to “COST_KM”.
Examples of erroneous definitions (beginning with a number or containing blank entries) are:


105COST;



204 test;



204test.

Each link in the network will now have the structure displayed in Figure 53 below. The user can
see this in the Feature Explorer window by selecting a link using the “Select Features” tool.

New attributes for
extra costs on links

Figure 53 Feature Explorer window.
8) In the Editor toolbar, select Editor -> Start editing. In the “Layers” drop down menu select
the “Network_Link” layer


To edit a single link, do the following:
1) Use the “Select features” tool

to select the specific link

2) In the Feature Explorer window, type in the value of the tax or cost in the new
attribute cell
3) Save the edit by clicking the green icon on the top left
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4) Close the Feature Explorer window
5) In the Editor toolbar select Editor -> Stop Editing
6) To the question “Do you want to save your edits?”, click “Yes”
7) Close the GIS window by clicking on the X icon without saving the ArcGIS Map
Document (*.mxd) (if any edits to the legends and/or the layout have been made,
the map could be saved, otherwise this is not necessary).


To edit a list of links based on attribute conditions, do the following:
1) Under the main toolbar, select Datasets -> Select by Attributes…
2) In the Select Specification window, right click in the blank field to see the
attribute list (note: it only shows attributes from the active layer – to access other
attributes, select another layer in the TOC), select the attribute for applying the
condition (in the example in Figure 54, select all the links on mode 5 – air)
3)

Figure 54 The Select Specification window.
4) Click “Create New Set”
5) Select Link -> Compute... in the menu bar to access the Link Attribute
Calculation window, see Figure 55
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Figure 55 The Link Attribute Calculation window.
6) Fill in the fields, see Figure 55. To insert edits in the main field in the middle,
right click and select “Insert”. A window, “Insert Equation”, pops up – right-click in
the blank field and select the attribute you want to edit, e.g. EC_KM_V401 as in
Figure 55, and type in “=” followed by the value. More attributes could be edited
by repeating the procedure. In the “Applies To:” drop down menu, select
“Selected items”
7) Click ”Apply”. An information window shows the total number of links updated.
Click “OK” and then “Close”
8) Under the Editor toolbar, select Editor -> Stop Editing
9) To the question “Do you want to save your edits?”, click “Yes”
10) Close the GIS window by clicking on the X icon without saving the ArcGIS Map
Document (*.mxd) (if any edits to the legends and/or the layout have been made,
the map could be saved, otherwise this is not necessary).


To edit a list of links based on a geographical selection, do the following:
1) Select the “Samgods_zones” layer in the TOC
2) In the main toolbar, select Datasets -> Select by Attributes…
3) In the Select Specification window, right click in the blank field to see the
attribute list (note: it only shows attributes from the active layer – to access other
attributes, select another layer in the TOC), and select the attribute for applying
the condition (in the example in Figure 54, select the Stockholm region). For a
list of the region and country codes, open the table Scenario Inputs\General
tables\Zoning Systems in the Data Section window
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Figure 56 The Select Specification window.
4) Click “Create New Set”
5) Select the “Network_link” layer in the TOC
6) On the main toolbar, select Datasets -> Select by Location... to access the
window in Figure 57 where appropriate changes can be done

Figure 57 The Select by Location window.
7) Click “Apply”. An information window shows the total number of links selected.
Click “OK” and then close the window by clicking “Cancel”
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8) Select Link -> Compute on the main toolbar to access the Link Attribute
Calculation window, see Figure 58

Figure 58 The Link Attribute Calculation window.
9) Fill in the fields. To insert edits in the main field in the middle, right click and
select “Insert”. A window, “Insert Equation”, pops up – right-click in the blank
field and select the attribute you want to edit, e.g. EC_V101 as in Figure 58, and
type in “=” followed by the value. More attributes could be edited by repeating
the procedure. In the “Applies To:” drop down menu, select “Selected items”
10) Click “Apply”. An information window shows the total number of links updated.
Click “OK” and then “Close”
11) On the Editor toolbar, select Editor -> Stop Editing
12) To the question “Do you want to save your edits?”, click “Yes”
13) Close the GIS window by clicking on the X icon without saving the ArcGIS Map
Document (*.mxd) (if any edits to the legends and/or the layout have been made,
the map could be saved, otherwise this is not necessary).
10.2.2

Country tax – kilometer-based

1) The user can apply a country tax for road and rail modes, differentiated by vehicle type.
For the other modes (sea, ferry and air), the tax can only be differentiated between
inside and outside of Sweden, since the links for these modes are not divided between
other countries in the Samgods model. To edit the country tax, do the following:
1) Click the “Edit…“ button for the “Table with tax by country (SEK/km) [Table]”catalog key
in the Edit the data application, or open the Scenario Inputs\Editable data\Tax by country
Table from the Data section window, for the selected scenario
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2) To modify existing values, just type a new value in the SEK_KM attribute and press
Enter
3) To add a new tax, the user must know the country code (ID_COUNTRY). To access the
country codes, please refer to the table Scenario Inputs\General tables\Zoning system
in the Data section window
a) Add a new row in the Tax by Country table by clicking the “+” icon;
b) Type in the country code, the vehicle type and the SEK_KM value (the country name
is not required)
4) Close the Tax by Country table by clicking on the X icon in the top right corner and click
“Yes” to the question, see Figure 59.

Figure 59 Country tax modification.

Please note: For sea, ferry and air modes (vehicles class numbers greater than 212) the user
can only apply two country codes:


ID_COUNTRY=1 for Sweden (as above);



ID_COUNTRY=-1 for all countries outside Sweden.

10.2.3

Link class tax

The user can apply a tax per link for a specific category of links in the network. This is done in
the following way:
1) Click “Edit“ for the “Tax by Category (SEK) [Table]” catalog key in the Edit the data
application or open Scenario Inputs\Editable data\Tax by Linkclass from the Data
Section window for the specific scenario;
2) To modify existing values, just type in a new value in the SEK attribute and press Enter;
3) To add a new tax, the user must know the category (LINKTYPE). To access the category
codes, open Scenario Inputs\General tables\LinkCategories values from the Data
section window;
a) Add a new row in the Tax by Link class table by clicking the “+” icon;
b) Type in the LINKTYPE value, the vehicle type and the SEK value;
4) Close the Tax by Link class table by clicking on the X icon in the top right corner and
click “Yes” to the question, see Figure 60.
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Figure 60 Link class tax modification.
10.2.4

Link tax

The user can apply a tax for a specific link in the network. This is done in the following manner:
1) Click “Edit…“ for the “Tax by Link (SEK) [Table]” catalog key in the Edit the data
application, or open Scenario Inputs\Editable data\Tax by Link from the Data section
window for the specific scenario
2) To modify an existing value, just type in a new value in the SEK attribute and press Enter
3) To add a new tax, the user must know the start (A) and end (B) node for the link in the
network. To visualize the network, open the Input_Data.mxd file, e.g. from the Data
Section window. The A and B node numbers can be accessed e.g. by selecting the link
with the Select Features tool and looking in the Feature Explorer window;
a) Add a new row in the Tax by Link table by clicking the “+” icon
b) Type in the A and B values (start and end node for the link), the vehicle class
and the SEK value. In order to have the tax in both directions of the link, the link
must be added twice, one row for each direction (where the A and B nodes are
exchanged in the second row)
4) Close the Tax by Link table by clicking the X icon in the top right corner and click “Yes” to
the question, see Figure 61.

Figure 61 Link tax modification.

Please note: Introducing a link with a zero tax value for a specific vehicle type has the effect
that all the extra costs (in term of taxes) are set to zero on that link. The same principle applies
to the Tax by Link class table regarding the Country tax value.
The general rule applied in the model is that
TAX_COUNTRY <- TAX_LINKCLASS <- TAX_LINK
If several tax values are assigned to a specific link, e.g. one from the country table, another
one from the link class table and a third one from the link table, each value will be overwritten
by the subsequent value in the order above, i.e. the smaller scale always overrides the larger
(disregarding the actual value of the tax).
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Please observe that this rule does not apply to the Toll bridges table or the extra cost values in
the network – they are added to any other taxes.

10.2.5

Toll bridges

In the network, there are a few bridges with fixed tolls. The Toll bridges table contains the values
of the tolls. The user can modify them or add new bridge tolls in the following manner:
1) Click “Edit…“ for the “Toll for bridges (SEK) [Table]” catalog key in the Edit the data
application, or open Scenario Inputs\Editable data\Toll bridges from the Data section
window for the specific scenario
2) To modify an existing value, just type in a new value in SEK attribute and press Enter
3) To add a new toll, the user must know the start (A) and end (B) node for the link in the
network. To visualize the network, open the Input_Data.mxd file, e.g. from the Data
Section window. The A and B node numbers can be accessed e.g. by selecting the link
with the Select Features tool and looking in the Feature Explorer window
a) Add a new row in the Toll bridges table by clicking the “+” icon
b) Type in the A and B values (start and end node for the link), the vehicle class
and the SEK value. In order to have the tax in both directions of the link, the link
must be added twice, one row for each direction (where the A and B nodes are
exchanged in the second row)
4) Close the Toll bridges table by clicking the X icon in the top right corner and click “Yes”
to the question, see Figure 62.

Figure 62 Toll bridges modification.

Change the loading costs and times in terminals for different types of
cargo
The costs and times for loading cargo inside the terminals are specified for different types of
cargo – containers and non containers by commodity group.
1) Open the vehicle parameters table by clicking “Edit…” for the “Specific parameters of
vehicle classes by commodity group [Table]” catalog key in the Edit the data application,
or open “Specific Vehicles Parameters (by vhcl class and commodity group)” from the
Data section window for the specific scenario
2) For each vehicle class and commodity group, edit the values for the attributes below by
typing in the new value and the press Enter:


load time containers in hours/vehicle (not divided by type of commodity) – attribute
CONT_LTI
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load cost containers in SEK/tonne (not divided by type of commodity) – attribute
CONT_LCO



load time non containers in hours/vehicle – attribute NC_LTI



load cost non containers in SEK/tonne – attribute NC_LCO



transfer load time containers in hours/vehicle (not divided by type of commodity) –
attribute CONT_LTI_T



transfer load cost containers in SEK/tonne (not divided by type of commodity) –
attribute CONT_LCO_T



transfer load time non containers in hours/vehicle – attribute NC_LTIT



transfer load cost non containers in SEK/tonne – attribute NC_LCOT

3) Close the table by clicking the X icon in the top right corner
4) On request, click “Yes” to save the edits

Change vehicle data
Change vehicle parameters (e.g. cost per km and hour, capacity, etc,) in the Vehicles
Parameters table the following way:
1) Open the Vehicles Parameters table by clicking the “Edit” button on the “General
parameters of Vehicle classes [Table]” catalog key using the Edit the data application, or
open “General Vehicles Parameters (by vhcl class only)” from the Data section window
for the specific scenario (same table as in Section 10.3);
2) Edit the values for any attribute(s) by vehicle class;
3) Close the table by clicking the X icon in the top right corner;
4) On request, click “Yes” to save the edits.
In the vehicles Parameters table is also the parameter that governs whether the empty vehicle
matrices will be produced or not. For each vehicle class it is possible to set the parameter
“EMPTY_V” to 1 (i.e. produce empty vehicle matrices) or 0 (i.e. not produce empty vehicle
matrices). If the user chooses not to produce the empty vehicle matrices, the matrices will
instead be filled out with zeroes. For more information on the computation of empty vehicles, see
appendix section.15.2.

Change the average value (SEK) of the commodities
1) Open the commodity table by clicking on “Edit” on the “Commodity data [Table]” catalog
key using the Edit the data application, or open Scenario Inputs\Editable data\Cargo
Table from the Data section window, for the specific scenario
2) Edit the values by commodity class for: VALUE_SEKT (SEK/Tonne)
3) Close the table by clicking the X icon in the top right corner
4) On request, click “Yes” to save the edits.

Change capacity in ports
The user can change the values for the following port parameters:
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MaxDwtCont (maximum deadweight tonnage, container vessel)



MaxDwtRoRo (maximum deadweight tonnage, ro/ro vessel)



MaxDwtOthe (maximum deadweight tonnage, other vessels)

This is done in the following way:
1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data
application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section
window for the specific scenario
2) Select the “Nodes” layer in the TOC window and tick the check box if it is not already
ticked
3) Start an Edit session (select Editor -> Start Editing on the Editor toolbar)
4) Select the “Nodes” layer in the “Layers” scroll down menu on the Editor toolbar
5) Select the terminal(s) by using the Select Features tool, or by setting a selection
condition (e.g., rail terminals: MODE_N=2 in Sweden). For instructions on how make a
selection based on attributes, please refer to Section 9.15.
6) Select Node -> Compute and type in the equations by right-clicking in the largest field (in
the middle) and select “Insert” (e.g., MAXDWTRORO=100000, see Figure 63 The
Feature Class Attribute Calculation window.. To see the available parameters, right-click
in the blank field in the Insert Equation window) and select which items the edits should
apply to (all or selected). Click “Apply”. When finished, click “Close”

Figure 63 The Feature Class Attribute Calculation window.
7) On the Editor toolbar, select Editor -> Stop Editing
8) To the question “Do you want to save your edits?”, click “Yes”
9) Close the GIS window by clicking the X icon without saving the ArcGIS Map Document
(*.mxd) (if any edits to the legends and/or the layout have been made, the map could be
saved, otherwise this is not necessary).

Change capacity in Trollhätte canal (also denoted Vänern canal)
The user can change the values for the following port parameters specifically for Vänern canal:
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MaxDwtCont (maximum deadweight tonnage, container vessel);



MaxDwtRoRo (maximum deadweight tonnage, ro/ro vessel);



MaxDwtOthe (maximum deadweight tonnage, other vessels).

This is done in the following way:
1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data
application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section
window for the specific scenario
2) Select the “Nodes” layer in the TOC window and tick the check box if it is not already
ticked
3) Start an Edit session (select Editor -> Start Editing on the Editor toolbar)
4) Select the “Nodes” layer in the “Layers” scroll down menu on the Editor toolbar
5) Select the terminal(s) by using the Select Features tool, or by setting a selection
condition (e.g., Varner ports: PORTAREANR=14). For instructions on how make a
selection based on attributes, please refer to Section 9.15.
6) Select Node -> Compute and type in the equations by right-clicking in the largest field (in
the middle) and select “Insert” (e.g., VANERNCAN=4001. To see the available
parameters, right-click in the blank field in the Insert Equation window) and select which
items the edits should apply to (selected). Click “Apply”. When finished, click “Close”
7) On the Editor toolbar, select Editor -> Stop Editing
8) To the question “Do you want to save your edits?”, click “yes”
9) Close the GIS window by clicking the X icon without saving the ArcGIS Map Document
(*.mxd) (if any edits to the legends and/or the layout have been made, the map could be
saved, otherwise this is not necessary).

Figure 63 The Feature Class Attribute Calculation window.
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Transoceanic impedances for small ports
The current model provides a tool to avoid transshipments between small domestic ports and
international ports. The nodes table has a new attribute, called TRANOCEFAC, that has a value
10 for domestic ports that represent an impedance applied to the times in case a movement
between the small port and a transoceanic port is selected. For details on the implementation
refer to document listed in reference 4. To modify the set of ports or the default value (10) the
following steps could be performed:
1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data
application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section
window for the specific scenario
2) Select the “Nodes” layer in the TOC window and tick the check box if it is not already
ticked
3) Start an Edit session (select Editor -> Start Editing on the Editor toolbar)
4) Select the “Nodes” layer in the “Layers” scroll down menu on the Editor toolbar
5) Select the terminal(s) by using the Select Features tool, or by setting a selection
condition (e.g. MODE_N=3&ID_COUNTRY=1 will select all the domestic ports). For
instructions on how make a selection based on attributes, please refer to Section 9.15.
6) Select Node -> Compute and type in the equations by right-clicking in the largest field (in
the middle) and select “Insert” (e.g., TRANOCEFAC=10, see Figure 64. To see the
available parameters, right-click in the blank field in the Insert Equation window) and
select which items the edits should apply to (selected). Click “Apply”. When finished,
click “Close”

Figure 64 The Feature Class Attribute Calculation window.
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7) On the Editor toolbar, select Editor -> Stop Editing
8) To the question “Do you want to save your edits?”, click “Yes”
9) Close the GIS window by clicking the X icon without saving the ArcGIS Map Document
(*.mxd) (if any edits to the legends and/or the layout have been made, the map could be
saved, otherwise this is not necessary)

Introduce new infrastructure
When adding new infrastructure it is recommended to use the filter function as described below.
Then only links and nodes with specific modes and/or categories are shown in the GIS window.
However, a new link has category = 0. When having created a new link, the attributes, including
the link category, could be edited directly as described below. However, if the editing of the link is
interrupted, e.g. by selecting another element or closing the Feature Explorer window before the
edits are finished, the new link can become invisible in the map because of the filter. In order to
be able to select it again and continue the edits, the filter must be disabled.
The edits made are not always visible at once in the Feature Explorer. In order to see exactly
which edits that have been made for a selected link, close the Feature Explorer and open it again
to refresh it.
10.9.1 New roads
1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data application,
or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section window for the
specific scenario
2) Activate the filter for the road mode both in the network node and the link layers by rightclicking on the respective layer in the TOC, selecting “Properties” and tick the “Active” check
box for road mode
3) Select the Network_Link layer in the TOC
4) Select the node default legend “2:Node type – Road” in the menu accessed by clicking on
the left downwards-pointing arrow:
5) Start an edit session (click Editor -> Start editing)
6) Select the Network_Link layer in the “Layers” drop down menu
Tip: Instead of specifying the new link from the beginning, as described in this
paragraph, it is possible to select an existing nearby link, with attributes like the new
link, and in the Feature Explorer window use the copy function. Click
, and then
create the new link as described below and change only the attributes that differ from
the other link. In this way, it is easier to avoid making mistakes when specifying the
attributes.
7) Select the pencil icon
8) Draw the new link. This is done by clicking where the new link should start and for each new
click on the map, a new vertex is created. At the end of the link, double-click
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9) The following window in Figure 65 will appear if new a node is added (i.e. if the link does not
start and end in existing nodes):

Figure 65 Add new node.
10) Click “Yes” and then select a node value greater than 2000 (values up to 1999 are only for
terminals and zones), see Figure 66
11) Click “OK”

Figure 66 The Add New Node window.
12) In the Feature Explorer window (see Figure 67), specify the following values. In order to
assign the same values to both directions (A to B aand B to A), make sure that both ways
are selected in the Feature Explorer window.

Figure 67 Feature explorer window.

163

Scenario setup - Introduce new infrastructure

a) ALL_M=1 (always equal to 1, which means that it is an open link)
b) LORRY_40T=1 (1 if open for vehicle types 102, 103 and 104, 0 otherwise)
c) LORRY_60T=1;(1 if open for vehicle type 105, 0 otherwise)
d) LORRY_74T=0;(1 if open for vehicle type 106, 0 otherwise)
e) CAR=1 (1 if open for vehicle type 101, 0 otherwise)
f)

Leave all the other modes as zero

g) CATEGORY: type the category number – see available numbers and descriptions in the
Data Section window, under Scenario Inputs\General tables\Link Categories
h) NLANES: number of lanes in each direction
i)

FUNCTION: speed flow curve – see V101/102 tables in the Data Section window under
Scenario Input/General tables (values between 1 and 50, 61 only for connectors and
other modes)

j)

SPEED_1:speed in km per hour for vehicle class 101

k) SPEED_2: speed in km per hour for vehicle classes 102, 103, 104, 105 and 106
l)

DIST_KM: update using the SHAPE_LENGTH value using Link -> Compute tool as
displayed Figure 68 (note that “Selected items” must be selected in the “Applies To:”
field)

m) MODE_L=1, because it is a road link
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Figure 68 The Link Attribute Calculation window.

Please note: It is recommended to round the distance values to avoid excessive
number of digits after the comma.
13) Select in the Feature Explorer window the node or nodes created (they can be found to the
left of the table of attributes). Answer “Yes” to the question whether the edits should be
saved. Edit the following attributes:
a) ID_COUNTRY and ID_REGION: the values are easily identified using the zoning system
feature class. Select the zone and it will be visualized in the Feature Explorer window
with the attributes for the zone (this is preferably done before starting to edit the new
link/node, since selecting the zone will un-select the new link and node). As an
alternative, the table “Zoning System”, found in Scenario Inputs\General tables in the
Data Section window, can be consulted
b) MODE_N=1 because it is a road node
c) All the other attributes will be filled in automatically by the model
14) On the Editor toolbar, select Editor -> Stop Editing
15) To the question “Do you want to save your edits?”, click “Yes”
16) Close the GIS window by clicking the X icon without saving the ArcGIS Map Document
(*.mxd) (if any edits to the legends and/or the layout have been made, the map could be
saved, otherwise this is not necessary).
10.9.2 New railroad
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1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data
application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section
window for the specific scenario
2) Activate the filter for the rail mode, both in the network node and the link layer by rightclicking on the respective layer in the TOC, selecting “Properties” and tick the “Active”
check box for rail mode
3) Select the Network_Link layer in the TOC
4) Select the node default legend “3:Node type-Rail”, in the menu accessed by clicking the
left downwards pointing arrow:
5) Start an edit session (select Editor -> Start Editing)
6) In the “Layers” drop down menu, select the Network_Link layer
Tip: Instead of specifying the new link from the beginning, as described in this
paragraph, it is possible to select an existing nearby link, with attributes like the new
link, and in the Feature Explorer window use the copy function. Click
, and then
create the new link as described below and change only the attributes that differ from
the other link. In this way, it is easier to avoid making mistakes when specifying the
attributes.
7) Select the pencil icon
8) Draw the new link. This is done by clicking where the new link should start and for each
new click on the map, a new vertex is created. At the end of the link, double-click
9) The window in Figure 69 will appear if a new node is added (i.e. if the link does not start
and end in existing nodes):

Figure 69 New railroad.
10) Click on “Yes” and then select a node value greater than 2000 (values up to 1999 are
only for terminals and zones), see Figure 70
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Figure 70 The Add New Node window.
11) Click “OK”
12) In the Feature Explorer window, specify the following values. In order to assign the same
values to both directions (A to B and B to A), make sure that both ways are selected in
the Feature Explorer window.
a) ALL_M=1 (always equal to 1, which means that it is an open link)
b) COMBI=1 (1 if open for vehicle type 201, 0 otherwise)
c) FEEDER1=1 & FEEDER2=1 (1 if open for vehicle type 202, 0 otherwise)
d) STAX225=1 (1 if open for vehicle type 204, 0 otherwise)
e) STAX25=1 (1 if open for vehicle type 205, 0 otherwise)
f)

STAX30=1 (1 if open for vehicle type 206 , 0 otherwise)

g) WAGONLOAD=1 (1 if open for vehicle type 207,208,209, 0 otherwise)
h) CATEGORY: type the category number – see available numbers and
descriptions in the Data Section window, under Scenario Inputs\General
tables\Link Categories
i)

NLANES: number of lanes in each direction

j)

FUNCTION=61 (always this value except for road mode)

k) SPEED1: Speed in km/h
l)

SPEED2=0

m) DIST_KM: update using the SHAPE_LENGTH value using Link -> Compute tool
as displayed in Figure 71 (note that “Selected items” must be selected in the
“Applies To:” field)
n) MODE_L=2, because it is a rail link
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Figure 71 The Link Attribute Calculation window.

Please note: it is recommended to round the distance values to avoid excessive
number of digits after the comma.

13) Select in the Feature Explorer window the created node or nodes (they can be found to
the left of the table of attributes). Answer “Yes” to the question whether the edits should
be saved. Edit the following attributes:
a) ID_COUNTRY and ID_REGION: the values are easily identified using the zoning
system feature class. Select the zone and it will be visualized in the Feature
Explorer window with the attributes for the zone (this is preferably done before
starting to edit the new link/node, since selecting the zone will un-select the new
link and node). As an alternative, the table “Zoning System”, found in Scenario
Inputs\General tables in the Data Section window, can be consulted
b) MODE_N=2 because it is a rail node
c) All the other attributes will be automatically filled by the model
14) On the Editor toolbar, select Editor -> Stop Editing
15) To the question “Do you want to save your edits?”, click “Yes”
16) Close the GIS window by clicking the X icon without saving the ArcGIS Map Document
(*.mxd) (if any edits to the legends and/or the layout have been made, the map could be
saved, otherwise this is not necessary).
10.9.3 New sea, ferry and air links
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New links for these modes could also be added, in a similar manner as for the road and rail links.
An important exception is about the UL3 link attribute for sea and ferry links.
UL3 represents the maximum vessel capacity allowed on a sea or ferry link. The value coded in
this attribute will ban vessel types where the capacity of the vessel exceeds the value UL3.
The vessel capacity is recorded in the general parameters for vehicles (attribute CAPACITY) and
it will compare with UL3 prior the LOS calculation. Two cases are possible:


If UL3 > CAPACITY: the specific vessel type will be able to use the link;



if UL3 < CAPACITY the specific vessel type will not use the particular link.

10.9.4 New terminals
The terminals are represented inside the network as zones 7. They could be distinguished from
the actual zones by their node number, which does not end with 00 (“actual” zones here means
Production, Attraction or Warehouse points for trips, whereas terminals are intermediate steps.
Actual zones could also be terminals, in the case of Direct Access. The actual zones have
NORIG numbers that end with 00. From Emme network it is the value already present).
To add a new terminal, different actions are required depending on the mode of the terminal. The
new terminal needs to be added in three layers: the Network layer, the Nodes_commodities
layer, and the Nodes layer.

Road terminal
Network layer:
1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data
application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section
window for the specific scenario
2) Activate the filter for road mode both in the network node and link layer (please refer to
Section 9.15 for instruction on how to do this)
3) Select the node default legend “2:Node type – road” (see Section 4.15)
4) Select the Network_Node layer in the TOC
5) Start an edit session (on the Editor toolbar, select Editor -> Start Editing)
6) In the “Layers” drop down menu, select the Network_Node layer
7) Select the pencil icon
8) Add the new node by clicking on the location and selecting a node number between the
highest zone number and 2000 (select a number less than 2000 in the range specified in
the window “Current Unused Numbers”)
9) Click “OK”
10) In the node table in the Feature Explorer window, type in the following information:
a) ID_COUNTRY and ID_REGION: the values are easily identified using the zoning
system feature class. Select the zone and it will be visualized in the Feature
Explorer window with the attributes for the zone (this is preferably done before
starting to edit the new node, since selecting the zone will un-select the new
7

The zone numbering referred to are Swedish zone number system used in Emme networks and in the
logistics model. For a conversion to Cube/Voyager node number a node-to-node map is required. All zone
numbers in Emme format starts with node numbers above 700000, whereas all corresponding node
numbers in Cube/Voyager are less than 2000.
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node). As an alternative, the table “Zoning System”, found in Scenario
Inputs\General tables in the Data Section window, can be consulted
b) MODE_N=1, because it is a road terminal
11) In order to change the number of zones for the entire network, right-click on the Network
layer in the TOC and select “Properties”. Change the Highest Zone No. to the number of
the just added terminal and click “OK”, see Figure 72

Figure 72 How to change the number of zones for the entire network
12) Select the Network_Link Layer in the “Layers” drop down menu. To the question whether
the changes should be saved, answer “Yes”. Using the new node as a starting node,
draw a link connector from the node to the road network, as described in the New roads
section above. Then type in the following information in the Feature Explorer window. In
order to assign the same values to both directions (A to B and B to A), make sure that
both ways are selected in the Feature Explorer window:
a) ALL_M=1 (always equal to 1, which means that it is an open link)
b) LORRY_40T=1 (1 if open for vehicle types 102, 103 and 104, 0 otherwise)
c) LORRY_60T=1 (1 if open for vehicle type 105, 0 otherwise)
d) LORRY_74T=0 (1 if open for vehicle type 106, 0 otherwise)
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e) CAR=1 (1 if open for vehicle type 101, 0 otherwise)
f)

Leave all the other modes as zero

g) CATEGORY=110 or 201 (see available numbers and descriptions in the Data
Section window, under Scenario Inputs\General tables\Link Categories);
h) NLANES=1
i)

FUNCTION=61

j)

SPEED_1=50

k) SPEED_2=0
l)

DIST_KM: update using the SHAPE_LENGTH value using Link -> Compute tool
as displayed in Figure 73

m) MODE_L=1 because it is a road link

Figure 73 The Link Attribute Calculation window.

Please note: it is recommended to round the distance values to avoid excessive
number of digits after the comma
Nodes_commodities layer:
1) In the “Layers” drop down menu, select the Nodes_commodities layer. Answer “Yes” to
the question whether to save the changes to the selected feature
2) Tick and select the Nodes_commodities layer in the TOC
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3) Add a new node by clicking in the map and give it exactly the same node number as the
terminal (it doesn’t matter if it is located in another position; it is only the node number
that is important). The node number is specified by assigning it to the attribute “N”
4) Type in the TRANSF_TYPE value – for a terminal with transfer road to road,
TRANSF_TYPE=1 (a list of the transfer types is located in the Data section window in
Scenario Input\General tables\Transfer type of terminal)
5) For each commodity, disable (0) or enable (1) transfer at the terminal
6) If there is another transfer type (e.g., transfer road-train – for road mode, possible values
for transfer type is 1 to 6) to edit, add the same node again in the same way as for the
previous transfer type, by setting the same node number and change all the other values
for the specific case
Nodes layer:
1) In the “Layers” drop down menu, select the Nodes layer. On request, answer “Yes” to
save the changes made
2) Tick and select the Nodes layer in the TOC
3) Add a new node with exactly the same node number as the terminal, in the same
manner as in the Nodes_commodities layer
4) Define the following attributes:


If a zone has direct access to the terminal, ZONET=the number of zone. If no zone
has direct access, define ZONET=0



If a zone belongs to an aggregation group for consolidation set CONAGGR= the
zone number in which the zone in included



DOMESTIC=1 if the terminal is Swedish, 0 otherwise;



C_TECH_FAC and T_TECH_FAC=1

5) On the Editor toolbar, select Editor -> Stop Editing. Answer “Yes” to the question(s)
whether to save the changes made
All the three node layers will now have the new terminal. Figure 74 below shows the Feature
Explorer window for the three layers, displaying some of the attributes of the terminal.
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Nodes_commodities
layer

Network node layer

Nodes layer

Figure 74 Feature Explorer windows for the Nodes_commodities layer, the Network_Node layer and
the Nodes layer, all displaying the attributes of the new terminal.

Rail terminal
The required actions for adding a rail terminal are similar to the ones for a road terminal. Of
course the attributes specific to the mode should be set for rail and railway vehicles instead of for
road. The attributes that differ from the case with the road terminal are:


MODE_N = 2



Possible values for TRANSF_TYPE (please refer to the table Scenario Inputs\General
tables\Transfer Type at terminals in the Data Section window)



CATEGORY=211 for the rail link connection

The terminal must have a rail link to connect it to the rail network and a road link to connect it to
the road network, see Figure 75 (if there is direct access from a zone to the terminal, the road
connector is not mandatory). Please refer to the instructions for a new road terminal and for how
to add a new railroad.
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Figure 75 Nodes layer illustration for rail terminal, connected to the rail network by a rail link and to
the road network by a road link.

Sea terminal
A new sea terminal is added in the same way as a rail terminal (except for the mode specific
attributes), except that the Ports_swe layer also must be edited, by adding the new terminal to it
in a similar way as in the Nodes_commodities layer. The attributes necessary to edit in the
Ports_swe layer are:


N = the same number as in the other three layers



MODE_N = 3



The pilot fees for each one of the vehicle types

Ferry terminal
A new ferry terminal is added in the same way as a rail terminal (except for the mode specific
attributes).

Air terminal
A new air terminal is added in the same way as a rail terminal (except for the mode specific
attributes).

Change speed on different links
1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data
application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section
window for the specific scenario
2) Select the Network Link Layer in the TOC
3) Start an edit session (Editor -> Start editing)
4) Select the Network Link layer in the “Layers” drop down menu on the Editor toolbar
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5) Make a selection (one or several links) and change the speed values in the Feature
Explorer window based on the selection made. For each mode, the speed is managed in
a different way, see below
10.10.1 Road Mode
1) Activate the filter for Road Mode (please refer to Section 9.15 for instructions)
2) If SPEED_1 and SPEED_2 for a link/links inside Sweden are equal to 0, the default
values in the general tables will be applied. The default values for the base speed are in
the delay tables in the Data Section window, Scenario Inputs\General tables\V101/V102
speed flow curves (V101 – applied to class 101, V102 – applied to classes 102-106)
3) The SPEED_1 field is defined as km per hour for vehicle class 101
4) SPEED_2 defines the speed for all other road vehicle classes (102-106)
5) Select a single link using the Select Features tool or select a group of links using
Datasets -> Select by attributes… or Select by location… (see Section 9.15 for
instructions). Edit the values directly in the Feature Explorer window or using Link ->
Compute
6) When all edits have been made, , select Editor -> Stop Editing on the Editor toolbar
7) On the request “Do you want to save your edits?”, click “Yes”
8) Close the GIS window by clicking on the X icon at the top right corner, without saving the
ArcGIS Map Document (*.mxd) (if any edits to the legends and/or the layout have been
made, the map could be saved, otherwise this is not necessary)
10.10.2 Rail Mode
1) Activate the filter for Rail Mode (please refer to Section 9.15 for instructions);
2) Select a single link using the Select Features tool or select a group of links using
Datasets -> Select by attributes… or Select by location… (see Section 9.15 for
instructions). Edit the speed value in the SPEED_1 attribute (in km/h) directly in the
Feature Explorer window or using Link -> Compute (the SPEED_2 attribute is only used
for road mode and should be set to 0 for all other modes)
3) On the Editor toolbar, select Editor -> Stop Editing
4) On the request “Do you want to save your edits?”, click “Yes”
5) Close the GIS window by clicking on the X icon at the top right corner without saving the
ArcGIS Map Document (*.mxd) (if any edits to the legends and/or the layout have been
made, the map could be saved, otherwise this is not necessary).
10.10.3 Sea Mode – enclosed waterways (CATEGORY=80 in Sweden and 540 outside
Sweden)
1) Activate the filter for Sea Mode (please refer to Section 9.15 for instructions)
2) Select a link or set of links with CATEGORY=80 or 540, using the Select Features tool or
Datasets -> Select by attributes… or Select by location… (see Section 9.15 for
instructions). Edit the speed value in the SPEED_1 attribute (in km/h) directly in the
Feature Explorer window or using Link -> Compute (the SPEED_2 attribute is only used
for road mode and should be set to 0 for all other modes)
3) For the other sea categories, the default values in the Vehicles Parameters table are
applied (see the next section)
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4) On the Editor toolbar, select Editor -> Stop Editing
5) On the request “Do you want to save your edits?”, click “Yes”
6) Close the GIS window by clicking on the X icon at the top right corner without saving the
ArcGIS Map Document (*.mxd) (if any edits to the legends and/or the layout have been
made, the map could be saved, otherwise this is not necessary)
10.10.4 Sea Mode – All the other categories
1) Open the Vehicles Parameters table by clicking “Edit…” for the “General parameters of
Vehicle Classes [Table]” catalog key using the Edit the data application or open Scenario
Inputs\Editable data\Vehicles Parameters from the Data Section window for the specific
scenario
2) Edit the speed values in the SPEED attribute for the vehicle types 301-317
3) Close the table by clicking on the X icon at the top right corner
4) On request, click “Yes” to save the edits
10.10.5 Ferry Mode
1) Activate the filter for Ferry Mode (please refer to Section 9.15 for instructions)
2) Select a single link using the Select Features tool or select a group of links using
Datasets -> Select by attributes… or Select by location… (see Section 9.15 for
instructions). Edit the speed value in the SPEED_1 attribute (in km/h) directly in the
Feature Explorer window or using Link -> Compute (the SPEED_2 attribute is only used
for road mode and should be set to 0 for all other modes)
3) On the Editor toolbar, select Editor -> Stop Editing
4) On the request “Do you want to save your edits?”, click “Yes”
5) Close the GIS window by clicking on the X icon at the top right corner without saving the
ArcGIS Map Document (*.mxd) (if any edits to the legends and/or the layout have been
made, the map could be saved, otherwise this is not necessary)
10.10.6 Air Mode
1) Activate the filter for Air Mode (please refer to Section 9.15 for instructions)
2) Select a single link using the Select Features tool or select a group of links using
Datasets -> Select by attributes… or Select by location… (see Section 9.15 for
instructions). Edit the speed value in the SPEED_1 attribute (in km/h) directly in the
Feature Explorer window or using Link -> Compute (the SPEED_2 attribute is only used
for road mode and should be set to 0 for all other modes)
3) On the Editor toolbar, select Editor -> Stop Editing
4) On the request “Do you want to save your edits?”, click “Yes”
5) Close the GIS window by clicking on the X icon without saving the ArcGIS Map
Document (*.mxd) (if any edits to the legends and/or the layout have been made, the
map could be saved, otherwise this is not necessary)

Edit the capacities for rail links
The Rail Capacity Management process requires input in terms of the number of trains per day
allowed on each domestic link (a link flow capacity). This information is provided via the capacity
link table. This section describes the steps to update this table:
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1) Click “Edit” on the “Table with rail capacity [Table]” catalog key using the Edit the data
application, or open Scenario Inputs\Editable data\RailCapacity table from the Data
section window for the specific scenario
2) Sort the table on the attribute ID_LINK clicking on the attribute name
3) Browse to the end of the table
4) Add a new empty record clicking on the button
5) Edit the A and B numbers for the new link in Voyager format
6) Edit the ID_LINK value as the first available from the list (e.g. if the last record has 388,
use 389);
7) Edit the ORIGCAP as number of trains per day bidirectional (e.g. total number of trains in
both the direction)
8) Add another new empty record clicking on the button
9) Edit the A and B numbers where A is the B value introduced in the previous record and
B is the A value introduced in the previous record (basically each time two records must
be introduced, one with A->B and one with B->A)
10) Edit the ID_LINK using the same value as previous record (e.g. 389)
11) Edit the ORIGCAP value using the same value as previous record
12) Close the table by clicking the X icon in the top right corner;
13) On request, click “Yes” to save the edits.

Important note!
The links present in capacity table MUST be consistent with the links present in the network. This
consistency is related to:
- a rail link in the capacity table must be present in the network
- a domestic rail link in the network must have a capacity value in the rail capacity table
- the links must be always bidirectional, therefore two records must always be present
- the ID_LINK must be sequential and no gaps are allowed
- two links with same node numbers (A to B and B to A) must have the same ID_LINK
The user has all these checks already available in the "Edit the data" application. During the run
report #8 will be produced under Report_ED_{SCENARIO_SHORTNAME}.txt. It is strongly
recommended to check this file prior the run of Samgods model.

Setup ASEK scenario
The ASEK scenarios provided in the model already cover the cases for year 2017 and 2040
(Base2017ASEK and MainSc2040ASEK). A new ASEK scenario is required ONLY when the
number of terminals will change from the reference scenario provided. In 2017 there are 1377
zones and in 2040 1377 zones. If the new scenario has more terminals than a new ASEK
scenario must be produced.
To setup an ASEK scenario the required steps are:
1) Create the new scenario under Scenario window, giving the same name of the scenario
in which the ASEK run is required plus ASEK suffix (for instance the main scenario is
Test2040, create the new scenario with name Test2040ASEK)
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2) Select “Create the editable files” application
3) Specify “Test2040” under “Which scenario do you want to copy as new scenario (Default
is Base2017)?” catalog key
4) Run the application
5) Under Scenario_data.mdb overwrite the existing values with the values present in
MainSc2040ASEK for each table or layer in Table 40.
Table 40 Setup ASEK scenario.

Table or layer
Cargo
Tax_Category
Tax_Country
Tax_Link
Toll_Link

Vehicles_parameters_PartA
Vehicles_parameters_PartB
6) In Nodes layer check C_TECH_FAC and T_TECH_FAC values for the new zones. They
must be equal to 1
7) Run “Edit the data” application

Lorry HGV 74 ton setup
The current model setup includes all new vehicle types introduced a few years back in the
definition of chain types used in the logistic process. MainSc2040 and sensitivity tests already
include “211 - System train STAX 22,5 (XL 750 m 204L)”, “212 - Wagonload train (XL 750 m)”
and “322 - Barge Inland water way” as active vehicles while “106 – Lorry HGV 74 ton” is still not
active.
To active this specific vehicle type code there are two options:

1. When editing the network in Network window, update the attribute ” LORRY_74T” with 1;
2. When providing the network as Emme file, update MODESTR value adding B (for instance ”
a 711400 171695 0.26 xabcB
110 1.0 81 50 0.26
0”).
On the chain list submodes c and X are included. They represent specific submodes for vehicle
type 106.
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11 Advanced user options
The advanced user rights have been specified for users demanding a more complex setup in
terms of functionalities. In this chapter, each functionality is described.

Consolidation factors
The consolidation factors can be specified using two different levels:


First level: using catalog keys 21 and 22 in Table 7:



Lower bound for consolidation factor (new) (applied to all commodities)



Upper bound for consolidation factor (new) (applied to all commodities)



Second level: CONSOL<Mode> table under Input_data.mdb which contains the
lower and upper bound for consolidation factor by sub-mode and per specific
commodity groups, using catalog key 7 in Table 16.

The value provided at the first level will be overridden by the values present at the second level.
In the current model some extra consolidation factor are provided for commoditygroups 2, 8 and
9.
The table has the following values seen in Figure 76.

Figure 76 Default CONSOL_L and CONSOL_U values and by commodity group.
The steps to perform if the Advanced user wishes to modify these values using a different set
are:
1) Open Data Manager from Cube Interface

by clicking on

the icon in the red rectangle;
2) Open Input_data.mdb in data manager, see Figure 77
3) Select BuildChain_CONSOL in data manager window, see Figure 78
4) Right click and select "Copy"
5) Select Input_Data,mdb in Data Manager window, right click and select "Paste"
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6) Refresh Data Manager window clicking on
7) Browse to BuildChain_CONSOL_1 (this is the copied table from BuildChain_CONSOL)
and double click on it. Made desired changes and close the window clicking on X.
Default values can be modified, as per by commodity group. Entry =-1 means derive the
value from defaul. For instance CONSOL_L01 for Chain A is -1, the applied value is
CONSOL_L for Chain A 0.4
8) Select Samgods application and scenario under scenario window
9) Double click on scenario name to open the scenario window
10) Click next until reach the catalog key Consolidation factors table
11) Click on "Browse" , select in the left window Input_Data.mdb and in the right window
BuildChain_CONSOL_1
12) Click on OK
13) Click "Save"

Figure 77 Input data.
With the above changes the Samgods application is ready for the run.
For an exhaustive description on how those parameters work in the logistic module see
document listed in reference 3.

Figure 78 Data Manager.
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Wait time for prompt messages
In some applications, some prompt windows will pop up during the execution. The prompt
windows always require an action from the user since the process will be in pause until a choice
will be made within a determined time (10 minutes). The prompt windows give information on the
run, normally warnings and failure messages.
The advanced user has the option to modify these settings and cutting down the wait time to a
few seconds when he/she wishes to run several scenarios in sequence.
To change the waiting time perform the following steps:
1) Select "Create the editable files" application and "Scenario_Tree" scenario under
scenario window
2) Double click on scenario name to open the scenario window
3) Under " Wait time for prompt messages during execution (default 10 minutes=600
seconds):" catalog key type 1 (1 will be 1 second)
4) Click "Save"
5) Click "Close"

Locking solutions option for Rail Capacity Management
A new feature allows locking the transport chain solutions for a set of large flows. This is done by
specifying the cases that need special attention in a text file.
An example of its structure is shown in Figure 79.

Figure 79 LockedSTDLogMod.txt file example.
The values provided are:


Commodity: commodity group (in the example first row 1 commodity)



FromNode: origin (828300)



ToNode: destination (948200)



SubCell: subcell in PWC matrix (0)



Freq: frequency (-1)



Mode used (I)



List of intermediate terminals and zones that must be kept: correct order is 828300 –
828311 – 828011 – 806011 – 786211 – 758111 – 902111 – 948211 - 948200

The transport chains listed in this file will be excluded in the evaluation of the new alternatives
during Standard Logmod and Rail Capacity Management process. Their impact on the rail
capacity consumption is of course still accounted for in the LP-model.
To specify a different set of locked solution the user should:
1) Create a new text file in Notepad (or any other editing software);
2) Provide the list of commodities and Keys he/she wishes to lock (using the results of
STD)
3) Place the new file under {CATALOG_DIR}\01_Programs\ LogMod\Input\Locked
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4) The file's naming convention must follow the general rules for scenario naming (no
blank, special characters, etc.)
5) Select Samgods application and scenario under scenario window
6) Double click on scenario name to open the scenario window
7) Click next until reach the catalog key "File with list of locked solutions for RCM:"
8) Edit the file name in the edit box, see Figure 80.
9) Click "Save"
10) Click "Close

Figure 80 Edit box and input.

Empty vehicle fractions
The Extract procedure reads the output files from LogMod and RCM and produces the OD
matrices for tonnes and number of loaded and empty vehicles respectively. It comprises a
stepwise linear function for deriving the number of empties as fraction of the loaded vehicles.
The applied curve is shown in Figure 81 Curve of empty vehicle fractions.

Figure 81 Curve of empty vehicle fractions.
From version 1.0 of the logistics model the curve could be specified via the interface updating the
table " Empty vehicle fractions per vehicle type and distance" under data panel (Scenario
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Inputs\General tables\). The structure of the table is as shown in Figure 79

Figure 82 Input table for empty vehicle fractions.
The attributes in the table represent the points of the curve the user wants to apply:


DIST1: first distance (km) where will be applied the EMPFAC1 value (with a flat
distribution)



DIST2: second distance (km) where will be applied the EMPFAC2 value (with a
linear function between EMPFAC1 and EMPFAC2 for distances between DIST1 and
DIST2)



If DIST1 and DIST2 are zero, a constant level curve with the value EMPFAC1 will be
applied.

The above attributes in other words shape the function used in the extract procedure. The
attribute ASYM provides a threshold distance above which asymmetric flows will generate empty
vehicles. The asymmetric part is determined as the absolute value of the difference in the loaded
flows in pairwise, opposite OD-relations. To illustrate the calculation consider an OD-relation (the
asymmetric part is abs(120 – 100) = 20):


Distance = 70 km



OD-flow ij= 120 vhcls



DO-flow ji = 100 vhcls



Empty vehicle fraction at 70 km = 0.1

If ASYM=50 the distance (70) is above the threshold value so asymmetric flows will generate
empty vehicles (according to empties := symmetric term + asymmetric term):


OD-flow empties ji = 0.1*100



DO-flow empties ij = 0.1*120 + 20

Restart from failure
In the event of a crash during a Samgods run different actions could be performed by the user
depending on the crashed application.
The model failure can occur under different circumstances:
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The “Scaling factor for outputs” define how the results will be presented in the report tables. The
original values from the model will be divided by





“Thousands” (/1,000)
“Millions” (1,000,000) or
“Billions”.(/1,000,000,000).

In the current implementation the unique and default value is ”Thousands” and the
normal/advance user has not access to the catalog key to modify the default. Only the developer
mode let modify the value.
The steps to modify the value are as follow:
1) Select “Scaling factor for outputs” catalog key from scenario window:
2) Type in the box “Millions” or “Billions”
3) Click on enter and “Save”
Note: The only allowed values are “Thousands”, “Millions” and “Billions”. Any other value is NOT
accepted and it will cause the failure of the run. Also be careful in NOT mispelling the name of
the scaling factor since also this will lead to a failure.
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hard disk space insufficient to save output



locked mdb that prevents move data in Input_data.mdb (if the geodatabase has been
open in GIS interface or is MS Access the .ldb file could reside in the system and protect
the mdb in read mode)



failure in running in the LP solution with CLP64.exe



wrong settings for some keys

If the failure happens in Standard LogMod or Rail Capacity Manamegemnt or in some of their
sub steps (LOS, Logistic Module, Assignment, Report, RCM,Assignment RCM, Report RCM ) it
is possible to rerun the process until the next sub step and after that run each remaining sub step
selecting " Run only one step, or run all steps" with the appropriate value.
For instance, if the process crashes in "Logistics module\Save Reports" group it is required to
run this and next sub group "Assignment\Conversion From Logmod to VY". The instructions
below must be performed for those two groups with the same execution order shown in the
interface (first “Save Reports”, second “Conversion From Logmod to VY”). After this the
Assignment, Report, Rail Capacity Management steps will be run separately.
To rerun a specific subgroup the following actions must be undertaken from the Cube interface:
1) Select the scenario that failed
2) Open the application that failed, see Figure 83
3) Click on "Run" (see icon in red rectangle in following picture)
4) On "Run Application" window select "Run Application now from Task Monitor'
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Advanced user options - Restart from failure
5) Tick "Run Current Group Only"
6) Click on "OK"

Figure 83 Restart from failure.
The single subgroup will be run.

Scaling factor for outpus
The “Scaling factor for outputs” define how the results will be presented in the report tables. The
original values from the model will be divided by





“Thousands” (/1,000)
“Millions” (1,000,000) or
“Billions”.(/1,000,000,000).

In the current implementation the unique and default value is ”Thousands” and the
normal/advance user has not access to the catalog key to modify the default. Only the developer
mode let modify the value.
The steps to modify the value are as follow:
1) Select “Scaling factor for outputs” catalog key from scenario window:
2) Type in the box “Millions” or “Billions”
3) Click on enter and “Save”
Note: The only allowed values are “Thousands”, “Millions” and “Billions”. Any other value is NOT
accepted and it will cause the failure of the run. Also be careful in NOT mispelling the name of
the scaling factor since also this will lead to a failure.
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Scaling factor for outpus
The “Scaling factor for outputs” define how the results will be presented in the report tables. The
original values from the model will be divided by





“Thousands” (/1,000)
“Millions” (1,000,000) or
“Billions”.(/1,000,000,000).

In the current implementation the unique and default value is ”Thousands” and the
normal/advance user has not access to the catalog key to modify the default. Only the developer
mode let modify the value.
The steps to modify the value are as follow:
1) Select “Scaling factor for outputs” catalog key from scenario window:
2) Type in the box “Millions” or “Billions”
3) Click on enter and “Save”
Note: The only allowed values are “Thousands”, “Millions” and “Billions”. Any other value is NOT
accepted and it will cause the failure of the run. Also be careful in NOT mispelling the name of
the scaling factor since also this will lead to a failure.
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12 Log reports
In this chapter, log reports from running some of the applications are presented. The reports
include messages that help the user to better analyze and understand the results.

Edit the data application
The Edit the data log report is created when the Edit the data application is run. Possible
messages inside the log report file Report_ED_{SCENARIO_SHORTNAME}.txt under the
scenario specific folder, or accessible from the Data section window under Scenario outputs\Edit
the data Report, are listed and explained inTable 41.
Table 41 Reports for Edit the data application.
Number
of
message
inside the
log report

Purpose

Example of
messages

Message explanation

#1

Inform whether the
scenario is editable or
not

Report #1 – the
scenario is still
editable.

The scenario is in editable
mode.

Report #1 – the
scenario is locked.

Changed the scenario into
read only mode. It is not
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Scaling factor for outpus
The “Scaling factor for outputs” define how the results will be presented in the report tables. The
original values from the model will be divided by





“Thousands” (/1,000)
“Millions” (1,000,000) or
“Billions”.(/1,000,000,000).

In the current implementation the unique and default value is ”Thousands” and the
normal/advance user has not access to the catalog key to modify the default. Only the developer
mode let modify the value.
The steps to modify the value are as follow:
4) Select “Scaling factor for outputs” catalog key from scenario window:
5) Type in the box “Millions” or “Billions”
6) Click on enter and “Save”
Note: The only allowed values are “Thousands”, “Millions” and “Billions”. Any other value is NOT
accepted and it will cause the failure of the run. Also be careful in NOT mispelling the name of
the scaling factor since also this will lead to a failure.

3 Log reports - Samgods Model application/Handling
scenario application
possible to change it back
from the interface.
#2

Verify the Port_swe
table

Report #2: the
terminal N(6.0)
TERMINAL N(6.0) is
not a sea terminal!!
Please check the”
Ports Sweden” layer.

The terminal number that is
not a sea terminal is printed
out. In the Ports_swe table
there should be only sea
terminals. If the terminal is not
a port, it will not be saved in
the table.

Verify if a domestic port
has the PortArea
number specified

Report #2: the
terminal N(6.0) is
missing the Port
Area attribute.

Each domestic port must be
allocated to a port area since
some calibration parameters
are associated to this
attribute. It is also used for
reporting procedures.

Please associate a
port area number.
See table
"A_Port_areas" for
the attribute names
#3

Information on the
number of
zones\terminals

Report #3: the
number of zones is
MAX
NETWORK(5.0)

Correct the PortArea number
with appropriate number.

Maximum number of
zones\terminals in the
highway network
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Scaling factor for outpus
The “Scaling factor for outputs” define how the results will be presented in the report tables. The
original values from the model will be divided by





“Thousands” (/1,000)
“Millions” (1,000,000) or
“Billions”.(/1,000,000,000).

In the current implementation the unique and default value is ”Thousands” and the
normal/advance user has not access to the catalog key to modify the default. Only the developer
mode let modify the value.
The steps to modify the value are as follow:
1) Select “Scaling factor for outputs” catalog key from scenario window:
2) Type in the box “Millions” or “Billions”
3) Click on enter and “Save”
Note: The only allowed values are “Thousands”, “Millions” and “Billions”. Any other value is NOT
accepted and it will cause the failure of the run. Also be careful in NOT mispelling the name of
the scaling factor since also this will lead to a failure.
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#3

Verify the coherence
between network and
nodes

Report #3: the
number of zones is
not the same in the
network and the
node table.
In the network there
are MAX
NETWORK(5.0) and
in the nodes table
MAX NODES(5.0).
Please check the
Scenario network.

#4
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Verify the coherence
between tables

In this step, the application
updates the variable
ZONES_M inside the general
tables and gives the report.
MAX NETWORK(5.0) is the
variable used to count the
maximum number of zones in
the network
MAX NODES(5.0) is the
variable used to count the
maximum number of zones in
the node s table. During the
run, they will be substitute by
the zone node numbers.

Report #4: Please
add the node
ZONE(6.0) to the
node table.

The zone is in the network but
not in the nodes table.

Report #4: Please
add the node
ZONE(6.0) to the
network.

The zone is in the nodes table
but not in the network.

Scaling factor for outpus
The “Scaling factor for outputs” define how the results will be presented in the report tables. The
original values from the model will be divided by





“Thousands” (/1,000)
“Millions” (1,000,000) or
“Billions”.(/1,000,000,000).

In the current implementation the unique and default value is ”Thousands” and the
normal/advance user has not access to the catalog key to modify the default. Only the developer
mode let modify the value.
The steps to modify the value are as follow:
4) Select “Scaling factor for outputs” catalog key from scenario window:
5) Type in the box “Millions” or “Billions”
6) Click on enter and “Save”
Note: The only allowed values are “Thousands”, “Millions” and “Billions”. Any other value is NOT
accepted and it will cause the failure of the run. Also be careful in NOT mispelling the name of
the scaling factor since also this will lead to a failure.
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scenario application

#5

Verify the numbering
system

Report #4: Please
add the sea terminal
ZONE(6.0) to the
network.

The sea terminal is in the
Node_Terminals but not in the
network.

Report #4: Please
add the commodity
node ZONE(6.0) to
the network.

The node is in the
Nodes_commodities table but
not in the network.

Report #4: Please
add the frequency
node ZONE(6.0) to
the network.

The node is in the
Frequency_Data_Node table
but not in the network.

Report #4: Please
add the frequency
node ZONE(6.0) to
the network.

The node is in the
Frequency_Data_Link table
but not in the network.

Report #5 –
numbering system.

Header of the message

Node / Code_error /
Description
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Scaling factor for outpus
The “Scaling factor for outputs” define how the results will be presented in the report tables. The
original values from the model will be divided by





“Thousands” (/1,000)
“Millions” (1,000,000) or
“Billions”.(/1,000,000,000).

In the current implementation the unique and default value is ”Thousands” and the
normal/advance user has not access to the catalog key to modify the default. Only the developer
mode let modify the value.
The steps to modify the value are as follow:
1) Select “Scaling factor for outputs” catalog key from scenario window:
2) Type in the box “Millions” or “Billions”
3) Click on enter and “Save”
Note: The only allowed values are “Thousands”, “Millions” and “Billions”. Any other value is NOT
accepted and it will cause the failure of the run. Also be careful in NOT mispelling the name of
the scaling factor since also this will lead to a failure.
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#6
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View the errors during
the creation of NORIG
numbers for the zones

N / 1 / Missed the
mode! – must be
correct!

Missed the mode for node N –
must be correct in the node
table

N / 2 / Missed the ID
COUNTRY or the ID
REGION code –
must be correct!

Missed the ID_COUNTRY or
the ID_REGION code in the
node table for node N

List of errors during
the creation of
SCBSTANN for the
zones

Header of the message

The node is without
MODE_N. Please
check the data.

The mode for the zone is
missing

The node has no
values available.
Please check the
data.

There are no node numbers
available for the zone

NORIG is the Emme node
number and its specification
comes from a set of rules
when edits are made in GIS
interface. From Emme
network it is the value already
present.

Scaling factor for outpus
The “Scaling factor for outputs” define how the results will be presented in the report tables. The
original values from the model will be divided by





“Thousands” (/1,000)
“Millions” (1,000,000) or
“Billions”.(/1,000,000,000).

In the current implementation the unique and default value is ”Thousands” and the
normal/advance user has not access to the catalog key to modify the default. Only the developer
mode let modify the value.
The steps to modify the value are as follow:
4) Select “Scaling factor for outputs” catalog key from scenario window:
5) Type in the box “Millions” or “Billions”
6) Click on enter and “Save”
Note: The only allowed values are “Thousands”, “Millions” and “Billions”. Any other value is NOT
accepted and it will cause the failure of the run. Also be careful in NOT mispelling the name of
the scaling factor since also this will lead to a failure.
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#7

#8

View the errors during
the creation of NORIG
numbers for the nodes

Check the consistency
of rail capacity table
with Rail Network

List of errors during
the creation of
NORIG for the
nodes

Header of the message

No more node
numbers are
available. Please
check the data

There are no node numbers
available for the node

Report#8: There are
mistakes in the rail
capacity table.
Please check the rail
capacity table.

The link listed is not a rail link.
Check the node numbers A
and B in the rail network and
identify the proper node
number. (NOTE: the links
must be only Swedish links).

The link A B
ID_LINK is not a rail
link
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Scaling factor for outpus
The “Scaling factor for outputs” define how the results will be presented in the report tables. The
original values from the model will be divided by





“Thousands” (/1,000)
“Millions” (1,000,000) or
“Billions”.(/1,000,000,000).

In the current implementation the unique and default value is ”Thousands” and the
normal/advance user has not access to the catalog key to modify the default. Only the developer
mode let modify the value.
The steps to modify the value are as follow:
1) Select “Scaling factor for outputs” catalog key from scenario window:
2) Type in the box “Millions” or “Billions”
3) Click on enter and “Save”
Note: The only allowed values are “Thousands”, “Millions” and “Billions”. Any other value is NOT
accepted and it will cause the failure of the run. Also be careful in NOT mispelling the name of
the scaling factor since also this will lead to a failure.
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The link A B
ID_LINK is not
present in the
network.

The link listed is not present
in the rail network. Two
possible actions are:
1) amend the A and B nodes
because the link is in the
network;
2) add the link in the network
because the link is missing.

The link A B is in the
rail capacity table
but has not any
capacity

The links listed in the rail
capacity table MUST have a
capacity value greater than
zero. The capacity is number
of BIDIRECTIONAL trains per
day.

The ID_LINK
sequence is wrong.
for the following
links:

Links with opposite direction
but same node number MUST
have same ID_LINK.
Example:

AB
2001-2000 and 2000-2001
AB
...
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Scaling factor for outpus
The “Scaling factor for outputs” define how the results will be presented in the report tables. The
original values from the model will be divided by





“Thousands” (/1,000)
“Millions” (1,000,000) or
“Billions”.(/1,000,000,000).

In the current implementation the unique and default value is ”Thousands” and the
normal/advance user has not access to the catalog key to modify the default. Only the developer
mode let modify the value.
The steps to modify the value are as follow:
4) Select “Scaling factor for outputs” catalog key from scenario window:
5) Type in the box “Millions” or “Billions”
6) Click on enter and “Save”
Note: The only allowed values are “Thousands”, “Millions” and “Billions”. Any other value is NOT
accepted and it will cause the failure of the run. Also be careful in NOT mispelling the name of
the scaling factor since also this will lead to a failure.

3 Log reports - Samgods Model application/Handling
scenario application

#8

To identify possible
nodes unconnected to
any link – this precludes
the correct structure of
spanning tree data later
produced by Samgods
application. This must
be considered as sever
mistake and always
fixed.

The ID_LINK
sequence is wrong.

The ID_LINK must start from
1 to the highest number. No
gaps could be present.

Report#9: There are
mistakes in the
network. The
following nodes
must be removed
since not used in
any link

The nodes listed must be
deleted from the network.
Open GIS interface, start an
edit session, select them and
delete from feature explorer
window. Save and close.

Node number=
12345

Samgods Model application
The Existing Outputs log report is created when the Samgods Model application is run. The
messages inside the log report file Report_SG_{SCENARIO_SHORTNAME}.txt under the
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Scaling factor for outpus
The “Scaling factor for outputs” define how the results will be presented in the report tables. The
original values from the model will be divided by





“Thousands” (/1,000)
“Millions” (1,000,000) or
“Billions”.(/1,000,000,000).

In the current implementation the unique and default value is ”Thousands” and the
normal/advance user has not access to the catalog key to modify the default. Only the developer
mode let modify the value.
The steps to modify the value are as follow:
1) Select “Scaling factor for outputs” catalog key from scenario window:
2) Type in the box “Millions” or “Billions”
3) Click on enter and “Save”
Note: The only allowed values are “Thousands”, “Millions” and “Billions”. Any other value is NOT
accepted and it will cause the failure of the run. Also be careful in NOT mispelling the name of
the scaling factor since also this will lead to a failure.
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scenario specific folder, or accessible from the Data Section window in Scenario
outputs\Samgods Report\Existing Outputs, are listed and explained in Table 42.
Table 42 Reports for the Samgods Model application.
Number of
message
inside the
log report

Purpose

Example of messages

Message explanation

#1

Analyse inconsistencies
between input data in
different runs

The output OUTPUT for the
commodity ID_COM(2.0) was
created with a different Input
data. Please check the
scenario data.

Warning that the input
data has been
modified between the
last run and the
current run.

The previous run has DATE_E
and the current run has
DATE_L.
List of output files

The results have been
computed by Voyager.
The output under path is
available.
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List of all available
output files and their
locations.

Log files/Handling scenario application

Handling scenario application
The Report for the import phase is created when the Import function in the Handling Scenario
application is run. The messages inside the log report file
Report_HL_{SCENARIO_SHORTNAME}.txt under the scenario specific folder, or accessible
from the Data Section window under Scenario Outputs\Import function Report\Report for the
import phase, are listed in Table 43.
Table 43 Reports for the Handling scenario application.
Possible messages

Required actions

All the catalog keys have
the correct value. No actions
are requested.

Nothing

List of catalog keys that
have to be changed and
how.

Change the listed catalogue keys for the imported scenario
under “Scenario Parameters” in the Handling Scenario
application and run the application again. Check the report
again.
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Check-list when errors occur

Check-list when errors occur


Do you have the required administrative rights to install and run the Samgods GUI?



Is the model user role correct? Model Standard user is typically used when running
scenarios etc., while Model developer typically is used during installation and setting up
the system. Model Advanced user is used when some main parameters in the model
setup should be changed for sensitivity tests



What is the ReturnCode no? ReturnCode 2 is a fatal error – view the error report



Is the name of the scenario correct? Geodatabase format does not allow:







o

Begin the name with numbers (i.e., 01_scenario is not allowed, but scenario_01
is OK)

o

Special characters (like space “ “ or -,+, n f t in the beginning of the name)

o

Too long names (maximum 12 characters)

Spaces, use underscore (“_”) instead.
Some errors (regarding delimiter problems with “.” and “,”) could be solved by setting the
National settings for the PC to British
If the logistics module stops operating, the reason could be that the execution is split up
into too many processors. RAM per processor should be at least 1.5 GB. The number of
processors to use is set in the interface, via a catalog key in the Samgods model
application, see Section 8.5.
Warning messages as in Figure 84: will interrupt the model run (with Return Code =3).
They refer to the LP setup (made by a set of batch files called in sequence). In this case
a failure is occurred in MPS.jar program or CLP64.exe program. To debug the problem
refers to documents listed in reference 1 and reference 4Fel! Hittar inte referenskälla..
Along the process in each fundamental stage, similar prompts will appear. In all cases
the failure is one of the external programs (BuildChain, ChainChoi, extract, mergerep,
RCM, LP2CC, SelectDirect). The proper folder that contain information on failure is
LogMod\LOG folder that will contain the log file (per commodity or vehicle class) and err
file (listing the possible reason of failure).
JVM (Java Virtual Machine) is not working and therefore RCM does not produce any
result: check java pattern first and if correct check if the correct java pattern is defined in
PATH system variable. Guidance for setting the environmental variable is present under:
https://www.java.com/en/download/help/path.xml
The value under PATH environment variable should point to the folder containing the
java.exe.
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Figure 84 Run error.

197

Maps on outputs - create a map

13 Maps on outputs
The model produces outputs that can be classified into two main groups:


tabular reports



geodatabase networks

The first group can be visualized via Cube interface, Access or ArcMap. The second group can
be visualized via Cube interface or ArcMap.
In this chapter we will provide the procedure to create maps for the second group.
A standard set of maps that could be exchange with people without Cube license is also
described in this chapter.

List of networks
The available networks are presented in Table 44.
Table 44 Geodatabase networks in output.
ID

Data panel

Name

1

Scenario
Outputs\Samgods
Report\Assignment

Road Assigned Network

Notes

Rail Assigned Network
Sea Assigned Network
Air Assigned Network

2
3

4

Scenario
Outputs\Samgods
Report\Reports

Assigned Network

Scenario
Outputs\RCM
Report\Assignment

Road Assignment Network
(RCM)

Bidirectional tons per mode
STD

Rail Assignment Network
(RCM)
Sea Assignment Network
(RCM)
Air Assignment Network
(RCM)
5

Scenario
Outputs\RCM
Report\Reports

6
7

Assigned Network
Report #15b Rail Capacity
Network
Bidirectional tons per mode
RCM

Create a map
To create a map in GUI interface:
1) Select the scenario from which you want to create a map
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Only for RCM

Maps on outputs - create a map
2) Select from data panel the geodatabase network you want to visualize (in the example
Report #15b Rail Capacity Network) and double click on it
3) The GIS window will be open having in TOC only the network (named Rail_BiDir)
4) Clicking on "Add data>Geodatabase Data", see Figure 87, add
{CATALOG_KEY}\Input_Data.mdb\Samgods_zones background layer. This is used
only for cosmetic purposes

Figure 85 Samgods_zones layer in Input_data.mdb

5) Clicking on "Add data>Shapefile" add background shapefile placed under
{CATALOG_KEY}\03_Gis_Data. This is used only for cosmetic purposes
6) In the TOC drag and drop Rail_BDir on the top of all the layers
7) Untick the network node layer (Rail_BDir_node)

Figure 86 Add data.
At this point the map will looks like Figure 87.
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Figure 87 Map with geodatabase network and general layers.

8) Click on GIS Analysis tab in the interface and click on Multi-Bandwidth tool, see Figure
88.

Figure 88 Multi-Bandwidth tool.
9)
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The Highway Layer Link Bandwidth Setting window will pop up. Select the attribute to
visualize in the map (TOT_EMPT) and Dynamic Color in the dialog screen. This option
allows specification of different colors for different value ranges for the selected attribute

Maps on outputs - create a map
10) Enter in the Name input frame, the name of the map (in the example Empty trains
bidirectional per day), in Figure 89.

Figure 89 Name input frame.
11) Click on "Color" and specified in the following window: Number of groups (6), the Color
Range clicking on colored icon (green and red). Click on Apply Color Range and Apply
Value Range. Accommodate the High Value in the range of values per desired class.
Click on OK

Figure 90 Colour settings.
12) Click on OK
13) Click on OK
The resulting map will be as shown in Figure 91.
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Figure 91 Present map.
14) Click on X to close the map, the system will prompt if it is necessary save the map giving
a location and a name. Select the scenario folder and give the name "RCM.mxd", see
Figure 92.

Figure 92 Save the map if necessary.

Copy existing maps in new scenarios
The practice to start from scratch is not recommended and will be extremely time consuming. A
useful option is to inherit/copy all the settings specified with Multi-Bandwidth (or any tool in the
graphical interface) from one scenario to another scenario by copying those settings from the
vpr file.
The vpr file, normally created and saved alongside the output.mdb, takes the name of the
geodatabase which it refers to. In Samgods model its name is
output{Commodity}_{SCENARIO_SHORTNAME}.vpr and it is placed under the scenario folder.
If it is not present, it means that no maps are yet specified for the scenario.
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The vpr file saves all the settings specified in the mxd document which refer to elements loaded
according to the TOC.
To import in a new scenario the legends, Multi-Bandwidths, labels specified in another scenario
proceed in the following manner:
1) Perform step 1 to step 7 for the current scenario
2) Right click on RailBdir_Link layer
3) On the window select "Copy Layer Settings From Another Layer", see Figure 93.

Figure 93 Copy layer settings from another layer.
4) Select the Vpr file from scenario having the map you want to use (in the example
Base2006R64 folder and Output0_Base2006R64.vpr file), see Figure 94.
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Figure 94 Select vpr file.
5) Select the layer having the same name of the current network (e.g. Rail_BDir), see

Figure 95.
6) Click on GIS Analysis tab in the interface and click on Multi-Bandwidth tool. The legend
specified in the other network will be prompted automatically.
7) Click on OK

Figure 95 Select layer.
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8) Click on X to close the map, the system will prompt if it is necessary save the map giving
a location and a name. Select the scenario folder and give the name "RCM_64.mdx".

Attributes names for maps
The available attributes that can be visualized in a map for networks 1,2,4,5 in Table 49 are
listed under 15.4.2. Here the attributes in networks 3,6 and 7 in Table 45 are listed.
Table 45 Attributes in geodatabase networks.

Attribute
TOT_ROAD_T
M_BD
TOT_RAIL_TM
_BD
TOT_SEA_TM
_BD
TOT_EMPT
TOT_ASS
TOT_LOAD
CAP
FLAG_OVCAP
FLAG_PER
FLAG_TOT
DIFF_VC

Meaning
Bidirectional tonne flows on road in
millions
Bidirectional tonne flows on rail in
millions
Bidirectional tonne flows on sea in
millions
Bidirectional empty train flows per day
bidirectional per day total train flows
(empty + loaded
Bidirectional number of loaded trains
per day
Bidirectional capacity (#trains/day)
1 if overcapacity load of 1 train/day,
otherwise 0
1 if overcapacity load of 1%, otherwise
0
1 if FLAG_PER=1 or FLAG_OVCAP=1
Differences in number of trains over
capacity

Network

Loaded_Bid_STD (Bidirectional
tonnes per mode STD)
Loaded_Bid_RCM (Bidirectional
tonnes per mode RCM)

Rail_Bdir (Report #15b Rail
Capacity Network)

Standard Output maps
For three specific outputs, there are available standard output maps respectively under:
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1) Data Panel\Scenario Outputs\RCM Report\GIS maps – for total Ktons and vehicles per
commodity group, see Figure 96 and Figure 97.

Figure 96 Standard map on ktons by total and commodity groups. (map name:
Output_COM_RCM_GIS_TON.mxd)

Figure 97 Standard map on Loaded vehicles by total and commodity groups. (map name:
Output_COM_RCM_GIS_VHCL.mxd)

206

Maps on outputs - create a map
2) Data Panel\Scenario Outputs\Compare\GIS maps – for differences on total Ktons by
commodity group, see Figure 98.

Figure 98 Standard map on ktons for total and commodity groups.
3) Data Panel\Scenario Outputs\SelectLink\STD\GIS Maps and Data Panel\Scenario
Outputs\SelectLink\RCM\GIS
The former is produced when running Samgods application, the later when running Compare
application.
Their setup allows the following actions:
1) To open them from GUI interface clicking under Data Panel
2) To open them in GIS Desktop via mxd file
3) To redistribute the maps and related layers to non-Cube users (with a valid ArcGIS
software)
The maps and the data sources are saved under:


{Scenario_Dir}\ABS_GIS{SCENARIO_SHORTNAME} for absolute values on current
scenario



{Scenario_Dir}\DIFF_GIS2040_2017 for differences between current scenario and
base scenario



{Scenario_Dir}\SelectLink\{FolderSL}\SEL_GIS

To share the results it will be sufficient to zip the specific folder and send it over, all the required
data will be present in there.
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15 Appendices
Dimensions in the model
The following tables Table A-1 and Table A-2 are copied from the program documentation
(reference 3 Appendix B).
Table A-1: Overview of commodity types:
Commodity Description
1

Products from agriculture, forestry and fishing

2

Coal, crude oil and natural gas

3

Ore, other products of extraction

4

Food, beverages and tobacco

5

Textiles, clothing, leather and leather goods

6

Wood and articles of wood and cork (excl. Furniture), pulp, paper and paper
products, printed matter
Coal and refined petroleum products

7
8
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9

Chemicals, chemical products, synthetic fibers, rubber and plastic products
and nuclear fuel
Other non-metallic mineral products

10

Metal products excluding machinery and equipment

11

Machinery and instruments

12

Transport equipment

13

Other manufacturing ex furniture

14

Household waste, other waste and return raw material

15

Round timber

16

Air transport goods
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Table A-2: Overview of vehicle type numbers, and aggregate modes for container transport and
non-container transport.
Aggregate mode
Containers

Heavy lorry

ModeNr

VhclNr

Vehicle type

A

104

Lorry HGV 25-40 ton

105

Lorry HGV 25-60 ton

Extra heavy lorry

X

106

Lorry HGV 74 ton

Kombi train

D

201

Kombi train

Long kombi train

d

210

Long kombi train

Feeder train

E

202

Feeder/shunt train

Wagonload train

F

207

Short wagon load train

208

Medium wagonload train

209

Long wagonload train

Long Wagonload train

f

212

Long wagonload train

Direct Sea

J

301

Container vessel 5 300 dwt1

302

Container vessel 16 000 dwt1

303

Container vessel 27 200 dwt1

304

Container vessel 100 000 dwt1

305

Other vessel 1 000 dwt

306

Other vessel 2 500 dwt

307

Other vessel 3 500 dwt

308

Other vessel 5 000 dwt

309

Other vessel 10 000 dwt

310

Other vessel 20 000 dwt

311

Other vessel 40 000 dwt

312

Other vessel 80 000 dwt

313

Other vessel 100 000 dwt

314

Other vessel 250 000 dwt

315

Ro/ro vessel 3 600 dwt

316

Ro/ro vessel 6 300 dwt

317

Ro/ro vessel 10 000 dwt

301

Container vessel 5 300 dwt

315

Ro/ro vessel 3 600 dwt

Feeder vessel

K

211
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Long-Haul vessel

Non-Containers

Ro/ro vessel 6 300 dwt

303

Container vessel 27 200 dwt

304

Container vessel 100 000 dwt

317

Ro/ro vessel 10 000 dwt

IWW

V

322

IWW-vessel

Light Lorry

B

101

Lorry light LGV, ≤ 3,5 ton

102

Lorry medium 3,5-16 ton

103

Lorry medium16-24 ton

104

Lorry HGV 25-40 ton

105

Lorry HGV 25-60 ton

Heavy lorry

C / S8

Extra heavy lorry

c

106

Lorry HGV 74 ton

Feeder train

G

202

Feeder/shunt train

Wagonload train

H

207

Short wagonload train

208

Medium wagonload train

Long wagonload train

h

212

Long wagonload train

System train

I

204

System train STAX 22,5

T

205

System train STAX 25

U

206

System train STAX 30

i

211

Long system train

M

305

Other vessel 1 000 dwt

306

Other vessel 2 500 dwt

307

Other vessel 3 500 dwt

308

Other vessel 5 000 dwt

309

Other vessel 10 000 dwt

310

Other vessel 20 000 dwt

311

Other vessel 40 000 dwt

312

Other vessel 80 000 dwt

313

Other vessel 100 000 dwt

314

Other vessel 250 000 dwt

315

Ro/ro vessel 3 600 dwt

Direct Sea

8

L

316

Consolidated heavy lorry is coded as mode S in the chains file. Consolidation in heavy lorries is only
available on an intermediate leg in a chain with at least three legs.

212

Appendices – Dimensions in the model

Feeder vessel

N

316

Ro/ro vessel 6 300 dwt

317

Ro/ro vessel 10 000 dwt

315

Ro/ro vessel 3 600 dwt

316

Ro/ro vessel 6 300 dwt

Long-Haul vessel

O

317

Ro/ro vessel 10 000 dwt

IWW

W

322

IWW-vessel

Road Ferry

P

318

Road ferry 2 500 dwt

319

Road ferry 5 000 dwt

320

Road ferry 7 500 dwt

Rail Ferry

Q

321

Rail ferry 5 000 dwt

Plane

R

401

Freight airplane

213

Appendices - Dimensions in the model
Table A-3: Transport chains used for Sweden
Number

Potential Chain

Included in
model year
2017

2040

1

A

yes

yes

2

ADA

yes

yes

3

AdA

no

yes

4

ADJA

yes

yes

5

ADJDA

yes

yes

6

ADKL

yes

yes

7

AJ

yes

yes

8

AJA

yes

yes

9

AJDA

yes

yes

10

AKL

yes

yes

11

APA

yes

yes

12

AV

yes

yes

13

AVA

yes

yes

14

B

yes

yes

15

BR

yes

yes

16

BRB

yes

yes

17

BS

yes

yes

18

BSB

yes

yes

19

C

yes

yes

20

c

yes

yes

21

CGH

yes

yes

22

CGHC

yes

yes

23

CGHM

yes

yes

24

CH

yes

yes

25

Ch

no

yes

26

ch

no

yes

27

CHG

yes

yes

28

CHGC

yes

yes

29

CM

yes

yes

30

CMC

yes

yes

31

CMI

yes

yes

32

CMT

yes

yes

33

CMU

yes

yes

34

CPC

yes

yes

35

CUM

yes

yes

36

CWC

yes

yes
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Number

Potential Chain

Included in
model year
2017

2040

37

cWc

yes

yes

38

GH

yes

yes

39

Gh

no

yes

40

GHC

yes

yes

41

GHG

yes

yes

42

GHM

yes

yes

43

GHMI

yes

yes

44

GHMT

yes

yes

45

GHMU

yes

yes

46

GHQH

yes

yes

47

HC

yes

yes

48

hC

no

yes

49

HG

yes

yes

50

hG

no

yes

51

HGC

yes

yes

52

I

yes

yes

53

i

no

yes

54

IM

yes

yes

55

iM

no

yes

56

IMC

yes

yes

57

IMHG

yes

yes

58

J

yes

yes

59

JA

yes

yes

60

KL

yes

yes

61

LK

yes

yes

62

LKA

yes

yes

63

LKDA

yes

yes

64

M

yes

yes

65

MC

yes

yes

66

MHG

yes

yes

67

MHGC

yes

yes

68

MI

yes

yes

69

MT

yes

yes

70

MU

yes

yes

71

RB

yes

yes

72

SB

yes

yes

73

T

yes

yes
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Number

Potential Chain

Included in
model year
2017

2040

74

TM

yes

yes

75

TMC

yes

yes

76

TMGH

yes

yes

77

U

yes

yes

78

UM

yes

yes

79

UMC

yes

yes

80

UMGH

yes

yes

81

VA

yes

yes

83

XdX

no

yes

84

XdJA

no

yes

85

AJdX

no

yes

86

cB

yes

yes

87

cS

yes

yes

88

cC

yes

yes

89

cH

yes

yes

90

Bc

yes

yes

91

XA

yes

yes

92

AX

yes

yes

94

WB

yes

yes

95

HQH

yes

yes

96

CHM

yes

yes

97

HM

yes

yes

98

MH

yes

yes

99

AdJA

no

yes

100

AdJdA

no

yes

101

AdKL

no

yes

102

AJdA

no

yes

103

LKdA

no

yes

104

CGh

no

yes

105

CGhC

no

yes

106

CGhM

no

yes

108

ChG

no

yes

109

ChGC

no

yes

110

GhC

no

yes

111

GhG

no

yes

112

GhM

no

yes

113

GhMI

no

yes
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Number

Potential Chain

Included in
model year
2017

2040

114

GhMT

no

yes

115

GhMU

no

yes

116

GhQh

no

yes

118

hGC

no

yes

119

IMhG

no

yes

120

MhG

no

yes

121

MhGC

no

yes

122

UMGh

no

yes

123

hQh

no

yes

124

ChM

no

yes

125

hM

no

yes

126

Mh

no

yes

127

CMi

no

yes

128

GHMi

no

yes

129

iMC

no

yes

130

iMHG

no

yes

131

Mi

no

yes

132

cGH

yes

yes

133

cGHc

yes

yes

134

cGHM

yes

yes

135

cHG

yes

yes

136

cHGc

yes

yes

137

cM

yes

yes

138

cMc

yes

yes

139

cMI

yes

yes

140

cMT

yes

yes

141

cMU

yes

yes

142

cPc

yes

yes

143

cUM

yes

yes

144

GHc

yes

yes

145

Hc

yes

yes

146

hc

no

yes

147

HGc

yes

yes

148

IMc

yes

yes

149

Mc

yes

yes

150

MHGc

yes

yes

151

TMc

yes

yes
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Number

Potential Chain

Included in
model year
2017

2040

152

UMc

yes

yes

153

cHM

yes

yes

154

cGh

no

yes

155

cGhc

no

yes

156

cGhM

no

yes

157

chG

no

yes

158

chGc

no

yes

159

Ghc

no

yes

160

hGc

no

yes

161

MhGc

no

yes

162

chM

no

yes

163

cMi

no

yes

164

iMc

no

yes

165

cGHC

yes

yes

166

cHGC

yes

yes

167

cMC

yes

yes

168

cWC

yes

yes

169

cGhC

no

yes

170

chGC

no

yes

171

CGHc

yes

yes

172

CHGc

yes

yes

173

CMc

yes

yes

174

CWc

yes

yes

175

CGhc

no

yes

176

ChGc

no

yes

177

X

yes

yes

178

XDX

yes

yes

179

XDJX

yes

yes

180

XDJDX

yes

yes

181

XDKL

yes

yes

182

XJ

yes

yes

183

XJX

yes

yes

184

XJDX

yes

yes

185

XKL

yes

yes

186

XPX

yes

yes

187

XV

yes

yes

188

XVX

yes

yes
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Number

Potential Chain

Included in
model year
2017

2040

189

JX

yes

yes

190

LKX

yes

yes

191

LKDX

yes

yes

192

VX

yes

yes

193

XdJX

no

yes

194

XdJdX

no

yes

195

XdKL

no

yes

196

XJdX

no

yes

197

LKdX

no

yes

198

XDA

yes

yes

199

XdA

no

yes

200

XDJA

yes

yes

201

XDJDA

yes

yes

202

XJA

yes

yes

203

XJDA

yes

yes

204

XPA

yes

yes

205

XVA

yes

yes

206

XdJdA

no

yes

207

XJdA

no

yes

208

ADX

yes

yes

209

AdX

no

yes

210

ADJX

yes

yes

211

ADJDX

yes

yes

212

AJX

yes

yes

213

AJDX

yes

yes

214

APX

yes

yes

215

AVX

yes

yes

216

AdJX

no

yes

217

AdJdX

no

yes
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Empty vehicles description
The computation of the empty vehicles matrices in the current version of the model is based on a
non-linear, non-separable model. Therefore the output in terms of empty vehicle flows in general
will depend on the set of commodities included in the logistics model simulations. The flows of
empty vehicles will be correctly estimated only if the model is run for all commodities. An
exception to this observation is the set of user defined empty vehicle modelling functions
introduced in December 2014, in which empty train flows are modeled as strictly proportional to
the number of loaded trains. With this setting the rail empty flows are strictly proportional to the
loaded flows, and the results can be aggregated to total volumes from any disaggregated level.
To obtain between scenarios comparable results it is therefore recommended that the model is
run for all commodities. There are two cases:


EMPTY_OK: the catalogue key for selecting the commodity group is set to 0, which
means that all commodities are selected for the logistics model simulation; This 0 is also
added to the vehicle OD-matrix names as for example OD_Tonnes201_0.314, which
during the railway capacity management procedure are renamed to
OD_Tonnes201_STD.314, where STD stands for STanDard logistics model.



EMPTY_ERROR: all other cases, i.e. the model is run for one commodity or all
commodity groups. In this case the empty vehicle flows will in general be according to
non-separable relationships.

The program originally gives three kinds of output matrices: The number of empty vehicles, the
total number of (loaded and empty) vehicles and the number of tonnes transported. In the
EMPTY_ERROR case, the total number of vehicles will be incorrect as well. This issue is dealt
with in two ways, presented below.
1: Compute the number of loaded vehicles.
Instead of producing the total number of vehicles (empty + loaded), the program now produces
the number of loaded vehicles. This is done by default, by computing
the number of loaded vehicles = total number of vehicles – number of empty vehicles
in an intermediate step in Cube, after the logistics model. This operation will always give the
correct result, since the estimated number of empty vehicles (with any errors) is subtracted from
the total number of vehicles in all OD relations (containing the same errors). The output in the
current version is thus made up by the three types of matrices:


Number of loaded vehicles (always correct values);



Number of empty vehicles (comparable and correct only in case EMPTY_OK);



Tonnes (correct values).

Furthermore, the total number of vehicles will be computed (by adding the empty and loaded
vehicles outputs) in the case EMPTY_OK. For the other case – EMPTY_ERROR – the total
number of vehicles will be replaced by zeros in order to reduce the risk of using incorrect values.
This gives the extra output
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Total number of vehicles (correct in case EMPTY_OK, set to zero otherwise).

The output in terms of total number of vehicles appears in some of the tables, but not in any of
the networks. Generally, in the outputs, the number of vehicles always refers to the number of
loaded vehicles, if nothing else is said.

2: Skip estimation of the empty vehicles
The user is given the option to not produce the empty vehicle matrices at all. The choice is made
by setting the attribute
EMPTY_V = 1

to produce empty vehicle matrices, or

EMPTY_V = 0

to not produce empty vehicle matrices.

The attribute is set for each vehicle class separately, in the table “Vehicle Parameters” (see
Section 10.4). If EMPTY_V=0, the empty vehicle matrices will be filled with zeroes.
Summarizing all the possibilities, we have the following cases and the result in each case in
Table 46.
Table 46 All different cases for the empty and total vehicles calculation.

EMPTY_OK

EMPTY_ERROR

EMPTY_V=0

EMPTY_V=1

Empty vehicles = 0

Empty vehicles ≠ 0

Total vehicles = loaded vehicles

Total vehicles = empty + loaded

Empty vehicles = 0

Empty vehicles ≠ 0

Total vehicles = 0

Total vehicles = 0

The empty vehicles calculation was designed for lorries, but is used for all vehicles as described
above.

Frequency network
The frequency networks are saved and can be displayed as GIS maps in the Samgods model
and could be edited as any other GIS layers, using the Compute function or the Feature Explorer
window. However, editing these layers in the GIS window is rather difficult and slow. New
terminals are given default frequencies, so that the user does not have to edit the frequency
networks unless any specific frequencies should be changed. The reason for saving the
frequency data as GIS layers instead of a matrix is that it saves hard disk space. The user just
has to think of the node layer as the diagonal elements of the imagined frequency matrix (giving
the frequencies within zones) and the link layer as the non-diagonal elements, giving the
frequencies between zones. By default, the frequency network layers are initially filtered to show
only the links and nodes connected to Stockholm.
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Variable names and their meaning
Below, some of the variable names in different tables in the interface are listed and explained.
Table 2 in Section 7.3 also gives information to help to understand the contents of the tables.
15.4.1 Variables in the output tables
In the output tables, different variable names appear. Table 48 gives the variables, their meaning
and in which data set (in the Data Section window) they appear. These data sets are found in
Scenario Outputs\Samgods Report\Logistics Module\OD Covered and Scenario
Outputs\Samgods Report\Reports.
Generally, the following abbreviations are used, separated by an underscore sign in Table 47.
Table 47 Abbreviations used for variable names.
NV

Number of vehicles

KM

Kilometer

TON

Tonne

TKM

Tonne Kilometer

VHCLKM

Vehicle Kilometer

DOM

Domestic

DTOT

Total domestic (domestic + domestic part of international)

INT

International

TOT

Total (in the sense total domestic + international)

L

Loaded (vehicle)

E

Empty (unloaded vehicle)

A

All (in the sense loaded + empty vehicles)

Table 48 Variable names used in the output files in the folders Scenario Outputs\Samgods
Report\Logistics Module\OD Covered and Scenario Outputs\Samgods Report\Reports in the Data
Section window.
Data set

Variable

Meaning

Output by vehicle type

NV_DTOT

Number of vehicles, total
domestic

Output by vehicle type

NV_INT

Number of vehicles,
international

Output by vehicle type

NV_TOT

Number of vehicles, total
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Data set

Variable

Meaning

Output by vehicle type,
Output by chain

KM_DTOT

Number of kilometers, total
domestic

Output by vehicle type,
Output by chain

KM_INT

Number of kilometres,
international

Output by vehicle type,
Output by chain

KM_TOT

Number of kilometres, total

Output by vehicle type,
Output by chain

TON_DTOT

Number of tonnes, total
domestic

Output by vehicle type,
Output by chain

TON_INT

Number of tonnes, international

Output by vehicle type,
Output by chain

TON_TOT

Number of tonnes, total

Output by vehicle type,
Output by chain

TKM_DTOT

Number of tonne kilometres,
total domestic

Output by vehicle type,
Output by chain

TKM_INT

Number of tonne kilometres,
international

Output by vehicle type,
Output by chain

TKM_TOT

Number of tonne kilometres,
total

Output by vehicle type

ALF_DOM

Average loading factor,
domestic

Output by vehicle type

ALF_INT

Average loading factor,
international

Output by vehicle type

ALF_TOT

Average loading factor, total

Output by vehicle type

AVDIST_DOM

Average distance, domestic

Output by vehicle type

AVDIST_INT

Average distance, international

Output by vehicle type

AVDIST_TOT

Average distance, total

Output by chain

COST_DOM

Logistic cost, domestic

Output by chain

COST_DTOT

Logistic cost, total domestic

Output by chain

COST_INT

Logistic cost, international

Output by chain

COST_TOT

Logistic cost, total

Output by chain

AC_TKM_DOM

Average cost per tonne
kilometre, domestic

Output by chain

AC_TKM_INT

Average cost per tonne
kilometre, international

Output by chain

AC_TKM_TOT

Average cost per tonne
kilometre, total
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Data set

Variable

Meaning

Report #1

NV_A_TOT

Number of vehicles, loaded +
empty, total domestic +
international

Report #1

NV_A_DTOT

Number of vehicles, loaded +
empty, total domestic

Report #1

VHCLKM_A_TOT

Number of vehicle kilometres,
loaded + empty, total domestic
+ international

Report #1

VHCLKM_A_DTOT

Number of vehicle kilometres,
loaded + empty, total domestic

Report #1

NV_L_TOT

Number of loaded vehicles,
total domestic + international

Report #1

NV_E_TOT

Number of empty vehicles,
domestic + international

Report #1

VHCLKM_L_TOT

Number of loaded vehicle
kilometres, domestic +
international

Report #1

VHCLKM_E_TOT

Number of unloaded vehicle
kilometres, domestic +
international

Report #1

NV_L_DTOT

Number of loaded vehicles,
total domestic

Report #1

NV_E_DTOT

Number of empty vehicles, total
domestic

Report #1

VHCLKM_L_DTOT

Number of loaded vehicle
kilometres, total domestic

Report #1

VHCLKM_E_DTOT

Number of empty vehicle
kilometres, total domestic

Report #4

TON_DTOT

Number of tones, total domestic

Report #4

TON_INT

Number of tones, international

Report #4

TON_TOT

Number of tones, dom. + int.

Report #4

TKM_DTOT

Number of tonne kilometres,
total domestic

Report #4

TKM_INT

Number of tonne kilometres,
international

Report #4

TKM_TOT

Number of tonne kilometres,
total domestic + international

Report #9

VHCLKM_L_ROAD

Number of loaded vehicle
kilometres, road mode
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Data set

Variable

Meaning

Report #9

VHCLKM_E_ROAD

Number of empty vehicle
kilometres, road mode

Report #9

VHCLKM_A_ROAD

Number of vehicle kilometres,
empty + loaded vehicles on
road

Report #9

TKM_ROAD

Number of tonne kilometres on
road

Report #9

VHCLKM_L_RAIL

Number of loaded vehicle
kilometres, rail mode

Report #9

VHCLKM_E_RAIL

Number of empty vehicle
kilometres, rail mode

Report #9

VHCLKM_A_RAIL

Number of vehicle kilometres,
empty + loaded vehicles on rail

Report #9

TKM_RAIL

Number of tonne kilometres on
rail

15.4.2 Variables in the assigned networks
Below, some of the variables found in the attribute tables of the assigned networks are listed and
explained. The outputs in terms of assigned networks are found in the folders Scenario Outputs\
Samgods Report\Assignment (assigned networks per mode), Scenario Outputs\Samgods
Report\Reports (assigned network with all modes) and Scenario Outputs\Compare\Assignment
(differences between the current scenario and the base scenario in loaded vehicle flows for all
modes). In the assigned networks (except the compared vehicle flows, see below), the rule for
the variable names is the following:
Each vehicle type has a label (the labels are found in the table Scenario Inputs\Editable
data\Vehicles Parameters in the data Section window). For example, vehicle class 101 has the
label LGV3. For each vehicle class there are three attributes in the network, which for the
example for LGV3 are LGV3 (only the label), LGV3T (label + T) and LGV3E (label + E). LGV3
then gives the number of loaded LGV3 vehicles per year on the link, LGV3T gives the number of
tonnes transported by LGV3 vehicles per year and LGV3E gives the number of empty (unloaded)
LGV3 vehicles per year. There is one exception from this rule and that is the attribute
FS_TRAIN, which cannot be found in the Vehicles Parameters table. FS_TRAIN is the sum of
the attributes FEEDV and FEEDW which are two separated assignments for vehicle class 202
(Feeder/shunt train).
Except the attributes for each vehicle class, there are also aggregated numbers in the networks
(for air mode there are no aggregated numbers, since there is only one vehicle type for air mode
(label FLYG)), see Table 49.
Table 49 Variable names in the assigned networks and their meanings.
Variable

Meaning

TOT_ROAD

Total number of loaded road vehicles
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TOT_RAIL

Total number of loaded rail vehicles

TOT_SEA

Total number of loaded sea vehicles

TOT_ROAD_T

Total numbers of tonnes transported by road vehicles

TOT_RAIL_T

Total numbers of tonnes transported by trains

TOT_SEA_T

Total numbers of tonnes transported by sea vehicles

TOT_ROAD_E

Total number of empty road vehicles

TOT_RAIL_E

Total number of empty rail vehicles

TOT_SEA_E

Total number of empty sea vehicles

VOLTO

Total number of loaded vehicles

TONTO

Total number of tonnes transported

EMPTO

Total number of empty vehicles

For the compared assigned network, only the loaded vehicle flows are included and they are
represented by the vehicle class label, with the prefix DIF. For the example used above, the
variable DIF_LGV3 gives the difference in number of loaded LGV3 vehicles, between the current
scenario and the base scenario. Also there are differences in aggregated loaded vehicle flows,
represented by e.g. DIF_ROAD and DIF_VOLTO (the latter gives the compared flows summed
for all vehicle types).
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Intra zonal flows treatment
The intrazonal flows are present in some reports and not present on others. The different cases
are related to the procedure or program in charge of produce the report itself.
As simple principle, all the reports derived from the external programs will contain the intrazonal
tons values, meanwhile all the reports from Voyager assignment will exclude those values.
The following scheme represents the cases presented in Table 50.
Table 50 Reports including or excluding intrazonal tonnes values.
Intrazonal
Report name

Values
included

Report_1 Tot VHCKM by VHC Type

No

Report_2_Logistics Module

Yes

Report_2_LM_CHAINS

Yes

Report_2_LM_DEMAND

Yes

Report_3_TonKm_Per_Mode_With_2006Statistics

Yes

Report_4_Total tonne kms by VHC Type

No

Report_5_Total logistic cost at zone-level

Yes

Report_6_Goods flow through terminals (number of tonnes in and out per year)

Yes

Report_6_b_Goods flow through terminals (total number of tonnes per year
without land based transfers)

Yes

Report_7_Domestic tonne kms with container per mode (road, rail, sea, air) and
vehicle cl

Yes

Report_8_Domestic vehicle kms with container per mode (road, rail, sea, air)
and vehicle cl

Yes

Report_9_Vehicle kms and Tonne kms per geographic region

No

Report_10_Transport work (tonne kms) per mode and vehicle cl, total and split
per commodity, domestic, tdomestic and international

Yes

Report_11_ Transported goods volume per mode and vehicle cl, total and split
per commodity, domestic, tdomestic and international

Yes

Report_12_node and link costs per vehicle and product group

Yes

Report_13_Tons_per_PortArea_and_Commodity_Group

No

Report_14_Oresund Bridge_Kiel Canal and Jylland

No

Report_15_Trains per day (tot, empty, loaded)

No

Report_16_VHCLKM and distribution by county - totals

No
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Intrazonal
Report name

Values
included

Report_17_VHCLKM and distribution by county - E10 roads

No

Report_18_VHCLKM and distribution by country - Other roads

No

Report_19_Loaded_Unloaded_Tons_Rail

Yes

Report_20 Inventory and order cost per commodity group
Report_21_Domestic Total and International Tonkm and VhclKm per commodity
group RCM - Rail
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Error hadling within model structure
Table 51 List of batch files calling external program, location and scripts which handle potential failure
ID

Name and location during the run

Purpose

Script creating the batch file

Script having error handling

1

{SCENARIO_DIR}\LogMod_{OverallLoo
pMax}\RCM\1_RUN_SelectDirect.bat

Select link analysis for STD and
RCM

{CATALOG_DIR}\02_APPLICATIONS\10_SELECT
LINK\CFMAT01M.S

{CATALOG_DIR}\02_APPLICATIONS\10_SELECTLINK
\PNPIL00A.S

2

{SCENARIO_DIR}\LogMod_{OverallLoo
pMax}\RCM\2_RUN_SelectDirect_CBA.
bat

Select link analysis for CBA

{CATALOG_DIR}\02_APPLICATIONS\10_SELECT
LINK\CFMAT01M.S

{CATALOG_DIR}\02_APPLICATIONS\10_SELECTLINK
\PNPIL00A.S

3

{SCENARIO_DIR}\LogMod\RCM\CB_R
UN_LOS.BAT

create LOS matrices without
rescaling factors

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LO
MAT01B.S

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LOPIL0
1A.S

4

{SCENARIO_DIR}\LOGMOD\RUNALL_
CBA.BAT

run LP2CC for CBA

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP
2CC\RLMAT01A.S

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP2CC\
RLPIL01B.S

5

{SCENARIO_DIR}\LOGMOD\COMMOD
ITY_CBA.BAT

sub bat file for ID 4

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP
2CC\RLMAT01B.S

6

{SCENARIO_DIR}\LOGMOD\CALL_JA
R_CBA.BAT

parallel process for ID 4

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP
2CC\RLMAT01E.S

7

{SCENARIO_DIR}\LOGMOD\MERGER
EP\MERGEREPALLCBA.BAT

Mergerep program

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP
2CC\RLMAT01D.S

8

{SCENARIO_DIR}\LogMod\RCM\CB_R
UN_UTI.BAT

Create reports for empty vehicles
and ferry

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP
2CC\RLMAT01F.S

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP2CC\
RLPIL01A.S

9

{SCENARIO_DIR}\LOGMOD\RUNALL.
BAT

Run STD log mod

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\LOG
ISTICMODVY\RLMAT01A.S

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\LOGISTI
CMODVY\RLPIL01B.S

10

{SCENARIO_DIR}\LOGMOD\COMMOD
ITY.BAT

sub bat file for ID 9

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\LOG
ISTICMODVY\RLMAT01B.S

11

{SCENARIO_DIR}\LOGMOD\EXTRACT
\EXTRACTALL.BAT

Extract vehicle and ton matrices

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\LOG
ISTICMODVY\RLMAT01C.S

12

{SCENARIO_DIR}\LOGMOD\CALL_JA
R.BAT

Parallel process for ID 9

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\LOG
ISTICMODVY\RLMAT01E.S

13

{SCENARIO_DIR}\LOGMOD\MERGER
EP\MERGEREPALL.BAT

Mergerep program

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\LOG
ISTICMODVY\RLMAT01D.S

14

{SCENARIO_DIR}\LogMod\RCM\0_Co
mpact.bat

Compact spanning tree data

{CATALOG_DIR}\02_Applications\9_RCM1\DATAP
REP_LP\DPMAT01B.S

{CATALOG_DIR}\02_Applications\9_RCM1\DATAPREP
_LP\DPPIL01A.S

15

{SCENARIO_DIR}\LogMod\RCM\1_RU
N_MPS_LP0_step1.BAT

LP step W

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP0
\LPMAT00B.S

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP0\LPP
IL00B.S

16

{SCENARIO_DIR}\LogMod\RCM\2_run
LP.bat

LP Solve

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP0
\LPMAT00C.S

No

17

{SCENARIO_DIR}\LogMod\RCM\3_RU
N_MPS_LP0_step2.BAT

LP step LXR

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP0
\LPMAT00D.S

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP0\LPP
IL00G.S

18

{SCENARIO_DIR}\LOGMOD\RUNALL_
RCM.BAT

Run RCM Build Chain and
Chainchoi

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1
\RLMAT01A.S

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1\RLP
IL01E.S
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ID

Name and location during the run

Purpose

Script creating the batch file

19

{SCENARIO_DIR}\LOGMOD\COMMOD
ITY_RCM.BAT

sub bat file for ID 21

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1
\RLMAT01B.S

20

{SCENARIO_DIR}\LOGMOD\CALL_JA
R.BAT

parallel process for ID 11

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1
\RLMAT01E.S

21

{SCENARIO_DIR}\LogMod\RCM\1_RU
N_MPS_LP@RCM_Loop@_step1.BAT

LP 1+ step w

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1
\FPMAT00B.S

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1\FPP
IL00E.S

22

{SCENARIO_DIR}\LogMod\RCM\2_run
@RCM_Loop@.bat

LP Solve

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1
\FPMAT00C.S

No

23

{SCENARIO_DIR}\LogMod\RCM\3_RU
N_MPS_LP@RCM_Loop@_step2.BAT

LP 1+ step LXR

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1
\FPMAT00D.S

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1\FPP
IL00F.S

24

{SCENARIO_DIR}\LOGMOD\RUNALL_
FIN.BAT

Run LP2CC for FINAL

{CATALOG_DIR}\02_Applications\9_RCM1\FINAL\
RLMAT01A.S

{CATALOG_DIR}\02_Applications\9_RCM1\FINAL\RLPI
L01B.S

25

{SCENARIO_DIR}\LOGMOD\COMMOD
ITY_FIN.BAT

sub bat file for ID 27

{CATALOG_DIR}\02_Applications\9_RCM1\FINAL\
RLMAT01B.S

26

{SCENARIO_DIR}\LOGMOD\EXTRACT
\EXTRACTALL_FIN.BAT

Extract vehicle and ton matrices

{CATALOG_DIR}\02_Applications\9_RCM1\FINAL\
RLMAT01F.S

27

{SCENARIO_DIR}\LOGMOD\CALL_JA
R.BAT

Parallel process for ID 27

{CATALOG_DIR}\02_Applications\9_RCM1\FINAL\
RLMAT01G.S

28

{SCENARIO_DIR}\LOGMOD\MERGER
EP\MERGEREPALLFIN.BAT

Mergerep program

{CATALOG_DIR}\02_Applications\9_RCM1\FINAL\
RLMAT01D.S

29

{SCENARIO_DIR}\LOGMOD\RUNALL.
BAT

Run STD log mod

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\1_RUN\3_LOGISTICMOD\RLMAT01A.S

30

{SCENARIO_DIR}\LOGMOD\COMMOD
ITY.BAT

sub bat file for ID 9

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\1_RUN\3_LOGISTICMOD\RLMAT01B.S

31

{SCENARIO_DIR}\LOGMOD\EXTRACT
\EXTRACTALL.BAT

Extract vehicle and ton matrices

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\1_RUN\3_LOGISTICMOD\RLMAT01C.S

32

{SCENARIO_DIR}\LOGMOD\CALL_JA
R.BAT

Parallel process for ID 9

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\1_RUN\3_LOGISTICMOD\RLMAT01E.S

33

{SCENARIO_DIR}\LOGMOD\MERGER
EP\MERGEREPALL.BAT

Mergerep program

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\1_RUN\3_LOGISTICMOD\RLMAT01D.S

34

{SCENARIO_DIR}\LogMod\RCM\0_Co
mpact.bat

Compact spanning tree data

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\1_DATAPREP_LP\DPMAT01B.S

35

{SCENARIO_DIR}\LogMod\RCM\1_RU
N_MPS_LP0_step1.BAT

LP step W

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\2_LP_STEPS\LPMAT00B.S

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\
2_RCM\2_LP_STEPS\LPPIL00B.S

36

{SCENARIO_DIR}\LogMod\RCM\2_run
LP.bat

LP Solve

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\2_LP_STEPS\LPMAT00C.S

No

37

{SCENARIO_DIR}\LogMod\RCM\3_RU
N_MPS_LP0_step2.BAT

LP step LXR

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\2_LP_STEPS\LPMAT00D.S

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\
2_RCM\2_LP_STEPS\LPPIL00G.S

38

{SCENARIO_DIR}\LOGMOD\RUNALL_
RCM.BAT

Run RCM Build Chain and
Chainchoi

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\2_LP_STEPS\RLMAT01A.S

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\
2_RCM\2_LP_STEPS\RLPIL01E.S
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Script having error handling

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\
1_RUN\3_LOGISTICMOD\RLPIL01B.S

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\
2_RCM\1_DATAPREP_LP\DPPIL01A.S
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ID

Name and location during the run

Purpose

Script creating the batch file

Script having error handling

39

{SCENARIO_DIR}\LOGMOD\COMMOD
ITY_RCM.BAT

sub bat file for ID 21

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\2_LP_STEPS\RLMAT01B.S

40

{SCENARIO_DIR}\LOGMOD\CALL_JA
R.BAT

parallel process for ID 11

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\2_LP_STEPS\RLMAT01E.S

41

{SCENARIO_DIR}\LogMod\RCM\1_RU
N_MPS_LP@RCM_Loop@_step1.BAT

LP 1+ step w

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\2_LP_STEPS\FPMAT00B.S

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\
2_RCM\2_LP_STEPS\FPPIL00E.S

42

{SCENARIO_DIR}\LogMod\RCM\2_run
@RCM_Loop@.bat

LP Solve

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\2_LP_STEPS\FPMAT00C.S

No

43

{SCENARIO_DIR}\LogMod\RCM\3_RU
N_MPS_LP@RCM_Loop@_step2.BAT

LP 1+ step LXR

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\2_LP_STEPS\FPMAT00D.S

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\
2_RCM\2_LP_STEPS\FPPIL00F.S

44

{SCENARIO_DIR}\LOGMOD\RUNALL_
FIN.BAT

Run LP2CC for FINAL

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\3_FINAL\RLMAT01A.S

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\
2_RCM\3_FINAL\RLPIL01B.S

45

{SCENARIO_DIR}\LOGMOD\COMMOD
ITY_FIN.BAT

sub bat file for ID 27

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\3_FINAL\RLMAT01B.S

46

{SCENARIO_DIR}\LOGMOD\EXTRACT
\EXTRACTALL_FIN.BAT

Extract vehicle and ton matrices

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\3_FINAL\RLMAT01F.S

47

{SCENARIO_DIR}\LOGMOD\CALL_JA
R.BAT

Parallel process for ID 27

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\3_FINAL\RLMAT01G.S

48

{SCENARIO_DIR}\LOGMOD\MERGER
EP\MERGEREPALLFIN.BAT

Mergerep program

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI
CITY\2_RCM\3_FINAL\RLMAT01D.S
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